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Capítulo 1 Introducción al software mView 

1.1 Cómo instalar el software mView 

(Por favor, vaya al sitio web oficial WWW.COOLMAY.COM.AR  para 

descargar la última versión) 

Este capítulo presentará en detalle el proceso de instalación del software 

mView. 

■ Requisitos de hardware 

Los requisitos básicos de hardware para instalar el software de edición 

mView son los siguientes: 

1. 1. Host de computadora personal: se recomienda usar una CPU de 

80486 o superior. 

2. 2. Memoria: se recomienda utilizar más de 128 MB de RAM para 

ampliar la memoria. 

3. 3. Disco duro: el disco duro debe tener más de 100 MB de espacio. 

4. 4. Pantalla: tarjeta de visualización VGA o SVGA general. 

5. 5. Ratón: utilice un ratón compatible con Windows. 

6. 6. Impresora: use una impresora compatible con Windows. 

Antes de instalarlo, verifique si el hardware de la computadora es como el 

anterior o superior. Para evitar problemas de incompatibilidad de hardware, 

utilice las especificaciones recomendadas tanto como sea posible. Si tiene 

alguna pregunta, póngase en contacto con nuestro servicio de atención al 

cliente. 

■  Fuente de software 

Puede ingresar al sitio web de nuestra empresa 

WWW.COOLMAY.COM.AR 

 para obtener la última versión del software. 

■ Pasos de instalación (tome la versión china simplificada de mView como 

ejemplo), tenga en cuenta que la versión del software "mView ***" está 

sujeta al sitio web oficial. 

Seleccione mView 13802.exe en la ventana del instalador para iniciar el 

instalador e iniciar la instalación; 

● Configure la ruta de almacenamiento del archivo de instalación, seleccione 

el valor predeterminado, ingrese la dirección o haga clic en el botón 

[Examinar...] para seleccionar la dirección y luego haga clic en el botón 

[Siguiente]; 

http://www.coolmay.com.ar/
http://www.coolmay.com.ar/
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● Establezca el nombre de la carpeta guardada. Se recomienda seleccionar el 

valor predeterminado y hacer clic directamente en el botón [Siguiente]. 

 

● Elija si desea crear un icono de acceso directo en el escritorio y luego haga 

clic en el botón [Siguiente]. 
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● Confirme la ruta de instalación y otra información de instalación, y luego 

haga clic en el botón [Instalar] para instalar.

 
● El proceso de instalación se muestra a continuación: 
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● Haga clic en [Siguiente] para instalar el asistente del controlador 

 

● La instalación del controlador se ha completado. 



Manual de programación de HMI de la serie TK 

 5 
https://coolmay.com.ar 

 

● Finalmente, haga clic en [Finalizar] para completar la instalación. 
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1.2 Cómo abrir el software mView 

Una vez completada la instalación del software mView, aparecerá un 

acceso directo placed on the desktop , Al mismo tiempo, el el 

grupo de programas mView correspondiente se ha agregado a Windows 

menu de inicio: 

 

Elija uno de los dos métodos anteriores para abrir el software de 

programación mView. Cuando se inicia la aplicación, aparecerá una ventana 

de inicio, como se muestra en la siguiente figura. Después de abrir el software, 

se verificará de acuerdo con la barra de menú [Ver]->[Opción...]->[Archivo]->El 

programa inicia automáticamente el archivo abierto, para determinar si se 

inicia el último archivo del proyecto cuando el se abre el software, o no abrir 

ningún archivo. 
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1.3 Introducción a la interfaz del software mView 

Diseño de la interfaz de edición de mView:

 
● Barra de título: muestra la ruta del proyecto abierto actualmente y el nombre 

del archivo, el número de ventana y el nombre de la ventana. 

● Barra de menú: un menú que muestra varios comandos de CoolMayView. 

Estos menús son menús desplegables. 

● Barra de herramientas estándar: Botones de acceso directo para colocar 

algunos comandos. Botones correspondientes y herramientas de edición para 

mostrar archivos, editar, imprimir y otras funciones. 

● Componentes de diseño: Botones de comando para objetos componentes. 

● Gestión de pantalla: La ventana de gestión de la pantalla utilizada por el 

proyecto. 

● Gestión de comunicaciones: diseñadores de ingeniería para gestionar, 

configurar una ventana para comunicarse con PLC u otros dispositivos serie. 

● Gestión de etiquetas: establezca etiquetas para las variables del sistema y 

las variables externas para facilitar a los usuarios la búsqueda rápida de las 

variables correspondientes. 

● Barra de estado: muestra el estado de funcionamiento actual, los 

parámetros de la interfaz hombre-máquina y el equipo de comunicación. 

Capítulo 2 Introducción al menú de ejecución del 

software mView
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2.1 Menú Archivo 

Use el mouse para hacer clic directamente en [Archivo], o use el teclado 

para presionar [ALT] + [F], aparece el menú desplegable [Archivo], como se 

muestra en la Figura 2-1.1. Para facilitar a los usuarios la selección rápida, 

también se proporcionan iconos de acceso directo en la barra de herramientas, 

como se muestra en la Figura 2-1.2. 

 

2-1.1 

 

2-1.2 

File toolbar 

（ 1

） 

New File… 

（ 2

） 

Open File… 

（ 3

） 

Save File 

2.1.1 New File… 

Para crear un nuevo proyecto, puede hacer clic directamente en [New File] en 

el menú [File], o hacer clic en el icono en la barra de herramientas, o usar la 

tecla de acceso rápido Ctrl + N establecida por el sistema. Se muestra el 
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cuadro de diálogo que se muestra a continuación:

 

Título: Introduzca el nombre del nuevo proyecto; 

Modelo: seleccione el modelo de la interfaz hombre-máquina (HMI); 

Dirección: seleccione si la pantalla de edición se muestra horizontal o 

verticalmente; 

Descripción: ingrese una descripción de ayuda para el proyecto recién 

creado, o elija no ingresarla. 

Después de completar la entrada de información relacionada con el 

proyecto, haga clic en el botón [OK] para ingresar al cuadro de diálogo de 

configuración de información de comunicación, como se muestra en la 

siguiente figura. Para configuraciones específicas, consulte la sección  

2.4.2 Gestión de la comunicación. 
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2.1.2 Open File… 

Para abrir un archivo existente, puede hacer clic directamente en [Open file...] 

en el menú [File], o hacer clic en el icono en la barra de herramientas, o usar la 

tecla de acceso rápido Ctrl + O configurada por el sistema. Se muestra el 

cuadro de diálogo que se muestra a continuación:
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Seleccione el archivo con el sufijo vxf que debe abrirse, presione el botón 

[Open] o haga doble clic en el archivo de proyecto seleccionado con el mouse. 

2.1.3 Save File 

Para guardar el proyecto editado actualmente en el disco, puede hacer clic 

directamente en [Save File] en el menú [File], o hacer clic en el icono en la 

barra de herramientas, o usar la tecla de acceso directo Ctrl + S configurada 

por el sistema.

 
Al guardar un nuevo proyecto, aparecerá el cuadro Guardar archivo vxf como 

se muestra arriba, ingrese el nombre del proyecto que desea guardar en el 

campo de nombre de archivo y haga clic en el botón [Save]. Si el proyecto ya 

se guardó, al presionar [Save] no se mostrará ningún cuadro de diálogo, sino 

que solo se guardará la información más reciente del proyecto actual. 

2.1.4 Guardar como archivo 

Guarde los datos de pantalla editados actualmente en otro nombre de 

archivo especificado en el disco. Este elemento solo puede ser seleccionado 

por [Save As File] por debajo [File] Ya sea un proyecto nuevo o un proyecto 

antiguo, aparecerá el cuadro de diálogo Guardar nuevo archivo.: 
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Después de ingresar el nuevo nombre del proyecto, haga clic en [Guardar] 

para guardar el proyecto como un nuevo archivo de proyecto 

2.1.5 Close File 

Cierre el archivo de proyecto editado actualmente. Este elemento solo se 

puede seleccionar mediante [Close File] en [File]. Si se modifica el archivo del 

proyecto, aparecerá el siguiente cuadro de diálogo para guardar el archivo del 

proyecto modificado. 

 

Haga clic en el botón [Yes] para guardar el archivo recién modificado y 

luego salga del archivo de proyecto actual; 

Haga clic en el botón [No] para guardar el archivo recién modificado y 

luego salga del archivo de proyecto actual; 
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Haga clic en el botón [Cancel] para salir del cuadro de diálogo y no hacer nada 

con el archivo recién modificado; 

2.1.6 Importar 

 

2.1.7 Exportar 
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2.1.8 Exit 

Finalice la aplicación y guarde el proyecto, seleccione la opción [Exit] en 

el menú [File], o haga clic en el botón  en la ventana principal. Si el 

proyecto ha cambiado, o no se ha guardado, aparecerá el siguiente cuadro de 

diálogo: 

 

Haga clic en el botón [Yes] para guardar el archivo recién modificado y luego 

cierre el programa de software actual; 

Haga clic en el botón [No] para guardar el archivo recién modificado y luego 

cierre el programa de software actual; 

Haga clic en el botón [Cancel] para salir del cuadro de diálogo y no hacer nada 

con el archivo recién modificado; 

2.2 Menú de edición 

Use el mouse para hacer clic directamente en [Editar], o use el teclado para 

presionar [ALT] + [E], aparece el menú desplegable de [Editar], como se 

muestra en la Figura 2-2.1. Para facilitar a los usuarios la selección rápida, 

también se proporcionan iconos de acceso directo en la barra de herramientas, 

como se muestra en la Figura 2-2.2 
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como se muestra en la Figura 2-2.2.  

2-2.1 

 

2-2.2 

(1) Deshacer【Ctrl+Z】 (9) Ordenar 

(2) Rehacer【Shift+Ctrl+Z】 (10) Group 

(3) Cortar【Ctrl+X】 (11) Desagrupar 

(4) Copiar【Ctrl+C】 (12) Lock 

(5) Pegar【Ctrl+V】 (13) Propiedad 

(6) Alinear (14) Mismo bisel 

(7) Tamaño (15) Misma fuente 

(8) Jog   
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2.2.1 Deshacer 

Para deshacer la última acción editada, puede seleccionar la opción [Undo] en 

[Edit], o hacer clic en el icono en la barra de herramientas, o usar la tecla de 

acceso rápido Ctrl + Z configurada por el sistema. 

2.2.2 Rehacer 

Para restaurar la acción de deshacer anterior, puede seleccionar la opción 

[Rehacer] en [Editar], o hacer clic en el icono en la barra de herramientas, o 

usar la tecla de acceso rápido shift + Ctrl + Y establecida por el sistema. 

2.2.3 Cortar 

Corta los componentes seleccionados para pegarlos en la nueva ubicación. 

Puede seleccionar la opción [Cut] en [Edit], o hacer clic en el icono en la barra 

de herramientas, o usar la tecla de acceso rápido Ctrl + X establecida por el 

sistema. 

2.2.4 Copiar 

Si los componentes utilizados son los mismos, puede utilizar la operación de 

copia para hacer los mismos componentes. Puede seleccionar la opción 

[Copy] en [Edit], o hacer clic en el icono en la barra de herramientas, o usar la 

tecla de acceso rápido Ctrl + C configurada por el sistema. 

2.2.5 Copia múltiple 

Seleccione un componente específico para hacer múltiples copias, puede 

seleccionar la opción [Copia múltiple] en [Editar], o usar la tecla de acceso 

rápido Ctrl + M configurada por el sistema. Después de hacer clic, aparecerá 

el cuadro de selección como se muestra a continuación: 
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Múltiples configuraciones de copia 

Número de copias horizontales: establezca el número de copias en la 

dirección horizontal. 

Número de copias verticales: establece el número de copias en dirección 

vertical. 

Puntos de intervalo horizontal: establezca la distancia entre los elementos 

horizontales. 

Puntos de espaciado vertical: establezca la distancia entre los componentes 

verticales. 

Modificación de variable de componente 

Sin corregir: no se realiza ningún procesamiento en los componentes 

copiados. 

Aumento en la dirección horizontal: establezca el orden en que el 

dispositivo lee los elementos blandos para aumentar horizontalmente y luego 

verticalmente. 

Incremento vertical: establezca el orden en que el dispositivo lee el 

dispositivo para aumentar primero verticalmente y luego horizontalmente. 

Valor de compensación de dirección: establezca el número de incrementos del 

valor del dispositivo de lectura del dispositivo. 

● Ejemplo de copia múltiple: seleccione el número horizontal = 2 y el número 

vertical = 3 encima del número de copias 

 

● Ejemplo de copia múltiple: Haga clic en [OK] para completar la copia 

múltiple. El resultado se muestra a continuación: 
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2.2.6 Pegar 

Para insertar los componentes copiados o cortados, puede seleccionar la 

opción [Paste] en [Edit], o hacer clic en el icono en la barra de herramientas, o 

usar la tecla de acceso rápido Ctrl + V configurada por el sistema. 

2.2.7 Alineación 

Seleccione los componentes que deben alinearse y debe haber más de 

dos componentes. Click [Align] por debajo [Edit], como se muestra a 
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continuación, o haga clic en el

 
En este ejemplo, seleccione [Upper Edge Alignment]. Este método de 

alineación utiliza el borde superior del objeto de referencia como alineación del 

objeto. Como se muestra abajo:

 
2.2.8 Size 

Seleccione los componentes que deben configurarse con el mismo 

tamaño. Debe haber más de dos componentes. Hacer clic [Size] por debajo 

[Edit], como se muestra a continuación, o 

icono en la barra de herramientas  
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Al seleccionar más de dos componentes gráficos, para acelerar la edición del 

tamaño del componente, puede usar esta función de alineación para 

seleccionar primero el componente gráfico cuyo tamaño desea modificar y 

luego seleccionar qué componente es el principal. A continuación, seleccione 

[Same Width] o [Same Height] o [Same Size]. Como se muestra en la siguiente 

figura [same width]: 

 

 
2.2.9 Jog 

Utilice esta función para mover con precisión la posición del componente 

seleccionado. Después de seleccionar el componente, haga clic en [Fine 

Adjustment] en el menu [Edit] como se muestra a continuación, o haga clic en 

el icono en la barra de herramientas, Puede mover la posición del 

componente seleccionado arriba, abajo, a la izquierda y a la derecha en detalle, 

click en icono en la barra de herramientas   
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o puede usar la tecla arriba, abajo, izquierda y derecha del teclado (fine 

adjustment), o puede usar Mayús + teclas arriba, abajo, izquierda y derecha del 

teclado (con un punto de cuadrícula) Principal), Ctrl + teclado arriba, abajo, 

izquierda, derecha Botón (cambiar el ajuste fino del tamaño del componente 

seleccionado) para un movimiento rápido y ajuste de tamaño. 

 

2.2.10 Order 

Después de seleccionar el componente, haga clic en [Sequence] en el 

menú [Edit] como se muestra a continuación, o haga clic en el icono  en 

la barra de herramientas, cuando los componentes se superponen, los 

componentes se pueden mover a la capa superior, la siguiente capa, la capa 
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superior y la capa inferior según los requisitos.

 

2.2.11 Setup 

Seleccione los componentes del componente que deben configurarse con 

el mismo borde y la misma fuente. Debe haber más de dos componentes. 

Haga clic en [Configuración] debajo de [Editar] como se muestra en la 

siguiente figura. O haga clic  en la barra de herramientas, puede 

configurar el borde o la fuente de varios componentes para que sea el mismo 

que el borde o la fuente del componente de referencia seleccionado. 

o 
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2.2.12 Group / Ungroup 

Al seleccionar múltiples componentes, al mover o copiar, para poder 

editar de forma rápida y sencilla. Puedes hacer clic [Group / Ungroup] en el 

menú [Edit], o haga clic en  icono en la barra de herramientas. 

Para agrupar varios componentes en un solo componente, a saber, [Group], 

también puede utilizar la tecla de acceso directo [G]. Seleccione los 

componentes ensamblados previamente y haga clic en [Cancel group] para 

separarlos, o use la tecla de acceso rápido [U]. 

2.2.13 Lock object / unlock object 

Después de seleccionar uno o más componentes, haga clic en [Lock 

Object] en el menú [Edit] para corregir el componente. El componente fijo no 

se puede mover y sus atributos no se pueden modificar. Para liberar la 

configuración, seleccione el componente que desea liberar y haga clic en 

[Lock Object] en el menú [Edit] de nuevo para liberar. 

o 
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O haga clic  en la barra de herramientas para bloquear o 

desbloquear el componente, también puede usar la tecla de acceso rápido [L] 

para reparar o cancelar. 

 

2.2.14 Object properties 

Dado que la ventana de propiedades del objeto de cada componente es 

diferente, consulte la descripción detallada en el capítulo [Capítulo 3 

Componentes] de este manual. 

2.2.15 Copy Screen Picture 

Haga clic en [Copy Screen Picture] en el menú [Edit] para copiar la ventana de 

pantalla de edición actual, como se muestra en la siguiente figura. Después de 

copiar, puede pegar la imagen de la pantalla en un software de dibujo o 

software de oficina como WORD para facilitar la clasificación de archivos.

 

o 
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2.2.16 Save to BMP 

Después de seleccionar el componente que desea guardar como imagen, 

haga clic en [Save to BMP] en el menú [Edit], aparecerá un cuadro de diálogo 

como se muestra en la figura a continuación, seleccione la ruta de guardado, 
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ingrese el nombre de la imagen para ser guardado, y haga clic en [Save (S)】 

para guardar el componente seleccionado como una imagen. 

 

2.2.17 Add Repository 

Esta función coloca el componente en la biblioteca de componentes. Al 

usarlo, puede abrir la biblioteca de componentes y seleccionar rápidamente el 

componente de acuerdo con la clasificación y el nombre de la configuración 

del componente en la biblioteca de componentes.. Después de seleccionar 

cualquier componente, click [Edit]-> [Add Repository], aparecerá el siguiente 

cuadro de diálogo: 

 

Type : Establezca la categoría del componente en la biblioteca de 

componentes. 
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Group: Establezca la categoría del componente en la biblioteca de 

componentes. 

Name: Establezca la categoría del componente en la biblioteca de 

componentes. 

Description: Complete la descripción auxiliar del componente de 

descripción. Una vez completada la configuración, haga clic en el botón 

[Aceptar] y el componente seleccionado entrará en la biblioteca de 

componentes de software, como se muestra en la siguiente figura:

 
Cuando está en uso, puede hacer doble clic en el componente 

directamente en la biblioteca de componentes, lo que puede guardar los 

detalles, como configurar la fuente de apariencia, lo que mejora en gran 

medida la velocidad de escritura del programa. 

2.3 View 

Use el mouse para hacer clic directamente en [Ver], o use el teclado para 

presionar [ALT] + [V], aparece el menú desplegable [Ver], como se muestra en 

la Figura 2-3.1. Para facilitar a los usuarios la selección rápida, también se 

proporcionan iconos de acceso directo en la barra de herramientas, como se 

muestra en la Figura 2-3.2. 

. 

2-3.1 
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2-3.2 

(1) Project 

(2) Option 

(3) Scale 

(4) Zoom in 

(5) Zoom out 

2.3.1 Project management 

1. La ventana de gestión de proyectos se refiere a la visualización y 

gestión completas de la pantalla y la comunicación del proyecto de edición 

actual. Haga clic en [Project management] en el menú [View], existen las 

siguientes cuatro sub-opciones. 

2. Scene: Después de hacer clic en la escena, aparecerá una ventana 

para administrar la pantalla a la izquierda del software (esta ventana también 

es la ventana de visualización predeterminada), o haga clic directamente 

[Screen] en la esquina inferior izquierda del software. La ventana de 

administración de imágenes se muestra en la siguiente figura. La ventana de 

gestión es responsable de la organización y planificación de todas las 

pantallas de la interfaz hombre-máquina. Para más detalles, consulte 

4.1ScreenManagement. 

 

3. Communication: Después de hacer clic en comunicación, aparecerá 

una ventana para la administración de enlaces en el lado izquierdo del 
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software, o haga clic en [Link] en la esquina inferior izquierda del software. La 

ventana de gestión de enlaces se muestra en la siguiente figura. Esta ventana 

de gestión es responsable de la interfaz hombre-máquina y el control 

programable El protocolo de comunicación y los ajustes de configuración 

entre el PLC (PLC) u otros dispositivos de comunicación en serie. Para más 

detalles, consulte 4.2 Link Management. 

 
4. Tag: Después de hacer clic en Etiqueta, la ventana de administración 

de etiquetas aparecerá a la izquierda del software, o haga clic directamente en 

[Tag] en la esquina inferior izquierda del software. La ventana de 

administración de etiquetas se muestra en la siguiente figura. Para obtener 
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más información, consulte 4.3 Gestión de etiquetas.

 
5. Language : Después de hacer clic en Idioma, aparecerá un cuadro de 

diálogo para la configuración de idioma como se muestra en la siguiente 

figura. Para obtener más información, consulte el Capítulo 5Language 

Management. 

 

2.3.2 Message window 

Haga clic en [Mensaje] en el menú [Ver] y aparecerá la ventana de revisión 

gramatical como se muestra a continuación. Cuando se ejecuta, si hay un error 

de configuración, se mostrará en la ventana de verificación de sintaxis para 
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modificar el programa.

 

2.3.3 Repository 

Haga clic en [Repositorio] en el menú [Ver], o use el atajo de teclado [F12], 

aparecerá el repositorio como se muestra a continuación. Al realizar la 

programación de la interfaz, utilice esta ventana para acceder cómodamente a 

los componentes necesarios.
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Cuando esté en uso, seleccione la clasificación de componentes según sea 

necesario. Como se muestra en la figura a continuación, seleccione el 

componente que se utilizará en cada categoría, haga doble clic en el 

componente y el componente se colocará en la ventana de la pantalla 

derecha.  

2.3.4 Component list 

Haga clic en [Lista de componentes] en el menú [Ver], o use el atajo de 

teclado [F10], y aparecerá la ventana de lista de componentes como se 

muestra a continuación. En la ventana de lista de componentes, puede ver 

intuitivamente todos los componentes utilizados en la ventana de pantalla 

actual. 
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2.3.5 Option(H) 

Haga clic en [Opción(H)] en el menú [Ver] y aparecerá el cuadro de diálogo de 

configuración auxiliar como se muestra en la siguiente figura.

 

Snap/Grid: El cuadro de diálogo se muestra arriba 

Snap ON: Esta opción se refiere a si la esquina superior izquierda del 

elemento establecido debe estar en la cuadrícula establecida al editar la 

pantalla. 

En el cuadro combinado de ajuste, la distancia entre el ajuste se establece por 

separado en la dirección XY y el rango de configuración permitido es de 1 a 

32. Se recomienda que la configuración sea coherente con la dirección XY de 

la cuadrícula. 

Grid ON: Esta opción se refiere a si mostrar la cuadrícula auxiliar de fondo al 

editar la pantalla. 

En el cuadro combinado de la cuadrícula, establezca el espaciado de los 

puntos de la cuadrícula en la dirección XY, y el rango permitido es 1 ~ 32. 

Grid color: Establezca el color de visualización de la cuadrícula. 

Object snap: Esta opción se refiere a si mostrar la guía de alineación cuando 

el elemento en movimiento se alinea hacia arriba, hacia abajo, hacia la 

izquierda y hacia la derecha al editar la pantalla. 

En el cuadro combinado de espaciado de alineación de objetos, configure el 

espaciado de alineación en la dirección XY, y el rango de configuración 

permitido es 1 ~ 32. La guía de alineación se muestra cuando la distancia 

entre el componente movido y otros componentes es igual a la distancia de 

alineación establecida. 

Option: Esta opción establece si la pantalla muestra una cuadrícula de fondo 

cuando la relación de visualización de la pantalla es superior al 400 %. 

Aux. Data of Obj.: El cuadro de diálogo de configuración se muestra a 

continuación. 
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Only Selected Obj.: Marque esta opción, las siguientes opciones solo se 

muestran para los componentes seleccionados, de lo 

contrario, se muestran todos los componentes en la 

pantalla. 

Obj. Sequence: Marque esta opción, el orden de cada componente se 

mostrará en la pantalla. 

Obj. Name: Marque esta opción, el nombre de cada componente se mostrará 

en la pantalla. 

Parameter (Normal): Marque esta opción, la pantalla mostrará la información 

completa de las variables correspondientes a cada componente. 

Parameter (Simplify): Marque esta opción, la información simple de las 

variables correspondientes a cada componente se mostrará en la pantalla 

Component Edit: El cuadro de diálogo de configuración se muestra a 

continuación. 
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Marque esta opción, el sistema abrirá el cuadro de diálogo de propiedades del 

componente inmediatamente después de agregar un nuevo componente. De 

lo contrario, debe hacer doble clic manualmente en el componente para abrir 

el cuadro de diálogo de propiedades. 

File: El cuadro de diálogo de configuración se muestra a continuación. 

 

1.  Después de crear un nuevo proyecto, se agrega automáticamente un 

protocolo de comunicación: Marque esta opción. Después de crear un 

nuevo proyecto, se muestra automáticamente un cuadro de diálogo para 
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agregar un nuevo protocolo de comunicación para facilitar el usuario para 

establecer el protocolo de comunicación. De lo contrario, debe configurarse 

manualmente en la gestión de comunicación. Al cerrar la ventana de la 

pantalla, pregunte si desea guardar: marque esta opción, al cerrar el 

archivo, si el archivo agrega contenido nuevo, le preguntará si desea 

guardar. 

2. Copia de seguridad automática de archivos al guardar un proyecto: Marque 

esta opción para hacer una copia de seguridad automática de los archivos 

al guardar un proyecto. El archivo de copia de seguridad tiene la misma 

ubicación que el archivo de origen y el nombre del archivo es diferente. 

3. Copia de seguridad automática al abrir el proyecto de la versión anterior: 

Marque esta opción para hacer una copia de seguridad del archivo de la 

versión anterior al abrir el archivo de la versión anterior. 

4. Abrir automáticamente archivos antiguos cuando se abre el programa: 

marque esta opción para abrir el archivo desde el último cierre cuando se 

abre el software por primera vez. De lo contrario, debe crear un archivo 

nuevo o abrir manualmente el archivo anterior después de abrir el 

programa. 

5. Agregar información descompilada: marque esta opción para agregar 

información descompilada al compilar el archivo del proyecto. Es decir, el 

archivo de proyecto leído desde la HMI puede modificarse por 

programación. 

Compresión del programa: cuando se descarga el programa, el archivo del 

proyecto se comprimirá para ahorrar tiempo de descarga. 

Frame Size Transfer: El cuadro de diálogo de configuración se muestra a 

continuación. 
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Mini Size：Después de configurar la conversión del modelo, el tamaño 

mínimo del tamaño del texto del componente es 8 

Max Size: Después de configurar la conversión del modelo, el tamaño 

máximo del tamaño del texto del componente es 32 

En el mismo programa, cuando se convierte el modelo, debido a los diferentes 

tamaño de la pantalla, los componentes de la pantalla se ampliarán o reducirán 

proporcionalmente. El tamaño de fuente se establece aquí. Durante el proceso 

de conversión, el tamaño de la fuente se modificará de acuerdo con esta 

configuración para que la pantalla convertida tenga un diseño más coordinado. 

2.3.6 Auxiliary data of Object 

Para conocer el contenido de esta sección, consulte Datos auxiliares del objeto 

en la sección. 

2.3.7 Scale 

Haga clic en [Escala] en el menú [Ver], como se muestra a continuación:

 

Puede elegir la relación de tamaño de la ventana de imagen según sus 

preferencias. Para ajustar la relación de tamaño de la pantalla, también puede 

usar la tecla de acceso directo de acercamiento [I] y la tecla de acceso directo 
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de alejamiento [O] establecidas por el sistema.

 

50% magnification display 

 

100% magnification display 

2.3.8 Toolbar 

Haga clic en [Barra de herramientas] en el menú [Ver], puede seleccionar y 

mostrar libremente las herramientas en la herramienta de acceso directo, 
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como se muestra en la siguiente figura:

 

2.4 Project 

Use el mouse para hacer clic directamente en [Proyecto], o use el teclado para 

presionar [ALT] + [P], aparecerá el menú desplegable [Proyecto], como se 

muestra en la Figura 2-4.1. Para facilitar a los usuarios la selección rápida, 

también se proporcionan iconos de acceso directo en la barra de herramientas, 

como se muestra en la Figura 2-4.2.  

                                                             2-4.1 
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2-4.2 

(1) Screen 

(2) Communication 

(3) Tag 

(4) Language 

(5) Keyboard Define 

(6) Alarm 

(7) Password 

(8) Sound 

(9) Protection 

(10) Data Sync 

(11) Record 

(12) Data Schedule 

(13) Recipe 

(14) System Configuration 

(15) Macro 

(16) Report Manager 

2.4.1 Screen 

Haga clic en [Pantalla] en el menú [Proyecto], aparecerán las opciones que se 

muestran en la siguiente figura y los usuarios pueden realizar operaciones 

como agregar, copiar, editar y eliminar pantallas según las necesidades del 

programa. Cuando el foco del mouse está en el grupo de pantalla actual del 

programa de software, las opciones de agregar, editar, eliminar un grupo y 
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abrir y cerrar la pantalla del grupo se resaltarán y se podrán usar.

 

1. Add Screen Group: Haga clic en [Agregar grupo de pantallas] y aparecerá el 

cuadro de diálogo de configuración que se muestra a continuación. 

 

Group Name: Introduce el nombre de este grupo. 

Security: Autoridad de operación 1 ~ autoridad de operación 9, cuanto 

mayor sea el número, menor será la autoridad. 

Description: Ingrese la descripción de ayuda de este grupo, puede dejarlo 

en blanco. 

2. Edit Screen Group: Click [Edit Screen Group] para abrir el cuadro de 

diálogo de configuración como se muestra en la siguiente figura. Esta función 

se refiere a cuando la descripción del grupo no es perfecta al crear un nuevo 

grupo, o cuando la descripción del grupo original necesita ser modificada, use 
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esta función para modificar la información relevante del grupo.

 
3. Delete Screen Group: Click [Delete Screen Group], y aparecerá el 

cuadro de diálogo de configuración que se muestra a continuación. Después 

de hacer clic en el botón [Aceptar], el sistema eliminará toda la información de 

la pantalla del grupo. Después de hacer clic en el botón [Cancelar], el sistema 

no realiza ninguna operación en el grupo. 

 

4. Open Screen Group: haga clic en esta opción para abrir toda la 

información de la pantalla en el grupo seleccionado. 

5. Close Screen Group: haga clic en esta opción para cerrar toda la 

información de la pantalla en el grupo seleccionado. 
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6. Add Screen: Cuando haga clic en esta opción, aparecerá el cuadro de 

diálogo Nueva pantalla como se muestra a continuación.

 

Screen 

Name: Introduzca el nombre de la escena recién creada. 

ID: Introduzca el número de la pantalla recién creada. El rango de 

configuración del número es 1 ~ 32767. El número de cada 

pantalla no se puede repetir. 

Type: Haga clic en la flecha desplegable y aparecerán 4 opciones. 

Normal Screen: Pantalla de operación de edición básica. 

Dialog box: Seleccione esta opción para configurar la pantalla como la 

página del cuadro de diálogo. 

Las funciones específicas de la caja de marcación se refieren al capítulo 

4.1.1. 
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Boot Screen: Seleccione esta opción, la página actual es la primera 

pantalla que aparece cuando abre la pantalla táctil, similar a la pantalla de 

inicio de una computadora. 

Initial screen: La primera pantalla después de encender la pantalla táctil 

(la se ha mostrado la pantalla de inicio). 

Security: Autoridad de operación 1 ~ autoridad de operación 9, cuanto 

mayor sea el número, menor será la autoridad. La configuración de la 

contraseña de la autoridad correspondiente se establece en [Project]-> 

[Password] 

Set by screen group: La autoridad de operación es la misma que la 

autoridad del grupo de pantallas. 

Inherit: Seleccione esta opción para que la pantalla herede la 

configuración de la pantalla seleccionada. 

La imagen heredada se denomina padre y la imagen heredada actual es 

hijo. Cuando el hijo hereda al padre, todos los componentes del padre se 

heredarán juntos, pero el hijo no puede cambiar los componentes del 

padre y solo puede crear o modificar sus propios componentes. Si desea 

modificar los componentes principales en la pantalla secundaria, debe 

abrir la pantalla principal y luego modificar los componentes. En este 

momento, todos los símbolos principales en las imágenes secundarias 

que heredan la principal se modificarán al mismo tiempo. 

Description: Introduzca una descripción de ayuda para la pantalla actual. 

Auto Switch 

Delay Time: El intervalo de tiempo al cambiar entre escenas. 

Jump to: Después de configurar la pantalla de selección, cuando se 

alcance el tiempo de retraso, saltará a la pantalla de configuración. 

Load BG Image: Haga clic en este botón para seleccionar la imagen 

deseada como fondo de pantalla. 

Clear BG Image: Haga clic en este botón para eliminar la imagen de 

fondo de la pantalla. 

Position: Establezca la posición de la imagen de fondo. 

Macro: 

Screen OPEN Macro: Haga clic aquí para abrir un cuadro de diálogo para 

editar el programa macro cuando se abre la pantalla. 

Screen CLOSE Macro: Haga clic aquí para abrir un cuadro de diálogo 

para editar el programa macro cuando la pantalla está cerrada. 

Screen CYCLE Macro: Haga clic aquí para abrir un cuadro de diálogo 

para editar el programa macro ejecutado en esta pantalla. 
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CYCLE Macro Interval : Configure el intervalo de tiempo al ejecutar el 

programa macro de esta pantalla.

 
Quick jump page: 

Configure la página de la pantalla para el cambio de página cuando use 

los gestos hacia la izquierda, hacia la derecha, hacia arriba y hacia abajo. 

Controlled condition: se refiere a las condiciones necesarias para el 

establecimiento de esta función de deslizamiento, como se muestra en la 

figura anterior, cuando N0 = 100, deslice la pantalla táctil de la HMI hacia la 

izquierda y la pantalla salta de la pantalla actual a la pantalla 1. 

Apply all screens: Marque esta opción, las páginas de pantalla de 

diapositivas de todas las pantallas de este grupo son las mismas. 

Sub Screen: 
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Display Addr: Establezca la posición variable. Bit0-bit3 de la subpantalla 

de control de variables 1-subpantalla 4 respectivamente. 

Cuando se cambia la variable, se mostrará la pantalla 

secundaria correspondiente, pero la pantalla secundaria 

solo está en el estado de visualización. Como se muestra 

en la figura anterior: cuando N0.0=1, se muestra la 

pantalla secundaria 1; cuando N0.1=1, se muestra la 

pantalla secundaria 2; y así... 

Control Addr: Configure la dirección de la variable de pantalla de control, 

bit0-bit3 de esta variable controla las variables de la 

pantalla secundaria 1 a la pantalla secundaria 4 

respectivamente; cuando cambia [Display Addr], se 

mostrará la pantalla secundaria correspondiente, en este 

momento [Control Addr] Puede operar la pantalla 

secundaria al cambiar. Como se muestra en la figura 

anterior: cuando N0.0=1, se muestra la subpantalla 1, y 

cuando N1.0=1, se pueden operar las variables de la 

subpantalla 1. Y así... 

Sub-Screen 1/2/3/4: Configure la pantalla secundaria que se mostrará 

cuando cambie la variable. 

Para obtener más información, consulte el sitio web oficial "Sub-screen 

example" 
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Fast Communication: 

A saber, área de lectura rápida, establezca la variable de comunicación 

rápida de la pantalla actual, de modo que la variable establecida se pueda 

leer rápidamente. 

7. Copy Screen: Al hacer clic en esta opción, la pantalla actual se copiará en 

la mesa de trabajo de la PC, lo cual es conveniente para crear rápidamente 

una nueva pantalla. 

8. Edit Screen: Haga clic en esta opción para editar o modificar los atributos 

de la pantalla actual. 

9. Delete Screen: Al hacer clic en esta opción, se eliminará la pantalla actual. 

El cuadro de diálogo de confirmación para eliminar la pantalla se muestra 

como se muestra en la figura a continuación. Haga clic en [Aceptar] para 



Manual de programación de HMI de la serie TK 

 48 
https://coolmay.com.ar 

eliminar la pantalla y haga clic en [Cancelar] para no hacer nada en la pantalla 

actual.  

10.Lock Screen: Haga clic en esta opción para corregir los componentes de la 

pantalla actual. No puede agregar, eliminar o modificar los componentes en la 

pantalla. 

11. Open Screen: haga clic en esta opción, la pantalla salta a la pantalla 

donde se encuentra el enfoque en la administración de pantalla. 

12. Ejemplo: La pantalla actual es la pantalla 1, haga clic en la pantalla 2 

en administración de pantalla y luego haga clic en [abrir pantalla], luego la 

pantalla actual salta a la pantalla 2. 

13. All Screen to BMP: Haga clic en esta opción para generar todas las 

imágenes del proyecto actual como imágenes y guardarlas en la ruta 

especificada por el usuario. 

2.4.2 Communication 

Click [Communication] under the [Project] menuy aparecerán las opciones 

que se muestran en la siguiente figura. El usuario puede agregar, editar y 

eliminar protocolos y controladores de comunicación de acuerdo con las 

necesidades del programa. 
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1. Add Protocol: Después de seleccionar un puerto de comunicación que no ha 

sido configurado con un protocolo de comunicación, haga clic en 

[Comunicación] y luego se resaltará la opción [Agregar protocolo]. Haga clic en 

esta opción, aparecerá el siguiente cuadro de diálogo:

 
Protocol: Utilice las opciones desplegables para seleccionar el protocolo 

de comunicación a utilizar. 

Controller: Muestra el fabricante y modelo seleccionado por el protocolo 

de comunicación. 
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Port: Hay cuatro opciones de selección, identificación automática, RS232, 

RS422, RS485. 

Baud Rate: desde 150 ~ 115200 tarifa, disponible para la selección. 

Parity: [none], [odd parity], [even parity], [mark], [space]. 

Data Bit: [5], [6], [7], [8]. 

Stop Bit: [1 digit], [2 digits]. 

Delay: desde sin demora, demora 10ms hasta demora 5000ms, 

disponible para selección. 

Timeout: [0.1 sec], [0.2 sec], [0.5 sec], [1 sec], [1.5 sec], [2 sec], [3 sec], [5 

sec], [10 sec] total 9 Options. 

Retry Count: Establece el número de retransmisiones cuando la 

comunicación no tiene éxito. 

Multi-Station Smart Link: consulte el Apéndice 5 para obtener más 

información. 

OK / Cancel: Después de configurar, presione [OK] para guardar la 

configuración completa, presione [Cancelar] para salir del cuadro de 

diálogo sin configurar el protocolo de comunicación. 

Edit Protocol: Después de configurar un nuevo protocolo de 

comunicación, si hay un error de configuración, puede usar esta función 

para modificarlo. 

2. Delete Protocol: elimine el protocolo de comunicación que se ha creado 

recientemente. 

3. Add Controller: Después de agregar el protocolo de comunicación, se debe 

configurar el controlador al que pertenece el protocolo. Haga clic en la opción 

[Agregar controlador], aparecerá un cuadro de diálogo como el que se muestra a 

continuación:
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ID: Número de identificación del controlador. 

Station: el número de estación del controlador, es decir, el número de 

identificación del PLC. 

Controller: Muestra el fabricante seleccionado, el modelo, la descripción y 

otra información. 

Description: Introduzca una descripción o ayuda para este controlador. 

OK / Cancel: Después de configurar, presione [OK] para guardar la 

configuración completa. 

Press [Cancel] para salir del cuadro de diálogo sin configurar el controlador. 

4. Edit controller: Seleccione un controlador existente y haga clic en esta 

opción para modificar su configuración. 

5. Delete controller: Seleccione un controlador existente y haga clic en 

esta opción para eliminarlo. 

6. Variable Window: Haga clic en esta opción para abrir el cuadro de diálogo 

como se muestra en la siguiente figura,

 

Controller: Proporcionar variables internas de HMI o variables del 

controlador establecidas en el protocolo de comunicación para la selección. 

Variable/Para.: Muestra la información específica de las variables 

incluidas en el controlador seleccionado. 

Number: Abra esta ventana en la ventana de propiedades del 

componente, puede ingresar directamente las variables del sistema o 

controlador. 

2.4.3 Tag 
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Hay muchos tipos de controladores que se comunican con la interfaz 

hombre-máquina. El protocolo de comunicación y los números de memoria de 

diferentes fabricantes no son los mismos. Para facilitar la función de 

memorizar contactos y números de memoria, puede utilizar la gestión de 

etiquetas para aumentar la legibilidad. Por ejemplo, al agregar una etiqueta, 

queremos reemplazar el contacto X1 con el nombre "para prueba". Una vez 

completada la adición, ingrese "para prueba" en la posición de escritura o 

lectura solo cuando el componente necesite usar X1 "O haga clic en la opción 

desplegable para seleccionar" para prueba ", el sistema tratará" para prueba 

"como X1. Después de configurar la administración de etiquetas, los usuarios 

pueden reemplazar los nombres de los contactos y la memoria en las 

especificaciones del protocolo de comunicación con nombres que sean fáciles 

de recordar. 

Haga clic en [Etiqueta] en el menú [Proyecto] y aparecerán las opciones que 

se muestran en la siguiente figura. El usuario puede realizar operaciones como 

agregar, editar y eliminar protocolos y controladores de comunicación según lo 

requiera el programa.  

1. Add Tag Group: clasifique las etiquetas para una fácil gestión y edición 

Click [Add Tag Group], aparecerá un cuadro de diálogo como el que se 

muestra a continuación: 
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Ingrese el nombre de la etiqueta recién agregada en el nombre del grupo 

de etiquetas y haga clic en el botón [OK]. Las etiquetas recién agregadas se 

agregan nuevamente a la administración de etiquetas, como se muestra en la 

siguiente figura: 

 
2. Edit Tag Group: modificar el nombre de la etiqueta actualmente 

seleccionada. 

3. Delete Tag Group: modificar la etiqueta actualmente seleccionada. 

Haga clic en esta opción para abrir el cuadro de diálogo como se muestra en la 

figura a continuación. Haga clic en el botón [Aceptar] para eliminar el grupo de 

etiquetas seleccionado. Haga clic en el botón [Cancelar] para mantener el 

grupo de etiquetas seleccionado.

 

4. Add Tag: agregar una nueva etiqueta. 

5. Haga clic en esta opción para abrir el cuadro de diálogo que se muestra 

a continuación: 

 

Tag Group: El grupo de etiquetas actual se escribe de forma 

predeterminada y se puede seleccionar mediante la lista desplegable. 

Tag Name: Ingrese el nombre de identificación correspondiente a esta 

ubicación, puede reemplazar la ubicación. 
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Address: Ingrese el contacto correcto o la ubicación de memoria del 

controlador que se utilizará, y la dirección de registro D101 de Mitsubishi PLC 

FX3U se usa en la figura anterior. 

Max: Ingrese el valor máximo de este contacto o memoria, no puede 

ingresarlo. 

Min: Ingrese el valor mínimo de este contacto o memoria, no puede 

ingresarlo. 

Description: Ingrese la descripción de esta etiqueta, no puede ingresarla. 

OK / Cancel: Después de configurar, presione [OK] para guardar la 

configuración completa, presione [Cancelar] para no continuar Configure la 

etiqueta y salga del cuadro de diálogo. 

5. Edit Tag: modificar el contenido de la etiqueta existente y otras 

operaciones. 

6. Delete Tag: eliminar la etiqueta existente. 

2.4.4 Language 

Click [Language] under the [Project] Aparecerá el menú y aparecerán las 

opciones que se muestran en la siguiente figura. El usuario puede agregar, 

editar, eliminar la selección de idioma y configurar la traducción del idioma 

inicial de acuerdo con las necesidades del programa. 

 

1. Add Language: añadir un nuevo idioma. 

Haga clic en esta opción para abrir el cuadro de diálogo que se muestra a 

continuación: 
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Name: Haga clic en la lista desplegable para seleccionar el idioma 

que desea crear. 

Local ID: El código de región de la región donde se encuentra el 

idioma seleccionado. Este elemento se agrega de manera 

predeterminada. 

Font: muestra la fuente predeterminada predeterminada seleccionada. 

Font: Haga clic en este botón para abrir el cuadro de diálogo de selección 

de fuente, como se muestra en la siguiente figura, puede establecer la fuente 

predeterminada, el estilo de fuente, el tamaño, el efecto, el subrayado y el 

color del nuevo idioma.  

Test: mostrar la plantilla de la fuente seleccionada. 

Decimal: Establece qué símbolo mostrar cuando se muestra el símbolo 

decimal. 

Separate: Establezca qué símbolo usar al mostrar el separador. 

2. Edit language: Haga clic en esta opción para configurar la fuente, el estilo 

de fuente, el tamaño, el efecto, el subrayado y el color del idioma existente. 

3. Delete language: Haga clic en esta opción para eliminar el idioma existente. 
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4. Initial language: haga clic en esta opción en varios idiomas para establecer 

el idioma inicial. 

5. Translate: Haga clic en esta opción para convertir el idioma de la pantalla al 

idioma seleccionado. 

6. Dictionary: Configure la traducción del idioma correspondiente usted mismo. 

Para obtener una introducción detallada y ejemplos de aplicación de la 

gestión de idiomas, consulte el Capítulo 5 Gestión de idiomas. 

2.4.5 Keyboard Define 

Este modelo no tiene esta función temporalmente. 

2.4.6 Alarm 

Después de hacer clic en [Alarma] en el menú [Proyecto], el cuadro de diálogo 

de configuración 

que se muestra a continuación aparecerá para configurar la información de la 

alarma. Para una introducción detallada y casos de gestión de alarmas 

específicas, consulte el Capítulo 6 Gestión de alarmas.

 

Add Alarm: Agregar una nueva área de información de alarma. 



Manual de programación de HMI de la serie TK 

 57 
https://coolmay.com.ar 

 

Name: Ingrese el nombre establecido para la zona de alarma recién agregada. 

Address: La posición de la variable de entrada puede seleccionarse mediante 

el símbolo de flecha desplegable o ingresar directamente la posición 

de la variable. Como se muestra en la figura anterior, el botón de 

icono detrás del cuadro de entrada indica que 

esta posición debe ser PALABRA. Haga clic en este botón para abrir la 

ventana de variables que se muestra a continuación El tipo de 

variable. Al mismo tiempo, también puede ingresar o seleccionar la 

variable deseada en el cuadro de edición de números en la figura a 
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continuación.

 
Mask: Cuando se activa la alarma, esta función se puede usar para 

enmascarar la alarma, es decir, la información y el sonido de 

la alarma no se muestran. El método de selección de la 

dirección de la máscara es el mismo que el método de 

selección de la dirección del área de alarma. 

Update: Puede elegir la frecuencia de actualización. Si selecciona 3 segundos, 

significa que verificará si la alarma se activa cada 3 segundos. 

Delay: elija si desea esperar a que el controlador comience a crear datos y 

luego inicie la hora de la alarma. 

Group: Puede consultar el grupo en el que se clasificará esta alarma. Haga 

doble clic con el botón izquierdo del mouse en el grupo para 

editar el nombre del grupo. 

Description: Ingrese la descripción de ayuda para esta alarma. 

2.4.7 Password 

Después de hacer clic en [Contraseña] en el menú [Proyecto], aparecerá el 

cuadro de diálogo de configuración que se muestra a continuación para 

establecer la contraseña para configurar la autoridad del usuario. Para obtener 

una introducción detallada y un caso específico de gestión de contraseñas, 



Manual de programación de HMI de la serie TK 

 59 
https://coolmay.com.ar 

consulte el Capítulo 7 Gestión de contraseñas.

 

2.4.8 Sound 

Después de hacer clic en [Sonido] en el menú [Proyecto], aparecerá un cuadro 

de diálogo para configurar el audio como se muestra en la siguiente figura para 

configurar el audio que el usuario necesita usar. Para una introducción 

detallada y un caso de gestión de audio específico, consulte el Capítulo 8 

Gestión de sonido.
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2.4.9 Protection 

Después de hacer clic en [Protección] en el menú [Proyecto], aparecerá un 

cuadro de diálogo como el que se muestra a continuación para configurar la 

contraseña de carga/descarga del programa HMI. Para lograr la función de 

protección de datos.  

Protección con contraseña para la carga, descarga, carga y edición de 

proyectos, y configuración de contraseñas y solicitudes de contraseña. 

Después de configurar la [Contraseña de descarga], use la función [Guardar 

proyecto en archivo] en el menú [HMI] para guardar el proyecto como un 

archivo vho. Si desea utilizar este archivo vho para descargarlo a HMI más 

tarde, seleccione [Herramienta]-> [Descargar programa HMI...], aparecerá un 

cuadro de diálogo como el que se muestra en la siguiente figura para 

seleccionar el archivo vho.
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Después de confirmar la selección del archivo vho, haga clic en el botón [Abrir] 

y aparecerá el cuadro de entrada de la contraseña de descarga como se 

muestra en la siguiente figura. Después de ingresar la contraseña 

correctamente, haga clic en el botón [OK] para descargar el programa a la 

HMI.  

2.4.10 Data sync 

Después de hacer clic en [Sincronización de datos] en el menú [Proyecto], 

aparecerá un cuadro de diálogo como el que se muestra a continuación. Para 

obtener una introducción detallada y un caso de gestión de sincronización de 

datos, consulte el Capítulo 9 Gestión de sincronización de datos.
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2.4.11 Record 

Después de hacer clic en [Grabar] en el menú [Proyecto], aparecerá el 

siguiente cuadro de diálogo.

 
Add: Haga clic en este botón para abrir el cuadro de diálogo para definir un 

nuevo registro de datos como se muestra en la figura a continuación. 

Edit: Haga clic en este botón para volver a editar el registro de datos existente 

seleccionado. 

Delete: Haga clic en este botón para eliminar el registro de datos existente 

seleccionado. 

Import: Haga clic en este botón para importar el registro de datos del archivo 

vdr almacenado en la computadora al proyecto HMI. 

Export: Haga clic en este botón para exportar los registros de datos del 

proyecto HMI a una computadora y almacenarlos en un archivo vdr. 

El cuadro de diálogo Agregar definición de registro de datos se muestra a 

continuación: 
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Name: Introduzca el nombre del registro de datos. 

Data Format: Seleccione el tipo de datos. Hay cinco tipos de contactos, 

16 bits firmados/sin firmar, 32 bits firmados/sin firmar. 

Source: Establecer la ubicación de la fuente de datos. 

Data Length: establecer la longitud de los datos, el rango es 1 ~ 16. Por 

ejemplo, si se establece en 4, y la dirección de origen de los datos se establece 

en D0, significa que los datos se leen desde D0 ~ D3, que tiene 4 direcciones 

de registro. 

Record Count: establezca el número total de registros de los datos, el 

rango es 1 ~ 32767. 

Update Time: establecer los datos de registro de tiempo de intervalo. Esa 

es la frecuencia para grabar. 

Record Flag: Establezca una variable y use esta variable para controlar el 

inicio de la grabación y detener la grabación. 

Clear Flag: Configure una variable para controlar el borrado de los datos 

registrados previamente. Por ejemplo, seleccione M0 aquí, cuando M0 esté 

encendido, borre los datos registrados previamente. 

Clear [clear flag]: Marque esta opción para borrar la bandera mientras 

desconecta la bandera clara. Es decir, cuando se enciende M0, después de 

borrar los datos grabados previamente, M0 se apaga. 

Stop Count: Configúrelo para detener la grabación cuando grabe la 

cantidad establecida. 
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Cuando se establece en 0, esta función no se utiliza, es decir, los datos 

siempre se registran. 

Description: Proporcione una explicación complementaria para este 

registro, puede dejarlo en blanco. 

Record Date/Time: Marque esta opción para registrar la hora al registrar 

datos al registrar datos. 

Retentive: Marque esta opción, los datos se guardarán cuando la HMI se 

encienda nuevamente. 

2.4.11.1 Caso de uso de registro 

Haga clic en el menú del software-> [Proyecto]-> [Grabar...], aparece el 

cuadro de diálogo de gestión de registro de datos como se muestra a 

continuación. 

 

Haga clic en el icono [Agregar] y, en el cuadro de diálogo emergente Nueva 

definición de registro de datos, configure cada registro como se muestra a 

continuación:  
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Una vez completada la configuración, haga clic en el botón [OK] y la pantalla 

de gestión de registro de datos es como se muestra a continuación.

 

Después de agregar los datos, se puede utilizar el registro de datos. 

Cuando se utiliza [Elemento]-> [Mostrar elemento]-> [Gráfico de tendencia 

histórica], la pantalla de propiedades [Gráfico de tendencia histórica] como se 

muestra a continuación. 

 

En la lista desplegable de registros de datos, seleccione los datos que 

desea registrar. En este ejemplo, seleccione los datos NNNN. Después de la 

selección, se muestra la siguiente figura. 
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Como se establece en este ejemplo, cuando se alcanza la condición de 

bandera de registro, es decir, cuando N10.0 = 1, los datos de N0 y N1 se 

mostrarán en una curva, y el registro se muestra en la figura a continuación.

 

Cuando necesite eliminar la curva, establezca el valor de la bandera clara en 

0, es decir, N10.1 = 0. En este ejemplo, establezca N10.0 en 0, como se 
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muestra en la siguiente figura.

 

2.4.12 Data schedule 

Después de hacer clic en [Programación de datos] en el menú [Proyecto], 

aparecerá el siguiente cuadro de diálogo. Se puede utilizar para implementar 

los requisitos de programación para un tiempo fijo o un tiempo específico para 

realizar el control. 
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Add: Haga clic en este botón para abrir el nuevo cuadro de diálogo de 

definición de programación de datos, como se muestra en la siguiente figura:  
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Condition: Seleccione la condición de tiempo de la programación de 

datos, que se puede configurar en cuatro modos, que se explican por 

separado a continuación. 

Use fixed time setting (month, week, day, hour, minute, second) 

Marque esta opción, el usuario puede usar la acción al segundo más 

cercano para activar. Como se muestra en la figura anterior, el valor del 

registro D100 se pasa a D101 a las 0:20:37 el 1 de enero y el 4 de agosto 

de enero y agosto. El método de configuración se muestra en la figura 

anterior.Use fixed time setting (month, week, hour, minute) 

Marque esta opción, el usuario puede usar el disparador de acción al 

minuto más cercano o a un período de tiempo (para evitar la situación de que 

la alimentación se enciende después del punto de tiempo establecido y la 

acción no se completa), como se muestra en la imagen, todos los jueves de 

enero Cuando 0, transfiera el valor del registro D100 a D101, el método de 
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configuración se muestra en la figura a continuación. Cabe señalar que el 

"minute" la columna de configuración debe seleccionar todo, por lo que para 

evitar si solo selecciona 0 puntos, si el tiempo de arranque es 0: 1 o posterior, 

esta acción aún se puede completar. 

 

Use time variable settings (month, week, day, hour, minute, second) 

Marque esta opción, el usuario puede elegir el controlador por sí mismo, usar 

un registro continuo (8 palabras) como la variable de tiempo, esta opción 

puede cambiar la condición de tiempo en cualquier momento a través de la 
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configuración de la variable, como se muestra en la siguiente figura:

 

Use time variable setting (week, hour, minute) 

Marque esta opción, el usuario puede seleccionar el controlador por sí mismo 

y usar un registro continuo (3 palabras) como variable de tiempo. Esta opción 

puede cambiar la condición de tiempo en cualquier momento a través de la 
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configuración de la variable, como se muestra en la siguiente figura:

 

Edit: Haga clic en este botón para volver a editar el programa de datos 

existente seleccionado. 

Delete: Haga clic en este botón para eliminar el programa de datos existente 

seleccionado. 

Import: Haga clic en este botón para importar los datos del archivo vdh 

almacenados en la computadora al proyecto HMI. 

Export: Haga clic en este botón para exportar el programa de datos en el 

proyecto HMI a una computadora y almacenarlo como un archivo vdh. 

2.4.13 Recipe 

Después de hacer clic en [Receta] en el menú [Proyecto], aparecerá el 

siguiente cuadro de diálogo. Establezca la receta de datos que el usuario 

necesita usar. Para obtener una introducción detallada y casos de 

configuraciones de recetas específicas, consulte el Capítulo 10 Administración 

de recetas. 



Manual de programación de HMI de la serie TK 

 73 
https://coolmay.com.ar 

 

2.4.14 System Configuration 

Después de hacer clic en [Configuración del sistema] en el menú [Proyecto], 

aparecerá el siguiente cuadro de diálogo. Puede configurar el control de 

pantalla y el modo de ahorro de energía.

 
Scene Control: Configure la variable y controle el cambio automático de la 

pantalla hombre-máquina a través del cambio de los datos variables. 

Dirección de control: seleccione la dirección de la variable o el nombre de la 

etiqueta para controlar el cambio de pantalla. La variable debe ser un número 

sin signo de 16 bits. 
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Tiempo de actualización: establezca el tiempo de actualización del cambio de 

pantalla. 

Manu Switch Frame: establezca el cambio de valor variable después del 

cambio manual de pantalla, mediante "escritura variable 0" y "ID (número) de 

pantalla de cambio de escritura variable". 

Power Down Mode: establecer si el sistema utiliza el modo de ahorro de 

energía 

 
Usar el modo de ahorro de energía: después de marcar esta opción, los 

elementos que se muestran en la siguiente figura se pueden configurar para 

configurar el tiempo del modo de ahorro de energía.
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Cambiar de pantalla al entrar en el modo de ahorro de energía: Después de 

marcar esta opción, aparecerán los ajustes que se muestran en la siguiente 

figura.  

Screen switch: Seleccione la pantalla a la que cambiar cuando ingrese al 

modo de ahorro de energía. 

Después de la acción, establezca la autoridad de operación más baja: 

después de marcar esta opción, al ingresar al modo de ahorro de energía, la 

autoridad de operación se establece en la más baja. 

Cuando se recupere, vuelva a la pantalla anterior: después de marcar 

esta opción, toque la pantalla en el modo de ahorro de energía para volver a la 

pantalla anterior cuando se cambia la pantalla. 

2.4.15 Macro 

Haga clic en [Macro] en el menú [Proyecto], como se muestra en la figura a 

continuación, puede seleccionar la macro que se configurará para escribir la 

macro. La preparación de macroinstrucciones específicas y la introducción de 
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casos, consulte los Capítulos 11 y 12 para obtener más detalles.

 

2.4.16 Report Manager 

Este modelo no tiene esta función temporalmente. 

2.4.17 Setup (Station ID / Model) 

Station ID 

Haga clic en [Configuración]-> [ID de estación] en el menú [Proyecto] para 

abrir el cuadro de diálogo de configuración del número de estación como se 

muestra en la siguiente figura. En uso general, la interfaz hombre-máquina 

puede ser maestra o esclava. Este producto proporciona un total de 191 (0 ~ 

190) grupos de números de estaciones maestras para los usuarios. Group) 
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número de estación, puede configurar varias unidades de visualización para 

usar en el mismo grupo.  

Model 

En general, la planificación de una solución de interfaz hombre-máquina 

lleva mucho tiempo, por lo que el ingeniero optará por modificar o aplicar la 

solución utilizada anteriormente. Si necesita modificar el modelo cuando usa 

diferentes modelos, haga clic en [Configuración]-> [Modelo] en el menú 

[Proyecto] para abrir el cuadro de diálogo de consulta del modelo de 

conversión como se muestra en la figura a continuación. 

 

Al seleccionar el botón [Sí], se guardará el proyecto no convertido, y al 

seleccionar [No], no se guardará nada, y aparecerá directamente un cuadro de 

diálogo para modificar el modelo, el número y otra información, como se 
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muestra en la siguiente figura.

 

Después de ingresar el título del proyecto, el número de modelo y la dirección 

de visualización del nuevo proyecto, haga clic en el botón [Aceptar] para abrir 

el cuadro de diálogo como se muestra en la figura a continuación. Puede hacer 

clic en el botón correspondiente para reemplazar el proyecto según sea 

necesario.  

2.5 HMI 

Use el mouse para hacer clic directamente en [HMI], o use el teclado para 

presionar [ALT] + [M], aparecerá el menú desplegable de [HMI], como se 

muestra en la Figura 2-5.1. Para facilitar a los usuarios la selección rápida, 

también se proporcionan iconos de acceso directo en la barra de herramientas, 



Manual de programación de HMI de la serie TK 

 79 
https://coolmay.com.ar 

como se muestra en la Figura 2-5.2.

 

2-5.1 

 

2-5.2 

(1) Syntax Check 

(2) On-Line Run 

(3) Off-Line Run 

(4) Stop 

(5) Download to HMI 

2.5.1 Syntax Check 

Haga clic en la barra de menú [HMI] [Comprobación de sintaxis] o presione 

directamente la tecla de acceso directo [F8] o haga clic directamente en el 

icono de la barra de herramientas . Al ejecutar [Comprobación de sintaxis], 

compruebe si los nombres de las variables o la configuración son correctos 

durante la compilación de cada pantalla en el proyecto y proporcione 

información de error en [Grammar CHK], para que podamos eliminar la 

información de error. Además, aparecerá el cuadro de diálogo [Syntax CHK 

Mes.], que muestra información como el uso de la memoria, la proporción del 

tipo de datos, los datos de la fuente de la memoria, etc., para que el usuario la 
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consulte al editar. Como se muestra abajo:

 

2.5.2 On-Line Run 

Haga clic en la barra de menú [HMI] [Ejecución en línea] o presione 

directamente la tecla de acceso directo [F9] o haga clic directamente en el 

icono de la barra de herramientas. La ejecución de esta función requiere una 

conexión real con el controlador y, durante la ejecución, el proyecto modificará 

el registro variable correspondiente establecido por el controlador para 

verificar si la acción del controlador establecido se puede realizar con 

normalidad. 

Antes de [Ejecutar en línea], debe configurar la comunicación, haga clic en la 

barra de menú [HMI] [Configuración]-> [Configuración de comunicación], la 

configuración del puerto de comunicación en la página de carga / descarga se 

refiere al uso de la PC designada. El puerto del terminal está conectado a la 

unidad de visualización. La configuración del puerto de comunicación en la 

página de configuración de comunicación de emulación se refiere al puerto de 

comunicación en la unidad de visualización. A continuación se muestran 
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capturas de pantalla de las dos páginas.

 

2.5.3 Off-Line Run 

Haga clic en la barra de menú [HMI] [Ejecutar fuera de línea] o presione 

directamente la tecla de acceso directo [shift+ F9] o haga clic directamente en 

el icono de la barra de herramientas. Al usar esta función, no es necesario 

conectarse con la interfaz hombre-máquina real, por lo que el cliente puede 

usarla para verificar si el proyecto se puede ejecutar normalmente y verificar si 

cada función es correcta. 

2.5.4 Stop 

Cuando no se ejecuta [Ejecución sin conexión], esta opción aparece atenuada 

y no se puede seleccionar. Esta opción se resalta cuando es necesario 

finalizar la ejecución fuera de línea de la computadora. Puede hacer clic en la 

barra de menú [HMI] [Detener] o presionar directamente la tecla de acceso 

directo [Ctrl + F9] o hacer clic directamente en el icono de la barra de 

herramientas. Detener la ejecución de fuera de línea. 

2.5.5 Download to HMI 

Antes de descargar el proyecto a la HMI, primero debe configurar los ajustes 

de comunicación. Aquí puede consultar la configuración de comunicación en 

2.5.2 ejecución en línea. 

Una vez completado el proyecto, debe descargarlo a la HMI. Puede hacer clic 

en la barra de menú [HMI] [Descargar a HMI] o presionar directamente la tecla 

de acceso directo [Ctrl + Alt + S] o hacer clic directamente en el icono de la 
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barra de herramientas . Se muestra el cuadro de diálogo que se muestra a 

continuación.  

Turbo Download: Después de verificar, la velocidad de descarga es más 

rápida. 

Com Port Set: Aquí, seleccione el puerto de la PC donde están 

conectadas la PC host y la HMI. 

Init Register: Después de verificar, el búfer se inicializa al descargar. 

Update Password: Después de verificar, la tabla de contraseñas se 

actualizará al descargar. 

Clear Retentive Reg.: Después de verificar, los datos en el búfer de 

retención de apagado se borrarán al descargar. 

Init Station ID Group: Después de verificar, la configuración del grupo de 

números de estación se actualizará al descargar. 

Update RTC: Después de verificar, configure la hora de HMI para que sea 

la misma que la hora de la computadora al descargar. 

[Download]: Haga clic en el botón de descarga para descargar el 

programa a la HMI.  

[Cancel]: Haga clic en el botón Cancelar para cancelar la descarga del 

programa.. 

[Setup]: Haga clic en el botón de configuración, aparece un cuadro de 

diálogo de configuración de comunicación para configurar la carga/descarga y 

el puerto COM. 

2.5.6 Save To File 

Además de descargar el programa creado directamente a la HMI, el 

software también proporciona un proyecto específico para guardar el 

programa creado por el usuario como un sufijo (.vho) para que los usuarios 

descarguen el programa.. 
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Nota: Si no se marca la barra de menú [Ver]->[Opción...]->[Archivo]-

>[Agregar información descompilada], entonces este archivo de (.vho) solo se 

puede descargar y el programa no se puede modificar. 

Haga clic en la barra de menú [HMI] [Guardar proyecto en archivo], aparecerá un 

cuadro de diálogo como se muestra a continuación. Haga clic en el botón 

[Guardar] para guardar el proyecto como un archivo específico de HMI con la 

extensión (.vho). Haga clic en el botón [Cancelar].

 

Si necesita descargar este programa a la HMI en el futuro, puede hacer clic en 

[Descargar programa HMI...] en el menú [Herramientas] para seleccionar el 

archivo deseado con el sufijo (.vho) para descargar a la interfaz HMI. . 

2.5.7 Setup 

Haga clic en [Configuración]-> [Configuración de comunicación] en la barra de 

menú de [HMI] y aparecerá un cuadro de diálogo como el que se muestra a 

continuación.

 



Manual de programación de HMI de la serie TK 

 84 
https://coolmay.com.ar 

Upload/Download 

Connection Device: Establezca el puerto COM de la computadora a la que 

está conectada la unidad de visualización. 

Fixed Baud Rate (115200, N, 8,1): Seleccione esta opción para usar solo 

esta velocidad de comunicación para comunicarse 

con el PLC. 

Auto. Baud Rate: Seleccione esta opción, puede seleccionar varias 

velocidades. Cuando la HMI se comunica con el PLC, puede usar la velocidad 

seleccionada para la comunicación. 

Simulate COM Set 

COM1: Seleccione el puerto COM en la computadora. 

COM2: Seleccione el puerto COM en la computadora. 

Una vez completada la configuración de la comunicación de la simulación, 

seleccione [HMI (M)]-> [Simulación en línea] para permitir que la PC se 

comunique con el controlador como una HMI, de modo que el usuario pueda 

verificar si la función establecida ha logrado el efecto deseado. 

Una vez completada la configuración de COM1/COM2 en esta página, el toque 

de comunicación en el software se muestra a continuación.

 

2.6 Component 

Haga clic en [Componente], o presione [ALT] + [C], aparece el menú 

desplegable [HMI], como se muestra en la Figura 2-6.1. Para facilitar a los 

usuarios la selección rápida, también se proporcionan iconos de acceso 
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directo en la barra de herramientas, como se muestra en la Figura 2-6.2.

 
2-6.1 

 

2-6.2 

Para el uso de cada componente, consulte el Capítulo 3 [Componente] para 

obtener más detalles. 

2.7 Tool 

Haga clic en [Herramienta], o presione [ALT] + [T], luego aparecerá el menú 

desplegable [Herramienta], como se muestra en la figura 2-7.1.

 

2-7.1 

2.7.1 Download HMI... 

Haga clic en la opción [Descargar programa HMI...] en la barra de menú 

[Herramienta] y aparecerá el cuadro de diálogo que se muestra a continuación. 

El propósito es descargar el archivo guardado con el nombre de sufijo (.vho) 

desde la HMI. El archivo es solo para descargar y no se puede modificar. 

Cree un archivo (.vho), haga clic en la opción [Guardar proyecto en archivo...] 

en la barra de menú [HMI] y el proyecto actual se guardará como un archivo 
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(.vho) en la ubicación especificada por el usuario.

 

Después de seleccionar el archivo (.vho) que desea descargar, seleccione y 

haga clic en el botón [Abrir]. Aparece el siguiente cuadro de diálogo de 

descarga. Después de seleccionar el número de puerto correcto, haga clic en 

el botón [Descargar].  
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El proceso de descarga del proyecto se muestra a continuación.

 

Una vez completada la descarga, haga clic en el botón [Finalizar] para 

completar el proceso de descarga.

 

2.7.2 Upload HMI... 

Utilice esta función para leer el proyecto en la HMI a la PC y guardarlo como 

Proyecto HMI para su modificación y posterior descarga. Haga clic en la 

opción [Cargar programa HMI...] en la barra de menú [Herramienta] y 

aparecerá un cuadro de diálogo como el que se muestra en la siguiente figura. 
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Después de seleccionar el puerto de comunicación correcto, haga clic en el 

botón [Cargar].  

Después de seleccionar y hacer clic en el botón [Cargar], si se establece una 

contraseña de carga en el programa, aparecerá la siguiente pantalla de 

ingreso de contraseña:  

Input password and click [Confirm], an upload picture will be shown as 

below. 

 

Una vez completada la transferencia, se le pedirá al usuario que guarde el 

proyecto como un proyecto dedicado con el sufijo (.vho), como se muestra en 
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la figura a continuación.

 

Seleccione la ruta para guardar el (.vho) y haga clic en el botón [Guardar] para 

guardar el archivo que se lee desde la HMI. Haga clic en el botón [Finalizar] en 

el cuadro de diálogo de carga del programa a continuación, y la HMI lee que el 

programa ha finalizado.  

2.7.3 Update HMI OS... 

1. Para este software, si se lanza la nueva versión del software mView, se 

combinará con la versión correspondiente del sistema operativo. El papel 

del sistema operativo es el software compatible con la computadora inferior. 

Si los usuarios necesitan usar las funciones proporcionadas por la nueva 

versión del software, deben usar la nueva versión del sistema operativo. 

Los pasos de descarga del sistema operativo HMI son los siguientes. 
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2. Haga clic en [Actualizar HMI OS...] en la barra de menú [Herramienta], como 

se muestra a continuación.

 

2. En el cuadro de diálogo emergente, seleccione la versión del sistema 

operativo para actualizar, como se muestra en la figura a continuación. Se 

recomienda actualizar según la versión de software de la computadora host 

utilizada.

 

2. Después de seleccionar el archivo del sistema operativo, haga clic en el 

botón [Abrir], aparece el siguiente cuadro de diálogo, haga clic en el botón 
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[Actualizar] para comenzar a actualizar el sistema operativo.

 
2. El proceso de actualización se muestra a continuación.

 

2. Una vez completada la actualización, debe volver a encender la unidad de 

visualización, aparece el siguiente cuadro emergente, haga clic en [Aceptar].
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2.7.4 Language Selection 

Hay tres idiomas de software de edición disponibles, [chino 

(tradicional)], [inglés], [chino (simplificado)]. El software para cada idioma se 

muestra a continuación.  

[Chinese (Traditional)] 

 

[English] 

 

[Chinese (Simplified)] 

 

2.8 Window 

Haga clic en [Ventana], o presione [ALT] + [W], aparece el menú 

desplegable de [Ventana], como se muestra en la Figura 2-8.1. 

 

2-8.1 
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Cuando necesite usar varias pantallas en un proyecto, para facilitar la 

visualización y edición, puede seleccionar esta forma de editar la pantalla, 

como se muestra en la siguiente figura, puede elegir [Cascada], [Mosaico 

horizontal] y [ Teja Vertical].  

[Cascade] 
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[Tile Horizontal] 

 
[Tile Vertical] 
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2.9 Help 

Haga clic en [Ayuda], o presione [ALT] + [H], aparece el menú desplegable 

[Ayuda], como se muestra en la Figura 2-9.1.

 

2-9.1 

Haga clic en [mView Help], abra el manual de usuario de este software. 

Los usuarios pueden encontrar contenidos relacionados. 

Haga clic en [Acerca de...], aparecerá la versión del software, como se 

muestra en la siguiente figura. Por favor, preste atención a si es la última 

versión. Si tiene alguna pregunta, por favor contáctenos.

 

Capítulo 3 Descripción de la función del componente 

mView 
The components provided by this software are divided into the following five 

categories: 

1.  [Graphic]. 

2. [Static]. 

3. [Button]. 

4. [Display]. 

5. [Edit]. 

3.1 Graphic 

Para usar un componente gráfico, puede hacer clic en [Gráfico] debajo del 

Aparecen la barra de menú [Componente] y las opciones desplegables, como 

se muestra en la siguiente figura 3.1-1, o puede hacer clic directamente en 
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esta opción en la barra de acceso directo de la herramienta, como se muestra 

en la siguiente figura 3.1-2.  

3.1-1 

 

3.1-2 

Seleccione el componente que necesita. Haga clic en el componente y 

presione el botón derecho del mouse para seleccionar las propiedades del 

objeto, o haga doble clic con el mouse directamente en el componente que 

desea editar, aparecerá la configuración de las propiedades del componente. 

La ventana de propiedades [Punto] y [Línea] se muestra a continuación:
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Style: La visualización de punto o línea está disponible. 

Color: Modificar el color del componente. 

Position: X1 / Y1 representa el punto más a la izquierda de [Línea], X2 / Y2 

representa el punto más a la derecha de [Línea]. 

X: Modifique las coordenadas de X para que las coordenadas X del 

componente se muevan a las coordenadas X modificadas. 

Y: Modifique las coordenadas de Y para que las coordenadas Y del 

componente se muevan a las coordenadas Y modificadas. 

Las propiedades de otros componentes son las mismas. Aquí hay un ejemplo.

 
Pen: 

Style: Seleccione el estilo del marco de elipse. 

Color: Seleccione el color del marco de elipse. 

Brush: 

Style: mostrar y establecer el estilo del marco interior de elipse. 

Position: 

X: Introduzca la posición de la coordenada X del elemento de elipse. 

Y: Introduzca la posición de la coordenada Y del elemento de elipse. 

W: Introduzca el ancho del elemento de elipse. 
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H: Introduzca la altura del elemento elíptico. 

3.1.1 Brush Settings 

La sección anterior presenta los pinceles. Esta sección explica los pasos y detalles 

de la configuración del pincel. 

Haga clic en la imagen de vista previa en Estilo de pincel, aparecerá el cuadro de 

diálogo de pincel variable que se muestra a continuación.

 

Brush Effect: Seleccione normal o efecto flash en la lista desplegable. 

Haga clic en la vista previa del estilo de pincel y aparecerá el cuadro de 

diálogo de selección de pincel.

 
Pattern: Seleccione el patrón de pincel que se mostrará. 

Foreground Color: establece el color del patrón del pincel. 

Background color: Verifique el color de fondo para mostrar el fondo; de 

lo contrario, no hay color de fondo. Establezca el color de fondo del patrón de 

pincel. 
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[OK]: Después de configurar, haga clic en [OK] para guardar la 

configuración. 

[Cancel]: Haga clic en [Cancelar] para no guardar la configuración 

seleccionada. 

Variable Brush: Marque esta opción para establecer los parámetros que 

controlan los cambios de pincel. El cuadro de diálogo se muestra a 

continuación. 

 

Data Format: Seleccione el tipo de variable que controla el cambio de 

pincel. 

Condition: Establecer variables específicas. 

Condition: Establezca las condiciones de los cambios de pincel, 

proporcionando un total de seis condiciones para elegir: igual a, no igual a, 

mayor que, igual a, menor que, menor que o igual a. 

Condition: Set the contrast variable. As shown in the figure above, set D0 

to display different brushes when compared with D1 / D2 / D3. 

Pen Style: Seleccione el estilo del marco del pincel. 

Pen Color: Seleccione el color del marco del pincel. 

Brush Style: Seleccione el patrón que muestra el pincel. 

Brush Effect: Seleccione normal de efecto de flash. 

[OK]: Después de configurar, haga clic en [OK] para guardar la 

configuración. 

[Cancel]: Haga clic en [Cancelar] para no guardar la configuración 

seleccionada. 
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3.2 Static Component 

Haga clic en [Estático] debajo de la barra de menú [Componente] y aparecerá 

la opción desplegable para el componente estático, como se muestra en la 

siguiente figura 3.2-1, o puede hacer clic directamente en esta opción en la 

barra de acceso directo de la herramienta, como se muestra en se muestra la 

siguiente figura 3.2-2  

3.2-1 

 

3.2-2 

3.2.1 Static Bevel/ Text 

Después de seleccionar el componente en el área de edición, haga clic con el 

botón derecho del mouse para seleccionar [propiedades], o haga doble clic 

directamente en el componente que se va a editar, aparecerán las 

propiedades del componente, se muestran los cuadros de diálogo de 
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propiedades de texto y bisel estático en las figuras a continuación.
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Bevel 

Select: Seleccione el estilo de bisel del componente, haga clic en 

[Seleccionar] para abrir el cuadro como se muestra a continuación. 

 

Out color: seleccione el color del marco del componente. 

In color: seleccione el color del marco interior del componente. 

Brush 

Style: Seleccione el estilo de pincel del componente, consulte 3.1.1 para 

más detalles. 

Position 

X: Establezca la posición de la coordenada X del elemento. 

Y: Establezca la posición de la coordenada Y del elemento. 

W: Establece el ancho del elemento. 

H: Establezca la altura del elemento. 

Text 

Language: Seleccione el idioma que aprieta el componente. 

Color: Seleccione el color del texto del componente. 

Word Wrap: Marque esta opción. Cuando la longitud es insuficiente, el 

texto se ajustará automáticamente. De lo contrario, no se realizará ningún 

procesamiento de avance de línea. 

Align: Seleccione la posición de alineación del texto de este componente. 

Effect: Seleccione si el texto se muestra como normal o se mueve. 

Flash: Seleccione si el texto se muestra normalmente o parpadea. 
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Font: Seleccione la fuente del texto. Se muestra un cuadro de diálogo 

para seleccionar propiedades de fuente específicas, como se muestra en la 

siguiente figura. 

Text: Introduzca el texto que se mostrará. Este componente admite la 

función de visualización del valor numérico incrustado de la cadena de 

caracteres. Para configuraciones detalladas, consulte el Apéndice 6 para la 

función de visualización del valor numérico incrustado de la cadena de 

caracteres. 

 

Font: Seleccione el estilo de fuente del texto. 

Font style: Seleccione el estilo de fuente del texto. 

Size: Seleccione el tamaño de fuente del texto. 

Effect-Strikeout: Seleccione si el texto debe mostrarse tachado. 

Effect-Underline: Seleccione si el texto debe estar subrayado. 

Effect-Color: Select the color of the text display. 

Sample: Muestra el efecto del estilo de texto seleccionado. 

Script: Select the language range when entering characters. 

3.2.2 Scale 

The property dialog box of the scale component is shown in the figure 

below. Since the [Bevel] setting is the same as that in Section 3.2.1, there is 

not much to repeat here, please refer to the [Bevel] setting in Section 3.2.1. 
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Scale 

Position: Seleccione la dirección de la escala. 

Master Count: seleccione el número de la escala principal, incluida la 

escala superior e inferior. 

Slave Count: seleccione el número de escala menor, la escala pequeña 

en la escala principal. 

Scale: Marque "escala", la escala se mostrará al editar la pantalla y no se 

mostrará si no está marcada. 

Axis: Marque “eje”, el eje de coordenadas se mostrará debajo de la escala 

de la pantalla de edición, y si no está marcado, no se mostrará. 

Pen 

Style: Seleccione el estilo de escala. 

Color: Seleccione el color del estilo de escala. 

Option 

Display Marks: Verifique las marcas de visualización y la báscula 

mostrará el valor de la escala grande, sujeto a los ajustes máximo y mínimo. 

Max: Establezca el valor máximo en la escala. 

Min: Establezca el valor mínimo en la escala. 

Color: Establece el color de la pantalla. 

Decimal Pos: Configure el número de decimales en la marca de 

visualización. 



Manual de programación de HMI de la serie TK 

 105 
https://coolmay.com.ar 

Suffix: Configure la unidad de visualización de la marca de visualización, 

que se puede dejar en blanco. 

Font: Configure la fuente de la marca de visualización. Para 

configuraciones detalladas, consulte la configuración de fuente en 3.2.1. 

3.2.3 Table 

El cuadro de diálogo de propiedades del componente de tabla se muestra a 

continuación. Dado que el [Bisel] es el mismo que en la Sección 3.2.1, no hay 

mucho que repetir aquí, consulte la configuración [Bisel] en la Sección 3.2.1

 
Table 

Row Count: Seleccione el número de líneas en la cuadrícula horizontal. 

Column Count: Seleccione el número de líneas en la cuadrícula vertical. 

Separator Line: Verifique la línea de separación, se generará una línea 

diagonal en la esquina superior izquierda del campo, como se muestra en la 

parte con un círculo azul a continuación. 
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Pen 

Style: Select the line style of the table component. 

Color: Select the line color of table components. 

3.2.4 Picture 

The property dialog box of the picture component is shown below. Since 

the [Bevel] setting is the same as that in Section 3.2.1, there is not much to 

repeat here, please refer to the [Bevel] setting in Section 3.2.1. 

 

Image / Picture 

Muestre el efecto de visualización después de cargar los gráficos. 

Load: Haga clic en este botón para abrir el cuadro de diálogo, seleccione 

el gráfico o el patrón de animación que desea cargar. 

Formatos disponibles: png, gif, jpg, jpeg, bmp, ico, emf, wmf. 

Clear: Haga clic en este botón para borrar el gráfico previamente 

seleccionado. 

Offset 

X: Utilice el punto central del elemento de la imagen como punto base 

para desplazarse hacia la izquierda y hacia la derecha en la dirección X. 

Y: Use the center point of the picture element as the base point to shift up 

and down in the Y direction. 
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Option 

Stretch: Marque estirar y los gráficos se escalarán automáticamente de 

acuerdo con el tamaño de la ventana. 

Transparent: Marque transparente para que los gráficos seleccionados 

aparezcan transparentes. 

Transparent Color: Seleccione el color que debe ser transparente. 

3.2.5 Memo 

Para obtener detalles sobre la configuración de atributos, consulte el capítulo 

3.2.1 Bisel estático/Texto. 

3.3 Button 

Para usar el componente de botón, puede hacer clic en [Botón] debajo de la 

barra de menú [Componente], y aparece la opción desplegable del 

componente de botón, como se muestra en la siguiente figura 3.3-1, o puede 

hacer clic directamente en la opción en la barra de atajos de herramientas, 

como se muestra en la siguiente figura 3.3-2.

 

3.3-1 

 

3.3-2 
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3.3.1 ON/ OFF Button and Switch/ Hold Button 

Después de seleccionar el componente, haga clic con el botón derecho en el 

componente para seleccionar las propiedades del componente o haga doble 

clic en el componente para abrir el cuadro de diálogo de propiedades del 

componente. El cuadro de diálogo de propiedades del botón ON/OFF y los 

componentes del botón Switch/Hold se muestran a continuación.
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1. Button 

Como las propiedades de la página [Botón] son las mismas que las 

configuraciones de [Bisel] en la Sección 3.2.1, no hay necesidad de repetir 

aquí. Consulte la configuración de [Bisel] en la Sección 3.2.1. 

2. Control 

 

Action: Hay cuatro acciones para elegir, y puede elegir el estado de la 

acción del botón. 

Read Address: Lea el valor de la posición del relé de entrada o variable 

del sistema. 

: Representa la posición de lectura, y el tipo es bit. 

Write Address: Escriba el valor en esta ubicación del relé de entrada o 

variable del sistema. 

: Representa la posición de escritura y el tipo es bit. 

Notification: Si se escribe un valor en la posición del relé de entrada o 

variable del sistema, se notificará la posición. 

On Macro: Haga clic en la flecha desplegable para seleccionar el comando 

de macro editado con anterioridad y ejecute el comando de macro seleccionado 

cuando el botón esté activado. 

Off Macro: Haga clic en la flecha desplegable para seleccionar el comando 

de macro editado con anterioridad y ejecute el comando de macro seleccionado 

cuando el botón esté APAGADO. 

Opción Security: Dado que tiene la autoridad para configurar la pantalla al 

crear una nueva pantalla, consulte la Sección 2.4.1 Pantalla. Si la autoridad 

establecida aquí es más alta que la autoridad de la pantalla, se requerirá la 

cuenta y la contraseña para ingresar cuando el componente del botón se 

ejecute en la emulación o en la interfaz hombre-máquina. 

Confirmar: Liberar. acción: Ejecute la acción cuando se suelte el 

componente del botón. 
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Wait Sec: Configure el tiempo de espera para evitar presionar 

accidentalmente. Cuando presione el botón, esperará el tiempo establecido 

aquí antes de ejecutar la acción del componente. 

Press. action: Ejecute la acción cuando se presione el elemento del 

botón. 

Key Def: Después de configurar la definición del teclado en la Sección 2-

4.5, puede seleccionar la función que necesita. 

Key Window: Esta función solo está disponible cuando las propiedades 

de la pantalla tienen propiedades de cuadro de diálogo. 

Presione el botón, aparecerá la ventana del cuadro de diálogo 

seleccionado. Si esta función está activada, aparecerá una 

ventana de cuadro de diálogo para determinar si ejecutar una 

determinada función. 

Sound: Establece el sonido cuando se hace clic en el botón. 

Enabled Flag: Establezca la variable de condición. Si establece la variable 

en 1, el botón puede realizar la acción correspondiente; de lo contrario, el 

botón no actúa. 

Hide Object: Marque esta opción para ocultar el componente. 

Hide Object when disabled or security: Marque esta opción, el 

componente se ocultará cuando no se alcance la autoridad o 

no se cumplan las condiciones controladas. 

Prompt if Priority Lack: Marque esta opción, el componente se ocultará 

cuando no se alcance la autoridad o no se cumplan las 

condiciones controladas. 

Establecer última prioridad después de jugar: después de la acción, 

establezca la última prioridad. Marque esta opción, haga clic en el botón, 

después de completar la acción, modifique la [Opción]-> [Seguridad] – “Usar 

nivel 9 (bajo)”.3. Status 
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Language: Seleccione el idioma actual. Para obtener más información, 

consulte la Sección Capítulo 5 Gestión del idioma. 

Preview: Puede ver la vista previa del texto de entrada aquí para evitar 

errores de entrada. 

Status 

Add: Dado que solo hay 0 o 1 estado, no hay ninguna función nueva aquí. 

Delete: Dado que solo hay 0 o 1 estado, no hay ninguna función nueva 

aquí. 

Brush: Para configuraciones específicas, consulte 3.1.1. 

Image: Para configuraciones específicas, consulte 3.2.4. 

Text: Para configuraciones específicas, consulte 3.2.1. 

Copy: Dado que solo hay 0 o 1 estado, no hay ninguna función nueva 

aquí. 

Index | Text: El índice 0 es el texto que se muestra cuando se presiona el 

botón, y el índice 1 es el texto que se muestra cuando no se presiona el 

botón. Texto: Introduzca el texto que se mostrará aquí. 

: Haga clic en este botón para copiar el texto actual a todos los 

estados. 

3.3.2 Set Value/ Const Button and Inc/ Dec Button 

Después de seleccionar el componente, haga clic con el botón derecho en el 

componente para seleccionar las propiedades del componente o haga doble 

clic en el componente para abrir el cuadro de diálogo de propiedades del 

componente. 

1. Button 

Como se muestra en la figura a continuación, las propiedades de la página 

[Botón] son las mismas que las configuraciones [Bisel] en la Sección 3.2.1, 
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consulte las configuraciones [Bisel] en la Sección 3.2.1.

 

2. Control 

 
Control 

Action: 

Input: Usado junto con la ventana del teclado, ingresa datos desde la 

pantalla a la posición variable del contacto. 
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Var/Const: Seleccione esta opción, el valor que se ingresará en la 

variable de contacto se puede ingresar mediante la regla de 

escritura. 

Inc/Dec: Seleccione esta opción y haga clic en el botón una vez para 

agregar o restar el conjunto de datos en la regla una vez a la 

variable de contacto. 

Format: Seleccione el formato de datos a escribir. 

Write Address: Introduzca la posición de la variable de contacto a escribir. 

Rule: Establece el método de cálculo de los datos o variables escritos. 

Cuando la selección de acción es variable/constante, ingrese 

directamente el valor a la variable de contacto. 

Cuando la selección de acción es Inc/Dec, si el valor aumenta, se debe 

agregar el símbolo [+] delante del valor, y si el valor disminuye, se debe agregar 

el símbolo [-] antes del valor. 

: Este icono es el identificador de la variable del elemento aritmético, 

indicando que aquí se soporta el cálculo entre variables. Por ejemplo: N100 + 

N200 se completan aquí, al escribir datos, el sistema calculará el resultado de 

N100 + N200 y lo escribirá. Para obtener más detalles, consulte el Apéndice 4 

Instrucciones para el uso de variables de operación. 

Max: El valor máximo del rango de lectura de la posición de entrada. 

Min: El valor mínimo del rango de lectura de la posición de entrada. 

El valor máximo y mínimo no se puede ingresar. Cuando no se ingresa, 

el rango de valores se refiere al tipo de datos establecido. 

Notification: El relé de entrada o la posición de la variable del sistema serán 

notificados cuando se escriba un valor en la posición. 

Before Macro: Ingrese el nombre de la macro editada directamente o 

haga clic en la flecha desplegable para seleccionar una 

macro existente. La macro se activa cuando se presiona 

el botón. 

After Macro: Ingrese el nombre de la macro editada directamente o haga 

clic en la flecha desplegable para seleccionar una macro 

existente. El botón se activará cuando aparezca la macro. 

Option 

Consulte las instrucciones de la opción en 3.3.1. 

Format 

Decimal Pos.: Establezca el número de lugares decimales. 

Dec: Marque esta opción para mostrar como un valor decimal. 

Hex: Marque esta opción para mostrarlo como un valor hexadecimal. 

32bit Float: Marque esta opción para mostrar valores de coma flotante de 

32 bits. 

3. Status 
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Para obtener más información, consulte las instrucciones de estado en 

3.3.1.3.3.3 Jump/ Back Button 

Después de seleccionar el componente, haga clic con el botón derecho en él 

para seleccionar las propiedades del componente o haga doble clic para abrir 

el cuadro de diálogo de propiedades del componente. 

1. Push Button 

Consulte la configuración de [Bisel] en la Sección 

3.2.1.2. Control 

 

Control 

Scene Switch: Cuando hay varias pantallas en el proyecto, esta función se 

puede usar para cambiar de pantalla y podemos elegir a qué pantalla saltar o 

regresar. 

Switch Notes: Configure la acción de notificación cuando se cambia la 

pantalla, es decir, 

puede configurar un determinado registro para que se active o desactive 

cuando se cambia la pantalla. 

Before Macro: Ingrese el nombre de la macro editada directamente o 

haga clic en la flecha desplegable para seleccionar una macro existente. 

La macro se activa cuando se presiona el botón. 
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After Macro: Ingrese el nombre de la macro editada directamente o haga 

clic en la flecha desplegable para seleccionar una macro existente. El botón se 

activará cuando aparezca la macro. 

Option: Consulte las instrucciones de la opción en 3.3.1. 

3. Status 

Para obtener más información, consulte las instrucciones de estado en 3.3.1. 

3.3.4 Fun Button 

Los detalles de la configuración de propiedades del botón de función, consulte 

el capítulo 

3.3.1. Esta sección solo explica los diferentes ajustes. 

Action: 

Set to last priority: Selecciónelo para establecer la autoridad de atributo 

de pantalla al mínimo. 

Inputs password again: Selecciónelo para ingresar la 

contraseña nuevamente. 

Clear all alarm event: Selecciónelo para eliminar todos los 

eventos de alarma. 
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3.3.5 Key Button 

Para obtener instrucciones detalladas sobre el botón y el estado, consulte el 

capítulo 

3.3.1. Esta sección solo explica los diferentes ajustes.

 

Normal: La acción a realizar cuando se presiona el botón. 

: Haga clic en este icono para copiar la función configurada por el 

botón actual a los otros tres botones. 

Shift: La acción que se realizará cuando presione la tecla [Shift] y luego 

presione el botón. 

Ctrl: La acción que se realizará cuando presione la tecla [Ctrl] y luego 

presione el botón. 

Alt: La acción a realizar cuando se presiona la tecla [Alt] y luego el botón. 

Notification: Haga clic en el botón y escriba 1 en la posición establecida. 

Before Macro: Ingrese el nombre de la macro editada directamente o haga 

clic en la flecha desplegable para seleccionar una macro existente. La macro 

se activa cuando se presiona el botón. 

After Macro: ingrese directamente el nombre de la macro editada o haga 

clic en la flecha desplegable para seleccionar una macro existente. La macro 

se activa después de que aparece el botón 

Key Def.: Se puede utilizar cuando el modelo hombre-máquina admite 

teclas de teclado. 

Las teclas Shift, Ctrl y Alt aquí se refieren a las que se configuran con los 

botones de las teclas, no a las del teclado de la computadora. Como se 
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muestra en la siguiente figura, la tecla Shift se usa como ejemplo, y este botón 

se usará como funciones de cambio.

 

In the status, all the texts are typed into shift since this button is only used 

as a shift function and has no other functions. If it contains other functions, 

please set according to the function name. 

Como se muestra en la figura a continuación, el valor del índice es 0 ~ 3, lo 

que significa que la tecla normal es 0, Shift es 1, Ctrl es 2 y el estado Alt es 3, 

por lo que si queremos que un botón de tecla tenga muchas funciones , 

podemos configurar las funciones de acuerdo con él.
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La configuración de la tecla shift se completa como se muestra arriba. Cuando 

se presiona el botón en la pantalla, significa que se presiona la tecla Mayús, de 

modo que el estado Shift, Ctrl, Alt mencionado anteriormente se puede usar en 

consecuencia. 

3.3.6 Set Status Button 

Para obtener instrucciones detalladas sobre el botón y el estado, consulte el 

capítulo 

3.3.1. Esta sección solo explica los diferentes ajustes.

 

Control 

Format: Establece el formato de la variable de registro. 

Write Address: Configure la ubicación para escribir datos. 

Value Address: Configure el contenido que se escribió. Por ejemplo, 

configúrelo como D0 y la posición de escritura como D1. Cuando ocurra 

la acción, escriba el contenido de D0 a D1. 

Notification: Al escribir, configure las variables establecidas por la 

notificación. 

Press Macro: Ingrese el nombre de la macro editada directamente o haga 

clic en la flecha desplegable para seleccionar una macro existente. La macro 

se activa cuando se presiona el botón. 

Release Macro: Ingrese el nombre de la macro editada directamente o 

haga clic en la flecha desplegable para seleccionar una macro existente. La 

macro se activa después de soltar el botón. 
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3.3.7 Target Button 

Para obtener instrucciones detalladas sobre el botón y el estado, consulte el 

capítulo 

3.3.1. Esta sección solo explica los diferentes ajustes.

 

Project making: cuando hay que configurar una serie de parámetros, para 

facilitar la configuración y evitar que el funcionamiento incorrecto golpee otras 

configuraciones, puede usar el botón de disparo. 

Read Address: Seleccione una variable como base para cambiar el 

número de columnas. 

Base Address: Configure según el número de serie de la primera columna 

de componentes, haga clic en [F4] para ver el número de serie del 

componente. Por ejemplo, si el número de serie del primer elemento del 

elemento del parámetro debe configurarse como 8 en esta línea, la posición 

cardinal se selecciona como 8. 

Scale Address: Se establece según el número de filas del grupo donde se 

encuentra el componente. Por ejemplo, si la fila es la tercera fila, configúrela 

en 3. 
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3.3.8 Data Move Button 

Para obtener instrucciones detalladas sobre el botón y el estado, consulte el 

capítulo 

3.3.1. Esta sección solo explica los diferentes ajustes.

 

Read Address: Establezca la posición de inicio de la variable que necesita 

leer datos. 

Write Address: Establecer la posición de inicio de la variable que necesita 

escribir datos. 

Data Length: Establezca el número de datos que se leerán y escribirán. 

For example: Como se muestra en la figura anterior, cuando hace clic en 

el botón, los valores de 10 datos en D0-D9 se leerán y luego se escribirán en 

10 registros en D10-D19 respectivamente. 

3.4 Display 

Para usar el componente Estado, puede hacer clic en [Estado] debajo de la 

barra de menú [Componente], y aparece la opción desplegable del 

componente de estado, como se muestra en la siguiente figura 3.4-1, o puede 
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hacer clic directamente en esta opción en la barra de atajos de herramientas, 

como se muestra en la siguiente figura 3.4-2.  

3.4-1 

 

3.4-2 
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3.4.1 Lamp 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Control y Estado. 

1. Control 

 

Data Type: Configure el tipo de variable o el formato de datos variables 

que muestra la lámpara. 

Read Addr.: Configure la posición variable que muestra la lámpara. 

Max: Cuando lee un registro, el valor máximo es el que usted establece. Si 

no establece el valor aquí, el valor se decide por formato de datos. 

Min: Cuando lee un registro, el valor mínimo es el que usted establece. Si 

no establece el valor aquí, el valor se decide por formato de datos. 

Visibility: Establezca la posición variable que hace que esta lámpara se 

muestre u oculte. 
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2. Status 

 

Para obtener más información, consulte la descripción de la página de 

estado en 3.3.1, aquí solo se presentan las diferencias. 

Add: Haga clic en este botón para agregar una nueva condición. 

Delete: Haga clic en este botón para eliminar la condición seleccionada. 

Condition: Establecer la condición de comparación de la condición 

seleccionada. Hay seis tipos de condiciones de comparación: 

igual, no igual, menor que, menor o igual, mayor que y mayor o 

igual para elegir. 

Connection / Para .: Introduzca el registro de 16 bits para compararlo 

con el registro que muestra la lámpara. Según los resultados 

de la comparación, la lámpara muestra un estado diferente. 
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3.4.2 Numeric Display 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Control y Texto. 

1. Control 

 

Data 

Data Format: Seleccione el formato de datos a leer. 

Read Addr.: Configure la dirección de la variable a leer. 

Max: Establece el valor máximo de la variable a leer. 

Min: Establece el valor mínimo de la variable a leer. 

Visibility: Establezca la variable que hace que el componente se muestre 

u oculte. 

Display Format 

Integer: Establece cuántos dígitos mostrar para los números enteros. 

Decimal Pos .: Establezca cuántos dígitos mostrar para los decimales. 

Zero of Hi Bites: Cuando el número entero se establece en 4, el valor se 

completará con 0 a 4 dígitos si esta opción está marcada. 

Decimal: Seleccione esta opción, el valor se muestra en formato decimal. 

Hex .: Seleccione esta opción para convertir el valor mostrado a 

visualización hexadecimal. 

32 Bits Float. Point: Seleccione esta opción para mostrar como un número 

de coma flotante de 32 bits. 

2. Text 



Manual de programación de HMI de la serie TK 

 125 
https://coolmay.com.ar 

 

Text 

Language: Seleccione el tipo de idioma que se muestra. 

Color: Seleccione el color del valor mostrado. 

Align: Seleccione la alineación de la pantalla numérica al mostrar. 

Flash Effect: Seleccione si el valor es normal o parpadea durante la 

visualización. 

Font: Establezca el tipo de fuente y el tamaño del valor cuando se 

muestre, consulte 3.2.1 para obtener más detalles. 
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3.4.3 Text Display 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Control y Texto. 

1. Control 

 

Control 

Data Format: Seleccione el formato de visualización del texto. 

String Length: Establezca la longitud de los caracteres que se 

pueden mostrar. 

Read Addr .: Establezca la dirección de la variable de lectura. 

Visibility: Establezca la variable que controla la visualización u ocultación 

del elemento de visualización de texto. 
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2. Text 

 

Text 

Language: Seleccione el tipo de idioma que se muestra. 

Color: Seleccione el color del valor mostrado. 

Align: Seleccione la alineación de la pantalla numérica. 

Auto. Linefeed: Marque esta opción, cuando la longitud total de la fuente sea 

mayor que la longitud del componente, se mostrará automáticamente la 

línea. De lo contrario, no hay saltos de línea. 

Word Effect: Seleccione si la pantalla de texto es normal o móvil. 

Flash Effect: Seleccione si el valor es una pantalla normal o parpadeante. 

Font: Establezca el tipo de fuente y el tamaño del valor cuando se 

muestre, consulte 3.2.1 para obtener más detalles. 

Text: Introduzca el texto que se mostrará. 
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3.4.4 Alarm String 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Texto y Opción. 

1. Text 

 

Text 

Language: Seleccione el tipo de idioma que se muestra. 

Color: Seleccione el color del valor mostrado. 

Align: Seleccione la alineación de la pantalla numérica. 

Word Effect: Seleccione si la pantalla de texto es normal o móvil. 

Flash Effect: Seleccione si el valor es una pantalla normal o parpadeante. 

Font: Establezca el tipo de fuente y el tamaño del valor cuando se 

muestre, consulte 3.2.1 para obtener más detalles. 

Visibility: Configure la variable que controla la visualización u ocultación de 

este componente de texto de alarma. 

Continue: Marque esta opción, el texto de la alarma se mostrará 

continuamente; de lo contrario, la información de la alarma volverá a aparecer 

después de que la información de la alarma se mueva y desaparezca en el 

componente de texto de la alarma. 

Move Speed: Configure la velocidad del movimiento del texto de alarma. 
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2. Option 

 

Option 

Index Number: Marque esta opción, el texto de la alarma aparecerá 

con el número de alarma, de lo contrario, solo se mostrará el texto de la 

alarma. 

Group Option 

Read Address: Configure la dirección de la zona de alarma de 

lectura. 

Date / Time 

Language: Seleccione el tipo de idioma que se muestra. 

Custom: Configure el texto de la alarma. 

Preview: Obtenga una vista previa de la visualización del texto de la 

alarma para modificarlo fácilmente a tiempo. 

Brush 

Type: Establece el estilo del pincel. 

3.4.5 Time/Date 

The detailed instructions of Bevel and Text, please refer to chapter 3.3.1. 

This section only explains the different settings of Control. 
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1. Control 

 

Control Display 

Format: 

Custom: Cuando se selecciona esta opción, ingrese el formato 

que se mostrará en el formato personalizado en 

la página de texto. 

Para el formato de hora, consulte la siguiente tabla. 

hh: mm: ss: El tiempo se mostrará como hora: minuto: segundo. 

hh:mm: El tiempo se mostrará como hora: minuto. 

MM / dd / yy: La hora se mostrará como mes/día/año. 

dd / MM / yy: La hora se mostrará como día/mes/año. 

Dd.MM.yy: La hora se mostrará como día, mes, año. 

Format Descriptions Input string Display string 

“” string “Year” Year 

yyyy año de 4 dígitos yyyy 2004 

yy año de 2 dígitos yy 04 

M mes de 1 dígito M 7 

MM mes de 2 dígitos MM 07 

d fecha de 1 dígito d 5 

dd fecha de 2 dígitos dd 05 

H Hora de 1 dígito 

(sistema de 12 

horas) 

H 9 
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HH Hora de 2 dígitos 

(sistema de 12 

horas) 

HH 09 

h Hora de 1 dígito 

(sistema de 24 

horas) 

h 9 

hh Hora de 2 dígitos 

(sistema de 24 

horas) 

hh 09 

m minuto de 1 dígito m 7 

mm minuto de 2 dígitos mm 07 

s segundo de 1 dígito s 7 

ss segundo de 2 

dígitos 

ss 07 

AM AM/PM AM AM/PMA 

Visibility: Set the variables that control the display or hide of the display 

element. 

3.4.6 Progress Bar 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Control. 

1. Control 

 

Control 

Data Type: Seleccione el formato de datos a leer. 

Read Addr .: Configure la dirección de la variable a leer. 
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Max: Ingrese el valor máximo de este contacto o memoria, o no podrá 

ingresarlo. 

Min: Ingrese el valor mínimo de este contacto o memoria, o no podrá 

ingresarlo. De lo contrario, el rango de valores máximo y mínimo es el 

rango de valores predeterminado de la variable. 

Visibility: Establezca las variables que controlan la visualización u 

ocultación del elemento de visualización. 

Option 

Direction: Ajusta la dirección de la barra de progreso. El valor 

predeterminado es la dirección horizontal. Si selecciona vertical, los 

gráficos en la pantalla también deben ajustarse para que sean 

verticales. 

Grid Color: Establece el color de la cuadrícula de la barra de progreso. 

3.4.7 Bar/ Float Bar 

Las instrucciones detalladas de Bevel, consulte el capítulo 3.3.1. Esta sección 

solo explica las diferentes configuraciones de Control. 

1. Control 

 

Control 

Data Type: Seleccione el formato de datos a leer. 

Read Addr .: Configure la dirección de la variable a leer. 

Max: Ingrese el valor máximo de este contacto o memoria, o no podrá 

ingresarlo. 

Min: Ingrese el valor mínimo de este contacto o memoria, o no podrá 

ingresarlo. De lo contrario, el rango de valores máximo y mínimo es el 

rango de valores predeterminado de la variable. 
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Visibility: Establezca las variables que controlan la visualización u 

ocultación del elemento de visualización. 

Option 

Type: Seleccione para usar la barra o la barra flotante. 

Direction: Seleccione la dirección de la barra o la barra flotante. 

Bar: 

Type: Selecciona el tipo de Barra o Barra Flotante. 

3.4.8 Meter 

Las instrucciones detalladas de Bisel y Control, consulte el capítulo 3.3.1 

y 3.2.4 respectivamente. Esta sección solo explica los ajustes de Scale.1. 

Scale 

 

Scale 

Graduation: Seleccione la dirección y el ángulo de la pantalla del medidor. 

Master Count: Seleccione el número de escalas principales. 

Slave Count: Seleccione el número de escalas menores. 

Length: Seleccione la longitud de la pantalla de escala. 

Disc size: Seleccione el tamaño del disco en el centro del medidor. 

Scale: Márquelo y aparecerá la escala, de lo contrario no. 

Axis: Márquelo y el eje de coordenadas en forma de arco aparecerá 

debajo de la escala. De otra forma no. 

Pen 
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Type: Seleccione el estilo de línea de la escala y el eje de 

coordenadas. 

Color: Seleccione el color del estilo de línea. 

Indicator Pen 

Type: Seleccione el estilo de línea del puntero del medidor. 

Color: Seleccione el color del estilo de línea. 

Disc color: Seleccione el color del disco. 

Option 

Display Marks: Márquelo y aparecerán las marcas digitales de la escala 

principal. De otra forma no. 

Max: Ingrese el valor máximo de este contacto o memoria, o no podrá 

ingresarlo. 

Min: Ingrese el valor mínimo de este contacto o memoria, o no podrá 

ingresarlo. De lo contrario, el rango de valores máximo y mínimo es el rango 

de valores predeterminado de la variable. 

Color: Seleccione el color de la marca digital. 

Decimal Pos.: Establecer el número de lugares decimales. 

Suffix: Configure la unidad de cantidad mostrada. 

Font: Establezca el tipo de fuente y el tamaño del valor numérico cuando 

se muestre, consulte 3.2.1 para obtener más detalles. 

2. Adv. 
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Fill Pie 

File Pie: Márquelo y aparecerá la configuración de Bush, de lo contrario 

no. 

Graphic Distance: Establezca el tiempo de intervalo entre la visualización 

de gráficos. 

3.4.9 Dynamic Picture 

Las instrucciones detalladas de bisel, imagen/imagen, consulte el capítulo 

3.3.1 y 3.4.7 respectivamente. Esta sección solo explica la configuración de 

Control. 

1. Control 

 

Coordinate 

Type: De acuerdo con la forma representada por las coordenadas X e Y, 

se puede seleccionar el valor absoluto y el valor de compensación. 

X/Y 

Data Format: Configure el formato de datos variables. 

Read Addr .: Configure la dirección de la variable de lectura para cambiar 

la posición de la imagen de acuerdo con el valor de la dirección. 

Max: Establezca el valor máximo de las coordenadas 

X / Y. 
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Min: Establezca el valor mínimo de las coordenadas 

X / Y. 

3.4.10 Path Picture 

Haga clic en [Componente]-> [Estado]-> [Imagen de ruta]. Cuando el mouse se 

mueva a la pantalla de edición, aparecerá un cursor en forma de cruz. Cuando 

se mueva a la posición deseada, presione el botón izquierdo del mouse, como 

se muestra en la siguiente figura, luego muévase a la posición relevante de la 

ruta deseada en secuencia, luego presione el botón izquierdo del mouse y 

finalmente confirme la posición de la ruta, presione el botón derecho botón del 

ratón para finalizar el dibujo.

 

Haga clic derecho o doble clic para ingresar a la página de configuración 

de propiedades. Las instrucciones detalladas de Bisel, Imagen/Imagen, 

consulte el capítulo 3.3.1 y 3.4.7 respectivamente. Esta sección solo explica 

la configuración de Control.1. Control 
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Control 

Type: Hay cuatro opciones que incluyen dirección de lectura, ciclo 

creciente, ciclo decreciente y ciclo trapecio. 

Read Address: La imagen se mueve al punto de coordenadas 

correspondiente según el valor de la variable en la posición de 

lectura. 

Inc cycle: Según el valor de la variable en la posición de lectura X 

milisegundos, la coordenada automática aumenta con el 

movimiento cíclico. 

Del cycle: Según el valor de la variable en la posición de lectura X 

milisegundos, la cota automática decrece con el movimiento 

cíclico. 

Trapeze cycle: La imagen se mueve automáticamente en un ciclo de 

coordenadas según el valor de la variable X milisegundos en 

la posición de lectura. Cuando el cuadro está en la 

coordenada inicial, es un ciclo creciente, y en la coordenada 

final es un ciclo decreciente, lo que equivale a ir y venir. 

Control Para. 

Format: Configurar el formato de datos variables. 

Read Address: Configure la dirección de la variable de lectura para 

cambiar la posición de la imagen de acuerdo con el valor de la posición. 

Path Information 

Point Count：Muestra cuántas posiciones de las coordenadas de ruta 

establecidas. 
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3.4.11 Dynamic Lamp 

El objetivo principal es utilizar el control variable, de modo que los 

componentes muestren diferentes pantallas o diferentes textos en diferentes 

posiciones. 

Haga clic derecho o doble clic para ingresar a la página de configuración de 

propiedades. El cuadro de diálogo de configuración de propiedades de 

visualización de coordenadas dinámicas se muestra en la siguiente figura.

 

1. Bevel: Consulte el capítulo 3.3.1 para obtener instrucciones 

detalladas. 

2. Control: Consulte el capítulo 3.3.2 para obtener instrucciones 

detalladas. 

3. Status: Consulte el capítulo 3.3.1 para obtener instrucciones 

detalladas. Aquí solo se explican las diferencias. 
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Add: Haga clic en este botón una vez para agregar un nuevo estado. 

Delete: Seleccione un estado y haga clic en este botón una vez para 

eliminar el estado seleccionado. 

Copy: Seleccione un estado determinado y haga clic en este botón una 

vez para copiar el estado seleccionado una vez. El contenido copiado incluye 

condiciones, contenido de texto, pinceles e imágenes. 

4. Coordinator Control: Consulte el capítulo 3.4.9 para obtener instrucciones 

detalladas. 

3.4.12 Path Lamp 

El componente combina una imagen de ruta dinámica y una lámpara 

dinámica. El propósito principal de usar la ruta dinámica es mostrar diferentes 

imágenes o pantallas cuando se usan variables para controlar diferentes 

estados. Al mismo tiempo, los componentes se pueden mostrar en diferentes 

posiciones. 

Click [Component]-> [Display]-> [Path Lamp]. Cuando el mouse se mueva 

a la pantalla de edición, aparecerá un cursor en forma de cruz. Cuando se 

mueva a la posición deseada, presione el botón izquierdo del mouse, luego 

muévase a la posición relevante de la ruta deseada en secuencia, luego 

presione el botón izquierdo del mouse y finalmente confirme la posición de la 

ruta, presione el botón derecho del mouse para finalizar el dibujo. 

Haga clic derecho o doble clic para ingresar a la página de configuración 

de propiedades. El cuadro de diálogo de configuración de propiedades de la 
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lámpara de ruta se muestra en la siguiente figura.

 
1. Bevel: Consulte el capítulo 3.3.1 para obtener instrucciones detalladas. 

2. Control: Consulte el capítulo 3.3.2 para obtener instrucciones detalladas. 

3. Status: Consulte los capítulos 3.3.1 y 3.4.11 para obtener instrucciones 

detalladas. 

4. Coordinator Control: Consulte el capítulo 3.4.9 para obtener instrucciones 

detalladas. 

3.4.13 Trend Graph 

La interfaz hombre-máquina lee los datos continuos de la dirección 

correspondiente y los presenta al usuario de forma intuitiva y gráfica en tiempo 

real. Por ejemplo: si los puntos de visualización son 50 puntos y se establecen 

tres curvas, se tomarán un total de 50 * 3 datos de 150 PALABRAS y será 

necesario realizar el procesamiento de datos en el programa de PLC.Click 

[Component]-> [Display]-> [Trend Graph] para mostrar el gráfico de tendencia 

en la pantalla de edición. Haga clic derecho o doble clic para ingresar a la 

página de configuración de propiedades. 

1. Bevel: Consulte el capítulo 3.3.1 para obtener instrucciones detalladas. 

2. Control: 
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Control 

Data Type: Establecer la posición inicial de la dirección de la variable de 

registro para la lectura de datos. 

Source Address: Establezca la longitud de los datos de lectura, es decir, el 

número de curvas mostradas. Por ejemplo, la dirección de 

origen es D10 y la longitud de los datos es 10, es decir, se 

leen los datos de D10 a D19 y se muestran 10 curvas en el 

gráfico de tendencia. 

Record Count: Establezca tiempos totales para registrar datos, es decir, 

los tiempos máximos de registro que se registrarán para cada 

curva. 

Update Time: Establezca el intervalo de tiempo para cada registro de datos. 

Por ejemplo, como se establece en la figura anterior, los datos 

D10 ~ D19 se registran una vez por segundo y se registra un 

total de 10 (número de registros). 

Record Flag: Establezca la condición para comenzar a registrar datos, es 

decir, la variable 

comienza a registrar datos cuando es 1 y no registra cuando es 0. 

Clear Flag: Establezca las condiciones para borrar los datos registrados, 

es decir, cuando la variable es 1, todos los datos se borran y 0 no se 

borra.. 

Clear Flag aft. Clear Rec.: Marque esta opción para borrar la bandera 

juntos al borrar los datos grabados. 
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Stop Count: Establezca el número cuando deje de grabar 

automáticamente, y establecer en 0 significa que no se 

utilizará esta función (el valor aquí debe ser menor o igual que 

el número de registros). 

Visibility: Establezca la variable que hace que el componente se muestre u 

oculte. 

Record Date/Time: Marque esta opción, el sistema registra la hora de 

registro de datos. 

 3. Curve Set 

 

Curve 

Add: Haga clic en este botón para agregar una curva. 

Delete: Haga clic en este botón para eliminar la curva seleccionada. 

Copy: Haga clic en este botón para copiar la curva seleccionada. 

Point: Marque esta opción, la curva se muestra en forma de puntos. 

Point Style: Establecer la forma del punto. 

Point Color: Establecer el color del punto. 

Line: Marque esta opción, la curva se muestra en forma de línea. 

Pen Style: Establecer el estilo de pincel. 

Pen Color: Establece el color de la pluma. 

Fill: Marque esta opción, la curva se muestra en forma de pincel. 

Brush Style: Establecer el estilo y el color del pincel. 
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Max: Establecer el valor máximo de una sola curva. 

Min: Establecer el valor mínimo de una sola curva. 

Visibility: Configure una pantalla de curva única y variables ocultas, cuando 

la variable es 1, se muestra la curva y 0 no se muestra. 4. Display 

 
Preview: Shows the style of curve display. 

Show Setting 

Type: Establecer la dirección del movimiento cuando se muestra la curva. 

Show Data Num .: Establezca el número de puntos para mostrar datos, es 

decir, el gráfico de tendencia comienza a moverse cuando se 

trata de la cantidad del conjunto de datos. 

Page Down Gap: Establecer el intervalo entre dos páginas al pasar las 

páginas. 

Show Break: Marque esta opción, cada curva se muestra con su propia 

área única. 

Grid of Num./Time 

Show Grid Num .: Establecer el número de cuadrículas que se mostrarán. 

Point / Grid: Establezca el número de cuadrículas requeridas para la 

visualización de la hora. 

Pen Style: Establecer el estilo de pincel. 

Pen Color: Establecer el color de la pluma. 



Manual de programación de HMI de la serie TK 

 144 
https://coolmay.com.ar 

5. Scale 

 

Left/ Top Scale 

Left / Top Scale: Marque esta opción, el valor de la escala se mostrará en 

el lado izquierdo del gráfico de tendencias y no se mostrará cuando no esté 

marcado. 

Max: Establecer el valor máximo que se muestra en la escala. 

Min: Establezca el valor mínimo de la visualización de la escala. 

Color: Establezca el color de la pantalla de escala a la izquierda. 

Decimal Pos.: Establezca si mostrar decimales. 0 significa sin decimales. 

Suffix: Establezca el símbolo de la unidad indicado por la escala. Si no se 

completa, el símbolo de la unidad no se mostrará. 

Font: Configure la fuente para la visualización de la escala. Para 

configuraciones detalladas, consulte la configuración de fuente en 3.2.1. 

Right/ Bottom Scale 

Consulte la introducción de parámetros en la left/top escala. 
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6. Display Time 

 

Display time 

Display Time: Marque esta opción para mostrar la hora de los datos 

registrados debajo del gráfico de tendencia. 

Display format: Establecer el formato de visualización de la hora. 

Color: Establecer el color de la visualización de la hora. 

Font: Establecer la fuente para la visualización de la hora. 

Start Record Time 

Start Record Time: Marque esta opción, la parte superior izquierda del 

gráfico de tendencia muestra el tiempo para comenzar a registrar datos. 

End Record Time 

End Record Time: Marque esta opción, la hora en la parte superior 

derecha del gráfico de tendencia muestra la hora en que finaliza la grabación 

de datos. 
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7. Time Scroll 

 

Time Scroll 

Time Scroll: Marque esta opción, el desplazamiento de tiempo se 

mostrará debajo del gráfico de tendencia. 

3.4.14 Tendencia histórica 

La interfaz hombre-máquina lee los datos continuos de la dirección 

correspondiente y los presenta al usuario de forma intuitiva y gráfica en tiempo 

real. 

Click [Component]-> [Display]-> [Historical Trend] para mostrar la 

tendencia histórica en la pantalla de edición. Haga clic derecho o doble clic 
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para ingresar a la página de configuración de propiedades.

 
1. Bevel: Consulte el capítulo 3.3.1 para obtener una descripción detallada.. 

2. Control: como se muestra arriba. 

Data 

Data Record: Seleccione el registro de datos requerido en la gestión de 

registros de datos como visualización del gráfico de tendencia histórica. Para 

la configuración de datos detallada, consulte la Sección 2.4.11 

3. Curve Setting/ Display/ Scale/ Display Time/ Time Scroll: Para obtener 

más información, consulte la Sección 3.4.13. 

4. 3.4.15 Record Table 

La interfaz hombre-máquina lee los datos continuos de la dirección 

correspondiente en el controlador programable y también se puede presentar 

al usuario en forma de tabla. 

Click [Component]-> [Display]-> [Record Table] para mostrar la tabla de 

datos de registro en la pantalla de edición. Haga clic derecho o doble clic para 

ingresar a la página de configuración de propiedades. El cuadro de diálogo de 

configuración de propiedades de la tabla de datos de registro se muestra en la 
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siguiente figura.

 
1. Bevel: Para obtener más información, consulte la Sección 3.3.1. 

2. Control: Para obtener más información, consulte la Sección 3.4.13. 

3. Colum Set: Como se muestra abajo. 

Column 

Language: Establecer el idioma a utilizar. 

Color: El color del texto en la tabla. 

Font: Establezca la fuente en la tabla. 

Add: Haga clic en este botón para agregar una columna de información 

de datos para mostrar. 

Delete: Haga clic en este botón para eliminar la información de la columna 

de datos seleccionada que se mostrará. 

Caption Text: Establezca el título de los datos que se mostrarán en la 

columna seleccionada. 

Width: Establezca el ancho requerido para mostrar los datos de la 

columna seleccionada. 

Align: Establezca la alineación de la visualización de datos de la columna 

seleccionada. 

Color: establezca el color cuando se muestren los datos de la columna 

seleccionada. 

Display Format: Establecer la fuente de datos para la visualización de 

datos de la columna seleccionada. 
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Integer: Configure el número de dígitos enteros cuando se muestren los 

datos de la columna seleccionada. 

Decimal Pos.: Establecer el número de lugares decimales cuando se 

muestran los datos de la columna seleccionada. 

Zero of Hi Bites: Marque esta opción para realizar relleno cero 

automáticamente cuando no hay datos en la posición alta. 

Decimal: Seleccione esta opción, los datos se muestran en forma 

decimal. 

Hex .: Seleccione esta opción, los datos se muestran en forma 

hexadecimal.  

4. Adv. Set 

 

Title 

Select Bevel: Configure el estilo de visualización del borde de la barra de 

título. Para más detalles, consulte el Capítulo 3.3.1. 

Out Color: Establecer el color del marco exterior de la barra de título. 

In Color: Establecer el color del marco interior de la barra de título. 

Brush Style: Haga clic en el botón de pincel y seleccione el estilo de 

pincel en el cuadro de diálogo emergente. 
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Select: Cuando se selecciona una fila de datos, la forma de visualización 

de esa fila. 

Brush Style: Establece el estilo de pincel de la fila seleccionada. 

Write Addr: Establezca un número sin signo de 16 bits y muestre el 

número de línea seleccionado en el número sin signo de 16 bits. 

Option 

Ordenar por programas de información más reciente: marque esta opción para 

mostrar los datos más recientes en la parte delantera al mostrar. De lo 

contrario, los datos más recientes se muestran al final. 

3.4.16 Alarm Display/ Alarm Count Display/ Current Alarm Display 

Click [Component]-> [Display]-> [Alarm Display]/ [Alarm Count Display]/ 

[Current Alarm Display] para agregar un componente de alarma a la pantalla de 

edición, como se muestra en la siguiente figura.

 
Haga clic derecho o doble clic para ingresar a la página de configuración 

de propiedades. El cuadro de diálogo para configurar las propiedades de la 

tabla de alarmas se muestra a continuación. 
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1.Bevel: consulte 3.3.1 

2.Column Set: como la imagen de arriba. 

Column 

Language: Seleccione el idioma que se muestra. 

Color: Seleccione el color del texto del título. 

Font: Seleccione la fuente que se mostrará en el texto del título. 

Display Flag: Establece la posición variable donde se muestra u oculta 

el elemento de alarma. 

Caption Text: Establecer el texto que se mostrará para el título 

seleccionado. 

Display width: Establecer el ancho de la barra de título seleccionada. 

Display content: Configure el contenido de la alarma que se mostrará en 

la barra de título seleccionada. 

Hay cinco opciones: hora de alarma, hora de recuperación, mensaje, 

número y tiempo transcurrido. 

Alignment: Establecer cómo se alinean el texto o los datos cuando se 

muestra la columna del título seleccionado. 

Display color: Establecer el color del contenido de visualización 

seleccionado. 

Display Format: Establece el formato de visualización del título 

seleccionado. Dependiendo de la selección de contenido de 

visualización, la selección proporcionada por el formato aquí 

también es diferente. 
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3. Advanced settings: La página se muestra a continuación. 

 

Title 

Para configuraciones detalladas, consulte la configuración de parámetros 

en la barra de título de la página de configuración avanzada en la sección 

3.4.15. 

Option 

“Mostrar marco cuando sel. Elemento”: Cuando se selecciona esta 

opción, si se selecciona la pantalla de alarma, se muestra la pantalla de 

visualización correspondiente que se establece. Si no se selecciona, no se 

muestra. 

“Índice grande->Índice pequeño”: cuando se selecciona esta opción, los 

números de serie de alarma se muestran en orden descendente de valores de 

índice. 

Group option 

Read position: Establezca la posición de lectura, que se puede 

seleccionar como el grupo de alarma que desea leer. 
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Select 

Para configuraciones detalladas, consulte la configuración de parámetros en 

los elementos de selección de la página de configuración avanzada en la 

sección 3.4.15. 

3.4.17 Status Polygon 

Click [Component]-> [Display]-> [Status Polygon]. Cuando el mouse se 

mueve a la pantalla de edición, aparecerá un cursor en forma de cruz. 

Presione el botón izquierdo del mouse cuando se mueva a la posición 

deseada, luego muévase a la posición relevante de la ruta deseada en 

secuencia y luego presione el botón izquierdo del mouse. Después de 

confirmar la posición de la ruta, presione el botón derecho del mouse para 

finalizar el dibujo. Como se muestra abajo.

 
Haga clic derecho o doble clic para ingresar a la página de configuración de 

propiedades. El cuadro de diálogo de configuración de la propiedad Polígono 
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de estado se muestra en la siguiente figura.

 

1. Location: Consulte la sección 3.2.1 

2. Control: Consulte la sección 3.4.2. 

3. Status: La página se muestra a continuación. 

 

3.4.18 Graph 

La HMI lee los datos continuos de la dirección correspondiente en el 

controlador programable. Además de mostrárselo al usuario en forma de 
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gráficos y tablas de tendencias, también puede optar por mostrárselo al usuario 

en forma de gráfico. 

Click [Component]-> [Display]-> [Graph] para mostrar el gráfico en la 

pantalla de edición. Haga clic derecho o doble clic para ingresar a la página de 

configuración de propiedades. El cuadro de diálogo de configuración de 

propiedades del gráfico se muestra en la siguiente figura. 

 

1. Bevel: consulte la sección 3.3.1. 

2. Control: La página es como se muestra arriba. 

Read Addr.: Establece la dirección de la variable a leer. La primera 

variable es el número de puntos, y el valor es menor o igual 

que el valor de configuración del punto de visualización. La 

dirección de lectura comienza desde la segunda variable de la 

posición de lectura. Como se muestra en la figura anterior, D10 

lee el número de puntos, D10 <10 (muestra el valor de 

configuración del número de puntos), lee datos de D11.Data 

Type: Only 16-bit signed numbers are available. 

Curve count: Establezca el número de curvas que se mostrarán. El rango 

de ajuste es 1 ~ 4. 

Number of Points: Establezca el número de puntos que se mostrarán para 

cada curva, es decir, el número de registros que se utilizarán. 

El rango de ajuste es 2 ~ 128. 

Number of H Grids : Establezca el número de líneas de cuadrícula 

horizontales en el gráfico. 
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Estilo de línea de cuadrícula H: establezca la forma de visualización de la 

línea de cuadrícula horizontal en el gráfico. 

H grid line color: Establezca el color de las líneas de cuadrícula horizontales 

en el gráfico. 

Curve display flag: establezca la posición variable para que la curva se 

muestre u oculte. Cuando se alcanza la condición, se muestra 

la curva. 

Clear flag: Establezca la posición variable de la curva clara. Cuando se 

alcanza la condición, la curva mostrada se borra. 

Visibility: Establezca la posición variable que hace que el componente 

gráfico se muestre u oculte. Cuando se alcanza la condición, se muestra el 

gráfico. Nota: Como se muestra en la figura anterior, si el número de curvas se 

establece en 1, solo se muestra una curva, por lo que el número de puntos 

que se muestran en la curva es un gráfico de líneas compuesto por un total de 

10 puntos D10-D19. 

Como se muestra en la figura anterior, si el número de curvas se 

establece en 2, se deben mostrar dos curvas. En este momento, los 10 puntos 

de la primera curva son D10 / D12 /....../ D28 y los 10 puntos de la segunda 

curva son D11 / D13 /.../ D27. Si el número de curvas se establece en otro, el 

número de puntos que se muestran en la curva puede ser como esta muestra, 

y así sucesivamente.3.Curve : La página es como se muestra en la siguiente 

figura.

 
Add: Haga clic en este botón para agregar un nuevo estado. Cuando se 

encuentra en varios estados, se muestran diferentes estados de acuerdo con 

los datos variables leídos. 
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Para obtener información detallada sobre la configuración de los parámetros, 

consulte la sección 3.4.13. 

Pen Style: Establecer el formulario de lápiz. 

Brush color: Set the color of the brush. 

Brush form: Establece el color del pincel. 

Fill Type: Establezca "qué área de dirección rellenar" al seleccionar el 

área de relleno. 

Delete: Haga clic en este botón para eliminar el estado seleccionado. 

Copy: Haga clic en este botón para copiar el estado seleccionado. 

3.4.19 XY Graph 

La HMI lee los datos continuos de la dirección correspondiente en el 

controlador programable. Además de mostrárselo al usuario en forma de gráfico 

de tendencia y tabla, también puede optar por mostrárselo al usuario en forma 

de curva XY. 

Click [Component]-> [Display]-> [XY Graph] para mostrar el gráfico XY en 

la pantalla de edición. Haga clic derecho o doble clic para ingresar a la página 

de configuración de propiedades. El cuadro de diálogo de configuración de 

propiedades del gráfico se muestra en la siguiente figura. 

 

1. Bevel：consulte la sección 3.3.1. 
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2. Control：como se muestra arriba. 

3. (Consulte 3.4.18 para configuraciones específicas. Aquí solo se 

describen las diferencias). 

4. Number of H Grids：Establezca el número de líneas de cuadrícula 

verticales en el gráfico XY. 

5. Estilo de línea de cuadrícula V: establezca el formato de visualización de la 

línea de cuadrícula vertical en el gráfico XY. Color de línea de cuadrícula V: 

establezca el color de las líneas de cuadrícula verticales en el gráfico XY. 

Por ejemplo 

Establecido como arriba, el número de gráficos es 2 y el número de puntos 

mostrados es 5, es decir, se muestran dos gráficos y cada gráfico consta de 5 

puntos. La posición de lectura es D10 y el formato es X0X1Y0Y1. 

Al mostrar un gráfico, el valor de D10 indica el número de puntos del 

gráfico. Este valor puede configurarse y debe configurarse para que sea 

menor o igual que el número de puntos mostrados. Cuando el valor 

establecido es mayor que el número de puntos mostrados, el sistema 

trata como si el valor establecido fuera igual al número de puntos 

mostrados. 

Arreglo de datos X0X1Y0Y1: 

Lee un total de 20 datos de registro de D11-D30, donde D11-D20 es el 

valor del primer gráfico, y las coordenadas de los 5 puntos son (D11, 

D16) (D12, D17) (D13, D18) (D14, D19) (D15, D20). Entonces D21-D30 

son los valores del segundo gráfico, y las coordenadas de los cinco 

puntos son (D21, D26) (D22, D27) (D23, D28) (D24, D29) (D25, D30). 

Si el arreglo de material secundario se selecciona como X0Y0X1Y1 

Significa leer un total de 20 datos de registro de D11-D30, donde D11-D20 es 

el valor del primer gráfico, y las coordenadas de 5 puntos son (D11, D12) 

(D13, D14) (D15, D16) (D17 , D18) (D19, D20). Entonces D21-D30 son los 

valores del segundo gráfico, y las coordenadas de los cinco puntos son (D21, 

D22) (D23, D24) (D25, D26) (D27, D28) (D29, D30). 

3. Curve: refer to section 3.4.13 

3.5 Edit 

Después de conectar la HMI al controlador programable, el componente de 

edición puede modificar algunos datos en el controlador programable. En este 

momento, el componente de edición se utiliza para completar la operación de 

modificación. 

Click [Component]-> [Edit]-> para encontrar una opción de edición 

diferente como la figura 3.5-1, o haga clic directamente en la opción desde la 
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barra de acceso directo de la herramienta, como la figura 3.5-2

 
3.5-1 

 
3.5-2 

3.5.1 Multiple Status Edit 

Click [Component]-> [Edit]-> [Multiple Status Edit] para mostrar el 

elemento de edición de estado mutil en la pantalla de edición. Haga clic 

derecho o doble clic para ingresar a la página de configuración de 

propiedades. El cuadro de diálogo de configuración de propiedades de edición 
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de estado mutil se muestra en la siguiente figura.

 

1. Bevel：refer to section 3.3.1 

2. Control：como se muestra arriba, consulte la sección 3.3.2. (Diferencia 

abajo) 

3. Posición de lectura: establezca la posición de la variable que se va a 

leer y, a continuación, lea el valor de esa posición. 
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4. Status：como se muestra arriba, consulte la sección 3.3.2. (Diferencia 

abajo)

 
Expresión condicional: establezca el valor de la expresión condicional, es 

decir, puede establecer diferentes valores para que el componente muestre 

diferentes estados. 

3.5.2 Numeric Entry 

Click [Component]-> [Edit]-> [Numeric Entry] para mostrar el elemento de 

edición de valores en la pantalla de edición. Haga clic derecho o doble clic 

para ingresar a la página de configuración de propiedades. El cuadro de 
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diálogo de configuración de propiedades numéricas se muestra en la siguiente 

figura.  

1. Bevel： Como se muestra arriba, consulte la sección 3.3.1. (Diferencia a 

continuación) Botón de selección: haga clic en el botón de selección para 

que aparezca el cuadro de diálogo como se muestra a continuación. 
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Puede elegir la forma del componente de edición. Hay 5 páginas sobre 36 

para elegir. 

2. Control：Página como se muestra a continuación. 

 

Consulte la sección 3.3.2. (Diferencia como abajo) 

Dirección de lectura: establezca la posición de la variable que se va a leer 

y luego lea el valor de esa posición. 

Transferencia de ingeniero 

Offset: Establezca el valor de compensación después de ingresar datos 

numéricos. 

Gain: Establezca el valor de ampliación después de ingresar datos 

numéricos. 

Auxiliary calculation: Cuando el valor de desplazamiento y el valor de 

ampliación no se calculan, haga clic en este botón para abrir el cuadro de 
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diálogo de cálculo auxiliar como se muestra en la figura a continuación.

 
Parameter calculation of Eng. Transfer：Establezca los valores máximo y 

mínimo para leer. 

Eng. Transfer Data：Establezca los valores máximo y mínimo después de 

leer los datos de transferencia de posición. 

Cal. Result: El sistema calcula automáticamente el valor de 

compensación y el valor de ampliación de acuerdo con el valor de la variable 

de entrada y el valor convertido del proyecto. 

Ok: haga clic en este botón para salir de este cuadro de diálogo de 

configuración y mostrar el resultado del cálculo en la posición correspondiente 

en la página anterior. 

Cancel: Haga clic en este botón para salir de este cuadro de diálogo de 

configuración sin realizar ningún cambio. 

For example: 

Cuando la HMI se comunica con el PLC, se debe leer el valor analógico 

en el PLC, pero el valor digital en el PLC es 0 ~ 4000, pero la HMI 

necesita que el operador vea el valor de temperatura de 0 ~ 50 ℃. En 

este caso, puede establecer los valores de compensación y ampliación 

en los datos de conversión de ingeniería. 

Reduciendo así la cantidad de cálculo en el PLC. 

Parámetro calculation of Eng. Transfer establecido en el ejemplo anterior: 
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Después de hacer clic en [Ok], las propiedades del componente de entrada 

numérica se muestran a continuación:

 

Después de la configuración, cuando se lee el valor digital correspondiente en 

el PLC, el valor convertido se muestra en la HMI, como se muestra en la figura 
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a continuación.
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3.5.3 Text Entry 

Click [Component]-> [Edit]-> [Text Entry] para mostrar el elemento de 

edición de valores en la pantalla de edición. Haga clic derecho o doble clic 

para ingresar a la página de configuración de propiedades. El cuadro de 

diálogo de configuración de propiedades de entrada de texto se muestra en la 
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siguiente figura.

 
1. Bevel: consulte el Capítulo 3.3.1 y el Capítulo 3.5.2. 

2. Control: La página es como se muestra arriba, consulte la sección 

3. 3.3.2. (Diferencias como abajo) 

Data Type: Select the format of the text string corresponding to the writing 

position 

0. AB: la primera palabra se escribe en los bits de orden superior de la 

variable y la segunda palabra se escribe en los bits de orden inferior de 

la variable. 

1. BA: La segunda palabra se escribe en los bits de orden superior de la 

variable y la primera palabra se escribe en los bits de orden inferior de 

la variable. 

2. _A: Cada variable solo almacena un texto en la posición baja. 

3. A_: Cada variable solo almacena un texto en la posición alta. 

4 ~ 7, igual que 0 ~ 3, pero no se muestra texto, solo se muestra "*". 

Longitud de cadena: establezca cuántos caracteres mostrar. Puede mostrar de 

1 a 32 caracteres. 

Text: consulte la sección 3.4.2. 

3.5.4 Password Edit 

Click [Component]-> [Edit]-> [Password Edit] para mostrar el elemento de 

edición de contraseña en la pantalla de edición. Haga clic derecho o doble clic 

para ingresar a la página de configuración de propiedades. El cuadro de 

diálogo de configuración de propiedad de edición de contraseña se muestra 
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en la siguiente figura.

 
1. Bevel: consulte el Capítulo 3.3.1 y el Capítulo 3.5.2. 

2. Data: La página es como se muestra arriba. (consulte la sección 3.3.2, 

Diferencia a continuación) 

3. Password index: Establezca la segunda a la octava contraseña. En este 

momento, la ventana del teclado en la sección de opciones de la derecha 

debe configurar la pantalla de entrada como el cuadro de diálogo de entrada 

de contraseña, de lo contrario no se puede ingresar. 

4. Text: consulte la sección 3.4.2. 

Después de configurar los parámetros, haga clic en este componente durante 

la ejecución y aparecerá la pantalla de entrada editada previamente. Una vez 

completada la entrada, se completa la operación de configuración de la 

contraseña. 

3.5.5 Track Bar 

Usando el elemento deslizante, puede usar la perilla de ajuste para 

establecer rápidamente el valor del elemento. 

Click [Component]-> [Edit]-> [Track Bar] para mostrar el componente 

deslizante en la pantalla de edición. Haga clic derecho o doble clic para 

ingresar a la página de configuración de propiedades. 

El cuadro de diálogo de configuración de propiedades del control 

deslizante se muestra a continuación. 
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1. Bevel: consulte la sección 3.3.1. 

2. Control: consulte la Sección 3.3.2. 

3. Display: La página es como se muestra arriba. 

Display form: Configure el modo de visualización de posición de la escala 

de visualización de componentes. 

Scale form: Configure la forma de visualización de la escala. 

Scale color: Establezca el color de visualización de la escala. 

Select Bevel: Establezca la forma de seleccionar la visualización del 

borde interno. 

Adj. Key Sel.: Establecer el modo de visualización del botón de ajuste de 

selección. 

Scale Numbers: Establezca el número de escalas que se mostrarán. El 

rango de ajuste es 1 ~ 100. 

Scale Length: Configure la longitud de la línea de escala, el rango de 

configuración es 3 ~ 12. 

Outer frame color: Configure el color del marco exterior del marco interior 

y el botón de ajuste por separado. 

Inner frame color: Configure el color del marco interior del marco interior y 

el botón de ajuste respectivamente. 

Brush Style: Configure la forma de pincel del borde interior y el botón de 

ajuste por separado. 

3.5.6 Scroll bar 

Establezca rápidamente el valor del componente. Además de usar el 

componente deslizante, también puede usar la barra de desplazamiento. 
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Click [Component]-> [Edit]-> [Scroll Bar] para mostrar el componente de la 

barra de desplazamiento en la pantalla de edición. Haga clic derecho o doble 

clic para ingresar a la página de configuración de propiedades. El cuadro de 

diálogo de configuración de propiedades de la barra de desplazamiento se 

muestra a continuación. 

 

1. Bevel: consulte la sección 3.3.1. 

2. Control: La página es como se muestra arriba. (consulte la sección 

3.3.2, diferencias a continuación) 

3. Para. Edit (Format=16Bit Unsign) 

Normal offset: Establezca el valor de compensación general, es decir, los 

datos que se mueven cada vez que hace clic en las flechas izquierda y 

derecha de la barra de desplazamiento. 

Fast offset: Establezca el valor de movimiento rápido, es decir, los datos 

que se mueven cada vez que se hace clic una vez en la barra de 

desplazamiento. 

Form size: Establezca el ancho del control deslizante. 

Nota: La configuración en la columna de edición de parámetros solo es 

efectiva cuando el formato de datos se establece en un número de 16 bits con 

signo o sin signo. 

4. Display: consulte la sección 3.5.5. 
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3.5.7 List box 

Además de las barras de desplazamiento y los controles deslizantes 

descritos en las secciones anteriores, también puede usar cuadros de lista 

para cambiar rápidamente los datos de los elementos de registro. 

Click [Component]-> [Edit]-> [List Box] para mostrar el componente de 

cuadro de lista en la pantalla de edición. Haga clic derecho o doble clic para 

ingresar a la página de configuración de propiedades. 

El cuadro de diálogo de configuración de propiedades del cuadro de lista se 

muestra en la siguiente figura.

 

1. Bevel: consulte la sección 3.3.1. 

2. Data: consulte la sección 3.3.2. 

3. Status: consulte la sección 3.3.2. 

4. Display: consulte la sección 3.3.5. 

Chapter 4 Project management 

4.1 Screen management 

The [Screen] allows us to quickly understand all the current pictures. Add, 

edit, delete, preview all pictures. For details of this chapter, please refer to 2.4.1 

Scene. After we create a new file, we can see the screen section shown in the 

figure below, which is divided into two parts: screen and preview. 
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Screen management 

Utilice una estructura de árbol para representar la relación entre cada grupo. 

Ejemplo: Solo las escenas que pertenecen a este grupo se mostrarán en el 

grupo de pantalla inicial. 

[TK6070FH]: indica el modelo de HMI configurado al crear un nuevo archivo.  

[Init Screen Group]: El grupo de pantalla de inicio preestablecido del sistema es 

conveniente para que editemos la pantalla y se puede clasificar 

claramente. Cuando la pantalla se edita en un grado considerable, la 

función de grupo se vuelve más importante. También puede crear un 

grupo de acuerdo a sus necesidades. Haga clic con el botón derecho 

en el TK6070FH o en el grupo de pantallas de inicio y seleccione 

[Nuevo grupo de pantallas] en la escena emergente. 
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Establezca el nombre del grupo y los permisos para este grupo. Por ejemplo, 

el sistema de la figura anterior Grupo preestablecido.  

[Start Screen]: Debajo de cada grupo, puede crear una pantalla que pertenezca 

al grupo, lo cual es conveniente para editar y navegar, y puede 

conocer rápidamente la relación actual entre todas las escenas y 

grupos. 

Preview 

Cuando se selecciona una determinada imagen, la vista previa de la 

pantalla mostrará el gráfico de vista previa de la imagen seleccionada, y 

también se puede ajustar el tamaño de la imagen de vista previa. Por lo tanto, 

cuando hay muchas escenas, puede hacer clic directamente en la pantalla en 

la administración de pantalla y puede ver el gráfico de vista previa de la pantalla 

seleccionada en la vista previa de pantalla. 

4.1.1 Dialog box screen 

El propósito del cuadro de diálogo es que cuando presionamos un determinado 

botón de función, como al confirmar o cancelar, para evitar la negligencia 

humana, presionar el botón primero provoca la pérdida de datos importantes, 

por lo que la ventana del cuadro de diálogo está configurada para avisar 

cuando Se presiona el botón para preguntar si está bien para evitar la pérdida 

causada por presionar accidentalmente el botón. 

El cuadro de diálogo realizado en el caso es solo un formulario básico. Por 

supuesto, los usuarios pueden crear cuadros de diálogo de diferentes estilos 

según sus propias ideas o necesidades. Después de leer este capítulo, espero 

que pueda brindarle información útil. 

Add, edit, delete dialog boxes 

Click [Project]-> [Screen]-> [Add Screen], 
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o haga clic derecho [Init Screen Group] en la gestión de Windows, como se 

muestra en la siguiente figura.  

Después de seleccionar [Add Screen], aparecerá una ventana para 

agregar una pantalla como se muestra en la siguiente figura. Seleccione el 

cuadro de diálogo en el [Screen Type]. Para otras configuraciones, consulte la 

sección 2.4.1. Haga clic en el [OK] para agregar una ventana de cuadro de 

diálogo. 
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Al editar o eliminar una pantalla, puede seleccionar la pantalla que desea 

editar o eliminar y luego hacer clic en [Project]-> [Screen], o haga clic con el 

botón derecho en la pantalla seleccionada para seleccionar la pantalla de 

edición o eliminación. Los ajustes para la pantalla de edición son los mismos 

que para agregar una nueva pantalla. 

4.1.2 Caso de cuadro de diálogo 

Después de agregar la ventana del cuadro de diálogo, puede comenzar a 

editar la pantalla del cuadro de diálogo que necesita, como se muestra a 

continuación. Los ejemplos dados aquí son ejemplos de extensión de múltiples 
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idiomas y componentes. Consulte el Capítulo 5 "Administración de idiomas".

 

Step 1. Agregue una nueva pantalla y establezca la propiedad de la pantalla 

como cuadro de diálogo. Como se muestra en la imagen 2 anterior, el 

nombre se establece en [Confirmation dialogue box]. 

Step 2. Coloque dos botones clave en la pantalla y configúrelos para [Confirm] 

y [Cancel]. 

Step 3. Establecer las propiedades de la [Confirm] botón, consulte la sección 

3.3.5. La configuración de la página de datos se muestra en la 

siguiente figura. 
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Normal: La acción a realizar cuando se presiona este botón. 

Shift: La acción que se realizará cuando se presionen la tecla [Shift] y el 

botón. 

Ctrl : La acción a realizar cuando se presionan la tecla [Ctrl] y el botón. 

Alt: La acción que se realizará cuando se presionen la tecla [Alt] y el 

botón. 

En la definición de las teclas de la figura anterior, hay demasiadas 

funciones para elegir. En este caso, tomamos dos ejemplos para explicar. El 

botón Aceptar se utiliza como tecla Aceptar, así que seleccione [Aceptar] en 

las cuatro columnas de los campos. Paso 4. Seleccione la página [Estado] 

para configurar los parámetros de esta página. Debido a que la función 

principal de este botón es usarlo como tecla OK, todo el texto en el valor de 

índice 0 ~ 3 se ingresa Confirmar. Como se muestra abajo.

 
Step 5. Configure el texto en otro idioma. De lo contrario, el texto del idioma no 

se puede mostrar normalmente. Como se muestra abajo. 
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Step 6. Establezca otro botón clave como la tecla de cancelación. Para 

conocer el método, consulte el Paso 3, el Paso 4 y el Paso 5. 

Step 7. Después de configurar las propiedades de los dos botones, se 

completa el cuadro de diálogo de confirmación chino. Como se muestra abajo. 

 

Step 8. Cuando presionamos los dos botones [chino] e [inglés] en la pantalla 

de inicio, debe aparecer la pantalla del cuadro de diálogo para 

confirmar, por lo que se deben crear dos cuadros de diálogo. Aquí 

puede hacer clic con el botón derecho en [Confirmar cuadro de 

diálogo] en la gestión de pantallas y hacer clic en [Copiar pantalla] en 

el menú contextual emergente. Modifique las propiedades de la 

pantalla, como se muestra a continuación. 
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Step 9. Haga clic en el botón [Confirmar] en las propiedades de la pantalla para 

agregar correctamente una nueva pantalla de cuadro de diálogo. Luego de 
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modificar los atributos de los componentes en la nueva pantalla, el proyecto se 

muestra en la siguiente figura. 

 

Step 10. In the initial screen, modify the properties of the [Chinese] button 

component as shown in the figure below. After completing the 

modification, click the [Confirm] button to save the settings. 
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Step 11. En la pantalla inicial, modifique las propiedades del componente del 

botón [English] como se muestra en la siguiente figura. Después de 

completar la modificación, haga clic en el botón [Confirmar] para 

guardar la configuración.

 
Step 12. Complete todas las operaciones de diseño como se indicó 

anteriormente. La pantalla de prueba de ejecución se muestra a continuación. 
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Cuando se presiona el botón [Chino], aparece un cuadro de diálogo de 

confirmación como se muestra a continuación.

 

When the [English] button is pressed, a confirmation dialog box appears 

as shown below. 

 

De esta manera, podemos aplicar este caso a otras mismas funciones, para 

evitar la situación en la que se presiona accidentalmente el botón. 

4.2 Link management 

Cuando selecciona Administración de enlaces, puede ver un diagrama de 

estructura de árbol como se muestra en la siguiente figura. Puede saber 

rápidamente qué protocolo de comunicación y cuántos controladores están 

configurados actualmente en COM1 y COM2. Puede seleccionar el protocolo 

de comunicación o el controlador usando el mouse. Después de presionar el 

botón derecho del mouse, puede crear, editar y eliminar rápidamente 

protocolos o controladores de comunicación para mejorar la puntualidad de las 

operaciones de administración de enlaces. También es fácil crear, editar y 
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eliminar protocolos o controladores de comunicación.

 

TK6070FH】：Indica el modelo de HMI establecido al crear un nuevo 

archivo. 

【COM1】：Configure el protocolo de comunicación al que pertenece 

COM1 en la computadora. Después de hacer clic, puede crear, editar y eliminar 

rápidamente protocolos de comunicación, pero solo se puede configurar un 

protocolo de comunicación para un puerto serie. 

【COM2】：Configure el protocolo de comunicación al que pertenece 

COM2 en la computadora. Después de hacer clic, puede crear, editar y eliminar 

rápidamente protocolos de comunicación, pero solo se puede configurar un 

protocolo de comunicación para un puerto serie. 

【Controller】：Configure el controlador al que pertenece el protocolo de 

comunicación en este puerto serie. Puede configurar varios controladores, pero 

el número de estación y la ID deben ser únicos (para obtener más información, 

consulte la sección 4.2.1). 

Haga clic con el botón derecho en cualquier puerto serie y seleccione 

[Agregar protocolo] para que aparezca la ventana Nuevo protocolo de 

comunicación. Como se muestra en la figura a continuación, seleccione el 
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protocolo de comunicación que desea utilizar.

 
Protocol: Utilice las opciones desplegables para seleccionar el protocolo a 

utilizar. 

Controller: Muestra el fabricante y modelo seleccionado por el protocolo 

de comunicación. 

Electrical: Cuatro opciones de selección, identificación automática, 

RS232, RS422, RS485. 

Baud Rate: de 150 a 115200 velocidades, que se pueden seleccionar. 

Parity: [None], [Odd parity], [Even parity], [Mark], [Space]. 

Data bit: [5], [6], [7], [8]. 

Stop bit: [1 bit], [2 bit]. 

Delay: sin retraso, retraso de 10 ms a retraso de 5000 ms, opcional. 

Timeout: [0.1], [0.2], [0.5], [1], [1.5], [2], [3], [5], [10] un total de 9 opciones. 

Retry Count: Establece el número de retransmisiones cuando la 

comunicación no tiene éxito. 

Multi-Station Smart Link: Seleccione esta bandera de función 

Haga clic en el [OK] botón para completar la configuración del protocolo 

de comunicación. los [Add Controller] aparece como se muestra en la 

siguiente figura. Debe seleccionar el modelo de controlador que desea operar. 
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ID: El número de identificación del controlador. 

Station : el número de estación del controlador, es decir, el número de ID 

del PLC, 

Controller: Muestra el fabricante seleccionado, modelo, descripción, etc. 

Description: Introduzca una descripción o ayuda para este controlador. 

4.2.1 ID and station number 

El número de estación (número de estación HMI) en la configuración de la 

unidad HMI es la ID (ID del PLC) correspondiente al controlador conectado, y 

la ID (ID de la HMI) establecida por la máquina humana es el controlador 

correspondiente en la configuración del software. Para la configuración del 

número de estación, COM1 y COM2 de la HMI son independientes. Por lo 

tanto, COM1 y COM2 se pueden configurar para conectar el controlador con el 

mismo número de estación, pero para la configuración de ID, cada HMI no se 

puede repetir. Porque la ID describe que este controlador es el controlador 
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conectado a la unidad HMI, como se muestra a continuación.

 

4.3 Tag management 

Debido a que hay muchos tipos de modelos de controladores, y los 

números de contactos y registros de protocolos de comunicación definidos por 

diferentes fabricantes no son los mismos, para facilitar la memorización de los 

números de contacto o registro, el diseño del software utiliza la gestión de 

etiquetas para aumentar la legibilidad. 

Por ejemplo, al crear una nueva etiqueta, reemplazamos el contacto X1 con el 

nombre [prueba]. Una vez completada la nueva construcción, siempre que el 

componente necesite usar X1, escriba [prueba] en la posición de escritura o 

lectura o haga clic en el menú desplegable para seleccionar [prueba], luego el 

sistema tratará [prueba] como es x1 De esta forma, cada contacto y registro se 

puede configurar con un nombre conveniente y más fácil en lugar del nombre 

del contacto y registro en el protocolo de comunicación original. 

4.3.1 Tag management case 

Step 1. Click [Project]-> [Tag]-> [Add Tag Group], como se muestra en la 

siguiente figura. El uso de la clasificación de etiquetas puede hacer que las 

etiquetas sean más detalladas y puede ser más conveniente y rápido de usar.
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Step 2. en la ventana emergente “Add Tag Group” cuadro de diálogo, 

establezca el nombre de la clasificación de etiqueta recién agregada, como se 

muestra en la siguiente figura. 

 

Step 3. Haga clic en el [OK] botón para agregar un nuevo grupo de etiquetas. 

En este momento, debe hacer clic en [Project]-> [Tag ]-> [Add Tag] para abrir 

el cuadro de diálogo para agregar etiquetas, como se muestra en la siguiente 

figura.  

Set the content of each parameter, refer to section 2.4.3. 

Note: If you do not need to subdivide the label classification, you can omit step 

1 and step 2. When you add a new label, start directly from step 3. Step 4. 

Después de hacer clic en [OK] en el paso 3, el "For monitoring pages" la 

etiqueta se agregará con una pestaña "TEST", como se muestra a 

continuación: 
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Step 5. Agregar “numeric entry” elementos a la pantalla de inicio, como se 

muestra en la siguiente figura.

 
Step 6. Abra la página de propiedades del componente, como se muestra en la 

siguiente figura. Después de configurar la etiqueta, puede usar directamente la 

opción desplegable para seleccionar [Test] en la posición de lectura en lugar 

de escribir. Por lo tanto, el uso de etiquetas puede mejorar en gran medida la 

visibilidad de los contactos y las memorias durante la operación y reducir el 

error humano. 

 

Chapter 5 Language management 

Este software es compatible con varios idiomas. El propósito es permitir 

que cualquier persona use el lenguaje y los símbolos con los que está 

familiarizado para editar los proyectos requeridos en esta plataforma de 

software. Como resultado, hmi se puede usar rápidamente, la legibilidad se 

puede mejorar visualmente y se puede aumentar la eficiencia del trabajo. 
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Los idiomas múltiples solo se pueden usar en componentes que pueden 

mostrar números o texto. Cuando creamos un nuevo proyecto, el sistema 

utilizará el idioma predeterminado por el sistema operativo (aquí se toma como 

ejemplo el chino simplificado), por lo que el texto o los números introducidos en 

el componente se clasifican en idioma chino simplificado. Si creamos un nuevo 

idioma inglés, como se muestra a continuación. En este momento, puede elegir 

chino o inglés aquí. Si configuramos previamente el componente y 

configuramos el componente en texto o número, podemos encontrar que 

cuando se selecciona chino, el componente muestra el texto o el número que 

ingresamos, pero cuando se selecciona inglés, el texto y los números en el 

componente desaparecieron porque no ingresamos texto ni números en el 

idioma inglés, por lo que no aparecieron. 
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Por lo tanto, para mostrar varios idiomas nuevos, debe ingresar varios idiomas 

y caracteres nuevos en el componente. Podemos crear múltiples idiomas en la 

gestión de idiomas. La ventana de propiedades del objeto del componente 

puede seleccionar el idioma en [Estado], [Texto] puede ingresar el texto del 

idioma que seleccionamos, de modo que no importa qué idioma se seleccione, 

aparecerá el texto que ingresamos para este idioma en el componente. 

5.1 Add, edit, delete languages 

Después de seleccionar [Project]-> [Language], habrá seis opciones, 

como se muestra en la siguiente figura.

 
Haga clic directamente en el icono de administración de idiomas en la 

barra de herramientas  , el cuadro de diálogo de administración de 

idiomas se muestra a continuación.

 
Índice: El campo de índice es el valor de índice de cada idioma y es único. 

Cada valor de índice corresponde al parámetro preestablecido del sistema 

N65342 [índice de idioma de pantalla actual]. Por lo tanto, cuando se cambia 

el valor del parámetro del sistema, el idioma correspondiente se cambiará de 

acuerdo con el valor del índice que se llenó en la posición de escritura. 
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Add language: Al hacer clic en esta opción, aparecerá un "cuadro de diálogo 

de configuración". 

  

Name: Haga clic en la lista desplegable para seleccionar el idioma que 

desea agregar. 

Local ID: El código de área del área de idioma seleccionada. Este 

elemento se agrega de forma predeterminada. 

Font: Muestra la fuente predeterminada predeterminada que seleccionó. 

Select font: Haga clic en este botón para abrir el cuadro de diálogo de 

selección de fuente, como se muestra en la figura siguiente. Puede establecer 

la fuente, el glifo, el tamaño, el efecto, el subrayado y el color predeterminados 

del nuevo idioma. 

Test: Muestra la plantilla de la fuente seleccionada. 

Decimal: Establezca qué símbolo se muestra cuando se muestra el 

símbolo del punto decimal. 

Separate: Establezca qué símbolo usar al mostrar el separador. 

Después de hacer clic en el botón [Aceptar], se agrega un nuevo idioma a la 

pantalla de administración de idiomas, como se muestra en la figura a 

continuación.

 

Edit language: Haga clic en esta opción para establecer la fuente, el glifo, 

el tamaño, el efecto, el subrayado y el color del idioma existente. La pantalla 

de edición es la misma que se muestra al agregar un nuevo idioma. 

Delete language: Haga clic en esta opción para eliminar el idioma 

existente. 
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Set initial language: Haga clic en esta opción en varios idiomas para 

establecer el idioma inicial. 

String translation: Haga clic en esta opción para convertir el idioma de la 

pantalla al idioma seleccionado, como se muestra en la figura siguiente. 

 

Entre ellos, el programa de software configura el chino y el inglés como 

funciones de traducción predeterminadas. Además, puede usar la función del 

diccionario de traducción para configurar el texto del idioma correspondiente, 
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como se muestra en la figura a continuación.

 

Dic. Translate： Configure la traducción del idioma correspondiente usted 

mismo. 

5.2 Multi-language and component cases 

Paso 1. Cree un nuevo archivo de proyecto. 

Paso 2. Agregue el idioma inglés. 

Paso 3. Seleccione el componente. Aquí, toma [Static Text] in [Static] como 

ejemplo. 
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Como se muestra abajo.  

Paso 4. Abra el cuadro de diálogo Propiedades de texto estático. Primero 

configure el idioma inglés como se muestra a continuación.
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Paso 5. Configure el idioma chino nuevamente como se muestra a 

continuación.

 

Paso 6. Cuando ambos idiomas estén configurados, haga clic en el botón [OK]. 

El texto estático ahora mostrará la fuente del idioma seleccionado. 

Como se describe en el capítulo anterior, cuando se selecciona chino 

o inglés, se muestran diferentes fuentes. 

Paso 7. Agregue [botón de valor] a la pantalla inicial, abra la ventana de 

propiedades del objeto, seleccione [variable o constante] en [acción] y 

seleccione [índice de idioma de la pantalla actual] en [escribir DIRECCIÓN]. 

[Reglas] Ingrese [0], que se refiere al valor del índice mencionado en la 

sección 5.1, que indica que la familia de idiomas es el chino, y 1 indica el 
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inglés, como se muestra en la figura a continuación.

 

[Status] página, configure el idioma del estado chino y el idioma del estado 

inglés, como se muestra a continuación. 

 

Paso 8. Agrega un segundo [Value button], establezca las propiedades del 

botón de configuración como se muestra a continuación 
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Establezca su página de estado en texto en chino e inglés como se muestra a 

continuación.

 

Paso 9. La configuración está completa y el proyecto se puede descargar a la 

HMI. O seleccione [HMI (M)]-> [Offline Execution] or use the hot key Shift + F9 

para comprobar el efecto. 
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Cuando haces clic en el [English] botón, el efecto es como se muestra en la 

siguiente figura.  

Cuando hace clic en el botón [Chino], el efecto es como se muestra a 

continuación.  

Chapter 6 Alarm management 

Click [Project]-> [Alarm] En la barra de menú o seleccione directamente el 

[Alarm ] icono

 
en la barra de herramientas para abrir la ventana, como se muestra en la 

siguiente figura. 
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Haga clic en el botón Nueva área de alarma para abrir la ventana Nueva 

área de alarma, como se muestra en la figura a continuación.

 

Name: Ingrese el nombre establecido para la zona de alarma recién agregada. 

Address: Ingrese la posición de la variable, puede seleccionarla a través del 

símbolo de flecha desplegable o directamente ingrese la posición 

de la variable. Como se muestra en la figura anterior, el botón de 

icono  detrás del cuadro de entrada indica que la posición 

debe ser PALABRA. Haga clic en el botón para abrir la ventana 

de variables como se muestra a continuación para verificar qué 

variable está en tipo WORD. Al mismo tiempo, también puede 

ingresar o seleccionar la variable requerida en el cuadro de 
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edición de números como se muestra a continuación.

 
Alarm shielded address: Cuando se activa la alarma, esta función se puede 

utilizar para proteger la alarma, es decir, el mensaje de alarma y 

el sonido no se muestran. El método de selección de la dirección 

blindada es el mismo que el de la dirección del área de alarma. 

Update cycle: Puede elegir la frecuencia con la que desea actualizar. Si 

selecciona 3 segundos, significa que la alarma se verificará cada 

3 segundos. 

Classification group: Puede comprobar en qué grupo se clasificará esta 

alarma. Haga doble clic con el botón izquierdo del mouse en el 

grupo para editar el nombre del grupo. 

Start-up delay: Seleccione si desea esperar a que el controlador inicie el 

tiempo de alarma después de completar la creación de datos. 

Help: Escriba una declaración de ayuda para esta alarma. 

Cuando se agrega el área de alarma, el [Alarm] se muestra en la siguiente 

figura. En este momento, hay dos botones de configuración agregados en la 

barra de herramientas de la ventana, que son [Edit Alarm] and [Delete Alarm], 

[ Edit Alarm] significa volver a editar los datos del área de alarma actual. 

[Delete alarm] es borrar los datos del área de eventos de alarma 

seleccionada. 
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Como se muestra a continuación, en el mensaje seleccionado que se 

configurará, y luego presione [Configuración de alarma] o haga doble clic 

directamente en el mensaje seleccionado, aparecerá la ventana de 

configuración de alarma como se muestra a continuación.

 

Alarm define 

Definición de alarma 

Valor de índice: debido a que la ubicación de la alarma se almacena en 

WORD, el tamaño de WORD es de 2 bytes. Cuando WORD es 1, se convertirá 

a binario [0000 0000 0000 0001]. Por favor refiérase a la tabla de abajo. 
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2power 
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

2Carry 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 

index 
5 4 3 2 1 0 

          

Level: Después de configurar el nivel, es conveniente que los usuarios 

editen el nivel de esta alarma. 

Trigger method: 

Positive edge: Cuando los datos cambien de 0 a 1, active la alarma. 

Negative edge: Cuando los datos cambien de 1 a 0, active la alarma. 

Positive and negative edge: Cuando los datos cambien de 0 a 1 o de 1 a 

0, active la alarma. 

High level: Cuando el dato es 1, activa la alarma. 

Low level: Cuando el dato es 0, activa la alarma. 

Mezcla de flanco positivo y nivel alto: cuando se cumplan las condiciones 

de flanco positivo y nivel alto, active la alarma. 

Mezcla de flanco negativo y nivel bajo: cuando se cumplen las condiciones 

de flanco negativo y nivel bajo, active la alarma. 

Pantalla de alarma: Seleccione la pantalla que aparece durante la alarma. 

Debe agregar un nuevo cuadro de diálogo antes de editar la pantalla que 

se usará durante la alarma. 

 

Configuración de la pantalla de alarma: 

Cuadro de diálogo: 1. Al seleccionar un cuadro de diálogo, tenga en cuenta 

que la pantalla configurada debe tener la función de salir del cuadro de 

diálogo; de lo contrario, cuando se produzca la alarma, el cuadro de diálogo 

establecido provocará el problema de no poder salir. 

2. Cuando opere la pantalla (el tipo de pantalla es un cuadro de diálogo), 

si la alarma se produce en este momento, desaparecerá la pantalla que no se 

haya operado por completo antes. 

Cambio de pantalla: seleccione la pantalla de visualización a la que saltar 

cuando se produzca la alarma, como la pantalla de la tabla de visualización de 

alarma actual. 

Mensaje: Al seleccionar el mensaje, puede elegir segundos para que aparezca 

el mensaje, no afectará la función de la operación actual. 

Ver pantalla: puede agregar un cuadro de diálogo para editar la pantalla. 

Cuando ocurre una alarma, desea ver qué tipo de alarma ocurrió antes, 

aparecerá esta pantalla. Configuro la pantalla expresada por esta alarma y 

puedo hacer un punto de alarma conveniente a la pantalla de búsqueda. 

Sonido de alarma: seleccione el sonido cuando se produzca la alarma, primero 

debe configurar el sonido en la gestión de sonido. 

Descripción: una descripción de esta configuración. 
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Alarm message 

Language: Configure el idioma cuando se muestre el mensaje de 

alarma.Color: Configure el color del texto cuando se muestre el mensaje 

de alarma. 

Text: Configure el texto que se muestra en el mensaje de alarma. 

Haga clic en el [Alarm Configuration] botón. El cuadro de diálogo de 

configuración de alarma se muestra a continuación:

 
Alarm record 

Números de registro: configure el número de alarmas registradas, que 

van de 2 a 2048. Cuando el número de alarmas supera el número establecido, 

los primeros datos registrados se eliminarán uno por uno para aumentar el 

último registro de alarma. 

Usar retención de apagado: seleccione esta opción para guardar los datos en 

el registro de alarmas cuando la HMI se apaga y luego se reinicia. 

6.1 Alarm case 

Este capítulo usa un caso simple para explicar cómo configurar la alarma 

(disparador, escudo) y usa la tabla de registro de alarmas para mostrar la 

información de alarmas ocurridas. 
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Paso 1. Antes de configurar la información de alarma, debe editar la pantalla 

de alarma, como se muestra en la siguiente figura.

 

Paso 2. Haz clic [Project]-> [Alarm] En la barra de menú o seleccione 

directamente el 

 
en la barra de herramientas para abrirlo, como se muestra en la siguiente 

figura. 

[ Alarm ] icono 
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Paso 3. Haga clic en el botón [Agregar alarma] para abrir la nueva ventana del 

área de alarma y configure los parámetros como se muestra en la siguiente 

figura.  

Una vez completada la configuración, haga clic en el botón [Aceptar] para 

guardar la configuración. Mostrar como se muestra en la siguiente figura.

 

Paso 4. Seleccione la barra de información con un valor de índice de 2 y 

haga clic en el [Alarm Setting] o haga doble clic en la información para abrir el 

cuadro de diálogo de configuración de información de alarma. El contenido de 
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la configuración se muestra en la siguiente figura.

 
Una vez completada la configuración, haga clic en el botón [OK] botón 

para guardar la configuración. Mostrar Como se muestra en la siguiente figura.

 
Paso 5: Regrese a la pantalla de inicio, diseñe la pantalla de inicio, configure el 

valor de N0 usando los botones de incremento y decremento, y use la lámpara 

de visualización para mostrar la situación del bit N0. Como se muestra en la 
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siguiente figura.

 

La nueva pantalla agregada se configura como una pantalla de protección, 

diseñe la pantalla de protección, configure el valor de N0 usando los botones 

de incremento y disminución, y use la lámpara de visualización para mostrar la 

situación del bit N0. Como se muestra en la siguiente figura.

 

Use [Alarm Display Table], [Alarm Count Table] y [Current Alarm Table] 

respectivamente para diseñar una pantalla para grabar la alarma, como se 

muestra en las siguientes tres figuras. Consulte la sección 3.4.16 para obtener 

instrucciones específicas sobre la tabla de registro de alarmas. 
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Paso 6. Una vez completadas todas las configuraciones de la pantalla, 

puede comenzar a ejecutar acciones. Hacer clic [Offline Execution] o presione 

[Shift]+[F9], y la pantalla de ejecución se muestra en la siguiente figura.

 
En este momento, podemos encontrar que al hacer clic en el botón [+], el 

valor de N0 cambia de [0] a [1], pero la alarma no se dispara hasta [4]. 

Configurando el activador de alto nivel, ¿por qué se activa cuando el valor es 

4? la ubicación de la alarma se almacena en WORD. En el paso 4, 

seleccionamos el índice 2 en [Alarma] para configurar, es decir, cuando el 

segundo bit de N0 es 1, el valor de N0 debe ser 4 para disparar. Debido a que 

el tamaño de los datos de PALABRA es de 2 bytes y es [0000 0000 0000 0000] 
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(consulte la tabla de este capítulo) en términos binarios, cuando se activa el 

nivel alto, el valor binario correspondiente al índice 2 es 1, es decir, [0000 0000 

0000 0100], y la pantalla binaria correspondiente es 22 potencia, 1 * 22 potencia 

= 4, por lo que la configuración del índice 2 solo se activará cuando el valor N0 

sea 4. 

Paso 7. Si el usuario no apaga la alarma ni protege la alarma después de 

que se produzca la alarma, la pantalla de alarma se reproducirá cada dos ciclos 

de actualización de acuerdo con el ciclo de actualización establecido en [Alarm 

(Event) Management] (3 segundos en este caso) hasta que la alarma se 

apague o proteja. 

Cuando ocurre una alarma, la información de la pantalla de [Alarm Display 

Table], [Alarm Count Table] y [Current Alarm Table] se muestran a 

continuación. 

[Alarm Display Table] se recopilarán en una tabla de registros según las 

alarmas que se hayan producido. 

 

[Alarm Count Table] Todo el número de alarmas que se han producido 

hasta el momento se contará y compilará en una tabla de recuento. 
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[Current Alarm Table] Muestra la información de alarma que está 

ocurriendo actualmente y que no se ha borrado en la tabla de registros.

 
Paso 8: después de que se produzca la alarma, la información de alarma 

enviada debe cerrarse o protegerse. El método para cerrar la información de 

alarma es restaurar el valor de N0, es decir, restaurar el bit correspondiente al 

valor de índice a 0. Proteger la información de alarma se refiere a establecer el 

valor de la dirección protegida de alarma N1 para que sea el mismo que el de 

N0. Como se muestra en la siguiente figura, la información de alarma se puede 
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proteger.

 

En este momento, la información de la pantalla de [Alarm Display Table], 

[Alarm Count 

Table] y 

[Current Alarm Table] se muestran en las siguientes tres figuras. 

[Alarm Display Table] registra todas las alarmas que se han producido. Si 

la alarma se ha borrado o protegido, se mostrará el tiempo de recuperación. 
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[Alarm Count Table] es el mismo que antes, y siempre contará las veces 

que ocurre cada alarma.

 
Debido a que la alarma se ha borrado, no hay registro de ninguna alarma 

en [Current Alarm Table]. 

 

Hasta aquí se ha completado la descripción básica de la configuración de la 

información de alarma. 

Los siguientes pasos introducirán el uso de la pantalla de inspección para 

marcar los puntos de falla. 
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Paso 9. Primero agregue la pantalla de visualización en el cuadro de diálogo 

de configuración de alarma, como se muestra en la figura a continuación.

 

Paso 10. Cambie la edición de pantalla de la pantalla de alarma actual a la 

siguiente.

 

Ingresar [Current alarm table] página de configuración de propiedades. En 

la página de configuración avanzada, al seleccionar los elementos en [Options], 

se muestra la pantalla de visualización. seleccionarlo Como se muestra abajo. 
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Plan [View Screen 1], [View Screen 2], y [View Screen 3] Como se 

muestra abajo 
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Paso 11. Repita el paso 4 para configurar las acciones de los índices de 

alarma 1, 2 y 3, y configure la pantalla de visualización como Ver pantalla 1, 

Ver pantalla 2, Ver pantalla 3. Es decir, cuando el valor de N0 es 14, tres los 
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mensajes de alarma se disparan simultáneamente. Como se muestra abajo

 

En este momento, ingrese el [Current Alarm Screen] y puede ver que 

hay tres alarmas de información en el [Current Alarm Table], como se 

muestra en la siguiente figura.

 
Al seleccionar el elemento de alarma en el [Current Alarm Table], la 

posición relativa de la tabla de alarmas de falla se mostrará en la pantalla en el 
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lado derecho de la HMI.

 

Chapter 7 Password Management 

Al operar el equipo, a menudo es necesario proporcionar a los usuarios 

con diferentes responsabilidades funciones operativas de diferentes permisos. 

Algunas funciones importantes solo están disponibles para los usuarios que 

tienen una contraseña y permisos suficientes. En este sentido, la gestión de 

contraseñas proporciona una capa de protección y comodidad en la gestión de 

derechos. 

Click [Project]-> [Password] para abrir el formulario de edición de 

contraseña, como se muestra en la siguiente figura. Este software proporciona 
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8 conjuntos de contraseñas y 8 tipos de niveles de permisos a configurar por 

los usuarios. El primer conjunto de sistemas aplica los permisos más altos 

para evitar permisos insuficientes cuando se configura incorrectamente. 

 

Generalmente, el nivel predeterminado de la nueva pantalla añadida es 

[set by screen group], el nivel predeterminado del grupo de pantalla es la 

autoridad más baja, y el nivel predeterminado de todos los componentes es 

[set by screen]. Por lo tanto, a menos que se especifique lo contrario, el 

usuario puede usar todas las funciones de edición, ya que todas las 

funciones están disponibles en el nivel más bajo de autoridad. 

7.1 Component setting 

Si algunos usuarios deben estar restringidos a un determinado 

componente (componente de botón y componente de edición), puede 

configurar el permiso de uso de este componente al configurar el componente. 

Como se muestra en la figura a continuación, establezca el permiso de uso de 

[Screen Button] to [User level 4]. 
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Al usar este botón, la autoridad es menor que la autoridad de configuración, la 

pantalla de ingreso de contraseña se mostrará a continuación, requiriendo la 

contraseña correcta antes de continuar usando esta función.

 

7.2 Screen settings 

Si necesita restringir al usuario a los componentes de toda la pantalla, puede 

configurar el uso de Propiedades de pantalla al editar la pantalla y está 

restringido por la configuración al usar el componente de pantalla. Los ajustes 
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se muestran a continuación.

 

7.3 Password screen setting 

Además de planificar el proyecto HMI, puede editar la contraseña que se 

utilizará en [Project]-> [Password Management], o puede diseñar una página 

de contraseñas específicamente para la gestión de contraseñas en el proyecto 

de interfaz hombre-máquina. Espectáculo. El elemento de entrada es 

[Password Edit] in [Edit]. 



Manual de programación de HMI de la serie TK 

 223 
https://coolmay.com.ar 

 

[Password Edit] La página de configuración de propiedades es la siguiente, 

puede elegir establecer varios grupos de contraseñas. Solo el primer grupo de 

contraseñas, es decir, la contraseña con la autoridad más alta, no se puede 

configurar y debe configurarse durante la planificación del proyecto.

 

Chapter 8 Sound Management 

En este software, los usuarios pueden editar varios efectos de sonido para 

usar, haga clic en [Project]-> [Sound Management] para abrir la ventana de 
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administración de sonido, como se muestra a continuación.

 
La parte del círculo de arriba es el sonido predeterminado por el sistema. 

De forma predeterminada, el sistema establece el índice 0 y el índice 1 en la 

figura como el sonido del botón y el cuadro de diálogo. 

Click the [Add Sound] Botón, y el [Add Sound Window] aparecerá como 

se muestra a continuación.  

Index: El sistema agrega automáticamente el valor del índice en 

secuencia. 

Name: Introduzca el nombre definido para este sonido. 

Repeat Count: elige el número de repeticiones al usar este sonido, 

puedes elegir no repetir hasta 7 veces. 

Description: Introduce una descripción de ayuda para este sonido. 
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Después de configurar, haga clic en [OK] botón para guardar la 

configuración anterior. Haga clic en el [Add Item] Botón, y el [Add Sound Item] 

aparecerá como se muestra a continuación. 

 

Frequency: Introduzca la frecuencia del sonido. El sonido alto y bajo 

cambiará con la frecuencia. La alta frecuencia significa un sonido agudo y la 

baja frecuencia significa un sonido bajo. Para configurar la frecuencia del 

sonido, consulte [Appendix 3 Scale Frequency Table] 

Time: Ingrese el tiempo para hacer un sonido, en ms, 500 ms es igual a 

0,5 s, lo que indica que el sonido se detendrá después de 0,5 segundos. 

El botón triangular en el círculo de la figura tiene la función de intentar 

reproducir el sonido. Después de configurar la frecuencia y la duración del 

sonido, puede presionar este botón para reproducir y confirmar si es el sonido 

que desea configurar. 

Esto completa el ajuste de cada parámetro de sonido. En el proceso de 

configuración de los atributos de los componentes, si hay una demanda de 
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sonido, puede optar por usarlo, como se muestra en la siguiente figura.
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Chapter 9 Data Synchronization Management 

Cuando el dispositivo se está ejecutando, hay algunos materiales que deben 

actualizarse sincrónicamente, o cuando necesita usar un dato para afectar 

otro dato, puede usar [Data Sync] completar. 

Click [Project]-> [Data Sync…] to open the [Data Sync] Ventana, como se 

muestra en la siguiente figura.

 
Haga clic en el [Add] botón para abrir el [Add Data Sync] ventana como se 

muestra a continuación. 

Puede editar los datos que desea sincronizar.
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Time: Seleccione el tiempo para lograr la sincronización, es decir, cuando 

cambien los datos de la dirección de origen, cuánto tiempo se sincronizarán 

los datos de la dirección de destino después de que alcance la variable de 

condición. En otras palabras, el momento en que la condición de 

sincronización es válida. Por ejemplo, la sincronización  

condition mode: nivel alto; variable de condición: N10.0; tiempo de 

sincronización: 10 minutos; luego N10.0==1 después de 10 minutos, los datos 

comienzan a sincronizarse, si es un flanco descendente, entonces la condición 

debe mantenerse Más de 10 minutos, de lo contrario no se puede detectar el 

flanco descendente, por lo que no hay un requisito especial. Por lo general, 

establezca el tiempo de sincronización en 0,2 segundos (es decir, la condición 

de activación es muy sensible y la variable de condición se sincroniza de 

inmediato). 

Format: seleccione el tipo y el tipo de variable utilizada para la 

sincronización de datos. 

Condition: Establezca la variable de condición y decida si sincronizar de 

acuerdo con el modo de condición de sincronización de esta variable de 

condición. 

Type: En este caso, el nivel alto se establece para lograr la 

sincronización. 

Rising edge: Cuando los datos cambian de 0 a 1, se logra la 

sincronización. 

Falling edge: Cuando los datos cambian de 1 a 0, se logra la 

sincronización. 

Rising and falling edges: Cuando los datos cambian de 0 a 1 o de 1 a 0, 

ambos se sincronizan. 

Positive level: cuando el dato es 1, se logra la sincronización. 

Negative level: cuando el dato es 0, se logra la sincronización. 

Source: Establezca la dirección de la fuente de datos, es decir, la 

dirección donde se leen los datos. En este caso se utiliza la variable de 

sistema N0. 

Destination: Configure la dirección de destino de los datos, es decir, la 

dirección donde se escriben los datos. En este caso, se utiliza la variable de 

sistema N1. 

Description: Ingrese la descripción de la definición para estos datos 

sincrónicos, no puede ingresarlos. 

Una vez completada la configuración de parámetros anterior, se puede 

editar la pantalla de sincronización editable. Esta pantalla cambia el valor de 

N0 mediante los botones de incremento y decremento. Después de que el 

valor de N0 cambia durante 3 segundos, el valor de N1 cambia al mismo valor 

que N0. Espectáculo. 
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Chapter 10 Recipe Management 

Cuando la HMI está conectada al PLC, a menudo hay una gran cantidad 

de valores con la misma naturaleza de los datos que deben transmitirse. 

Clasificamos y clasificamos estos datos y los transmitimos al mismo tiempo. 

Esta es la receta. Cuando el equipo general está en funcionamiento real, hay 

algunos materiales de producción que deben transmitirse al PLC mediante la 

interfaz hombre-máquina, o cuando se requiere la interfaz hombre-máquina 

para registrar los datos, puede usar [Recipe] conseguir. 
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Click [Project]-> [Recipe] para abrir el [Recipe] Ventana de administración, 

como se muestra a continuación.

 
Haga clic en el [Add] botón para abrir el [Add Recipe] ventana de 

definición, como se muestra en la figura a continuación, puede editar los datos 

de la nueva receta. 

 

Index: El sistema agrega automáticamente el valor de índice de los datos 

de la receta en secuencia. 

Name: Establezca el nombre de la receta. 

Work: Use la receta para almacenar temporalmente la dirección de inicio 

de la variable correspondiente (el tamaño es 1 capacidad de receta de grupo). 
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Control: dirección variable que controla la acción de la receta (el tamaño 

del área de control es 4 PALABRAS) 

Addres 

s 
Name Content Remarks 

+0 Index0 0..65535  

+1 Rev 0 Keep 

+2 Rev 0 Keep 

+3 Control 

Bit0=Read(Move from backup area 

to work area) 

Bit1=Write(Move from backup area 

to work area) 

Automatically 

cleared after 

moving parts 

Backup Addr: Elija la copia de seguridad de recetas, actualmente solo hay 

2 opciones disponibles. 

Datos de solo lectura: los datos se almacenan en el programa HMIT, 

adecuado para recetas de solo lectura. 

Use el área de variables del sistema (N0-N61439): los datos se 

almacenan en el área de variables del sistema, adecuada para leer y escribir 

recetas. 

Remarks: Para el área de variables del sistema, verifique la sección de 

retención de fallas de energía de los modelos individuales. 

Backup Addr: La dirección de almacenamiento de la receta de respaldo. 

Recipe Count: El número total de grupos de recetas. 

Description: Ingrese el texto de descripción de esta receta, no puede 

ingresarlo. Definición de variable de fórmula: 
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Add / Delete Variables: Haga clic en el botón Agregar/Eliminar 

directamente para agregar/eliminar variables. 

Set variable format: Haga clic en cualquier columna que necesite 

modificar el formato de variable y luego haga clic en el formato de variable 

correspondiente requerido por esta columna. 

S16: Establecer en número con signo de 16 bits. 

U16: Establecer en número sin signo de 

16 bits.  

S32: Establecer en número con signo de 

32 bits. 

U32: Establecido en número sin signo de 32 bits. 

F32: Establecido en coma flotante de 32 bits. 

Definition of recipe variables: Las acciones de recetas se controlan 

leyendo y escribiendo variables en el área de control. 

Leer acción de receta: 

Address Name Content 

+0 Index0 0 

+1 Rev 0 

+2 Rev 0 

+3 Control 
Set 1(Bit0 ： Mover del área de 

respaldo al área de trabajo) 

Mover la receta del grupo 0 del área de respaldo al área de trabajo 

Escribir acción de receta： 

Address Name Content 

+0 Index0 7 

+1 Rev 0 

+2 Rev 0 

+3 Control 
Set 2(Bit1 ： Mover del área de 

respaldo al área de trabajo) 

Se movió de la receta del grupo 0 en el área de trabajo al grupo 7 en el 

área de respaldo. 

Además, para escribir la receta en el PLC del controlador o leerla desde el 

mismo PLC del controlador, es necesario hacer coincidir el componente del 

botón de movimiento de datos, como se muestra en la figura a continuación. 
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10.1 Recipe use cases 

Este caso se utiliza para explicar cómo configurar la receta de datos de 

uso. 

Paso 1. Click [Project]-> [Recipe] en la barra de menú para abrir la 

[Recipe] Ventana de Gestión, como se muestra en la siguiente figura: 

 
Paso 2. Haga clic en el [Add Recipe] botón para abrir el [Add Data Recipe 

Definition] e ingrese el valor de cada parámetro, como se muestra en la 

siguiente figura.  

Paso 3. Después de configurar los parámetros, haga clic en el [OK] botón 

para volver a la [Recipe] Ventana de gestión. Los datos de receta recién 

agregados se muestran en el lado derecho de la ventana, como se muestra en 

la siguiente figura. 
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Paso 4. Haga clic en el [Add] Presione el botón Variable de receta en N13 e 

ingrese el valor numérico de la receta, como se muestra en la siguiente figura. 

 

Paso 5. Cierre el [Recipe] ventana, regrese a la pantalla de edición del 

proyecto y agregue los elementos de edición numéricos en las direcciones del 

, agregar la receta variable 
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área de trabajo N10 ~ N13, como se muestra en la figura a continuación.

 
Paso 6. Agregue los elementos de visualización numéricos de las direcciones 

de respaldo N100 ~ N123. Generalmente, no es necesario planificar la edición 

de esta parte durante la operación real. Como se muestra abajo.

 

Paso 7. Agregue un componente de edición numérica para la cantidad de 

grupos de recetas, que se puede usar para leer y escribir la cantidad de 
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grupos de recetas especificados. El formato se muestra en la siguiente figura.

 

Paso 8. Agregue un componente de botón de ENCENDIDO, que se usa como 

datos de recetas para escribir en la dirección de respaldo del número de grupo 

de recetas especificado desde la dirección del área de trabajo, y su posición 

variable se ingresa como N3.1, como se muestra en la figura a continuación. 

 

Paso 9. Agregue un componente de botón de ENCENDIDO escrito en el área 

de almacenamiento, que se usa como datos de recetas para leer desde la 

dirección de respaldo del número de grupo de recetas especificado a la 

dirección del área de trabajo, e ingrese N3.0 como la posición variable, como 
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se muestra en la siguiente figura.

 

Paso 10. La configuración de edición de pantalla está completa, en este 

momento haga clic en la opción de menú [HMI]-> [offline execution], aparece 

la pantalla de ejecución como se muestra en la siguiente figura.

 
Paso 11. Ingrese 3 en el cuadro de edición del número de grupo de 

recetas y presione [Backup Addr-> Work area] para escribir el tercer grupo de 

datos de receta desde la dirección de respaldo a la dirección del área de 



Manual de programación de HMI de la serie TK 

 238 
https://coolmay.com.ar 

trabajo, como se muestra en la figura a continuación.

 

Paso 12. Cambie el valor en el cuadro de edición del número de grupo de 

fórmula a 4 y luego modifique el valor de cada receta en el área de trabajo. 

Después de la modificación, presione [Work Area-> Backup Address] para leer 

los datos de la receta en la dirección del área de trabajo a El cuarto grupo de 

direcciones de respaldo se muestra a continuación.

 
Paso 13. El uso de recetas generales debe coincidir con el registro del PLC, 

por lo que los componentes de edición numérica de las posiciones del PLC D0 
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~ D3 se agregan como se muestra en la siguiente figura.

 

Paso 14. Haz clic [Project]-> [Data Synchronization Management] en la 

barra de menú para agregar 2 sincronización de datos de [PLC-> Working 

Area] and [Working Area-> PLC], como se muestra en la figura a continuación, 

para obtener más detalles, consulte el Capítulo 9.
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Paso 15. Modifique los dos botones ON en la pantalla de edición como se 

muestra a continuación.

 

Paso 16. Haz clic en la opción de menú [HMI]-> [Off-Line Run], la pantalla 

de ejecución es como se muestra en la siguiente figura.

 
Paso 17. En este momento, haga clic en el número de grupos de recetas 

para ingresar 2 y luego haga clic en [Backup Addr-> PLC], los datos de receta 

del tercer grupo se pueden leer desde el área de dirección de respaldo a la 
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dirección del PLC, como se muestra en la figura a continuación.

 
Paso 18. Modifique la cantidad de grupos de recetas, ingrese 1, cambie 

los datos en la ubicación del PLC D0 ~ D3 y luego haga clic en [PLC-> Backup 

address], los datos de la receta en la ubicación del PLC se pueden escribir en 

la dirección de respaldo del tercer grupo, como se muestra a continuación. 

  



Manual de programación de HMI de la serie TK 

 242 
https://coolmay.com.ar 

Capítulo 11 Tipos de macros y gramática 

11.1 tipos de macros 

INITIAL Macro 

Comando de macro que se inicia cuando se enciende o se reinicia la HMI. 

Esta macroinstrucción se ejecuta solo una vez y generalmente se usa para 

configurar el valor inicial. Por defecto, puede ejecutar 4096 pasos. 

 

BACKGROUND Macro 

Después de encender o reiniciar la HMI, el programa se ejecutará todo el 

tiempo. Similar al programa en segundo plano, se pueden realizar 1024 pasos 

de forma predeterminada en 50 ms. 

 

CLOCK Macro 

Después de encender o reiniciar la HMI, el programa se ejecutará a intervalos 

y el intervalo se establece en 500 ms para ejecutar 4096 pasos.

 

Screen Open Macro 

Cuando la pantalla se cambia a la pantalla configurada actualmente, se 

ejecutará el programa macro OPEN, y el valor predeterminado puede realizar 

4096 pasos a la vez. 

Screen Close Macro 

Cuando la pantalla actual se cambia a otra pantalla, se ejecutará el programa 

de instrucción de macro CERRAR. De forma predeterminada, puede realizar 

4096 pasos a la vez. 

Screen Cycle Macro 

Cuando la pantalla se cambia a la pantalla configurada actualmente, el 

programa de comando macro CYCLE se ejecutará todo el tiempo. El tiempo de 

intervalo está predeterminado en 500 ms, y el valor predeterminado puede 
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realizar 4096 pasos a la vez.

 

Macro de acción de componente (componente de botón y componente de 

edición) Cuando se activa el componente de botón o el componente de 

edición, se ejecutará el programa de macro correspondiente. El preset puede 
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realizar 4096 pasos a la vez.

 

Sub Macro 

La instrucción de submacro es equivalente al subprograma en el programa de 

instrucción de macro. El número se proporciona de 1 a 512 subprogramas. Las 

funciones comunes y generales se pueden escribir en el subprograma para 
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facilitar la llamada al programa principal.

 

11.2 Macro Editor 

 
Hay una barra de herramientas en la parte superior de la pantalla de edición, 

con cinco opciones: agregar, eliminar, verificar, importar y exportar. 

Agregar: agregue una macro de acción de componente. 

Eliminar: elimina una macro de acción de componente. 
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Comprobar: comprueba si hay errores en el programa de macros actual. 

Importar: importado del proyecto al programa macro editado actualmente, el 

programa editado actual se borrará. 

Exportar: guarda el programa de macros editado actualmente en el proyecto. 

El lado izquierdo de la pantalla de edición proporciona un diagrama de árbol 

del programa de macros, que muestra todos los comandos de macros. Es 

conveniente editar y previsualizar el programa de macros. 

El lado derecho de la pantalla de edición es el cuerpo principal de la pantalla 

del programa de edición. 

En la parte inferior de la pantalla de edición se encuentra la ventana de 

verificación de información del programa. Se mostrará cuando se ejecute el 

programa de verificación. Cuando la comprobación encuentre un problema, se 

mostrará en la ventana. Haga doble clic con el mouse en el problema que se 

muestra, la pantalla del programa de edición de macros saltará 

automáticamente a la posición del programa correspondiente. 

11.3 Introducción a la sintaxis de macros 

11.3.1 Data format, operator, command list 

Tabla de configuración de formato de datos 

forma 

t 
Bit 

8bit 

Signed 

number 

8bit 

Unsigned 

number 

16bit 

Signed 

number 

16bit 

Unsigned 

number 

32bit 

Signed 

number 

32bit 

Unsigned 

number 

32bit 

Floating 

point 

defini 

tion 
BIT INT8S INT8U 

INT16S 

or 

SIGNED 

INT16U 

INT32S 

or 

SIGNED 

DW 

INT32U 

or 

DW 

FLOAT32 

or 

FLOAT 

Establecer tabla de columnas de operadores 

Set operator Explanation 

= Setting 

+= 
Addition 

settings 

-= 
Subtraction 

setting 
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*= 
Multiplication 

setting 

/= Division setting 

%= 

Integer 

remainder 

setting 

<<= 
Left shift 

setting 

>>= 
Right shift 

setting 

&= 
Bits and 

settings 

^= 

Mutually 

exclusive or 

set 

|= Bit or setting 

Operator column table 

Operation 

symbol 
Explanation 

+ addition 

- Subtraction 

* Multiplication 

/ Division 

% 
Integer 

remainder 

！ Logical 

inverse 

~ Bitwise 

inverse 

== equal 

!= not equal to 

< Less than 

<= 
Less than or 

equal to 

> More than 

>= 
More than or 

equal to 

|| or “OR” 
Logical or 

Operations 
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&& or “AND” 
Logical and 

Operations 

& 
Bits and 

operations 

^ 
Bit-exclusive 

OR operation 

| 
Bits or 

operations 

<< Left shift 

>> Right shift 

Command list 

instruction Explanation 

LABEL (constant) 
Etiqueta de posición del programa (el rango 

constante es 0-65535) 

GOT (constant) 

Saltar a la etiqueta de posición del programa 

incondicionalmente (el rango constante es 0-

65535) 

CALL <Expression> Llamar a submacro (número de submacro 1-

512) 

RET Volver a la ubicación del programa de 

llamadas 

IF <Expression> THEN GOTO LABEL 

<constant> 

Cuando se establezca la condición variable 

(distinta de 0), salte a la etiqueta de posición 

del programa; de lo contrario, continúe con la 

siguiente línea de instrucciones. 

IF <Expression> THEN DO 

Cuando se establezca la condición variable 

(distinta de 0), continúe con la siguiente línea 

de instrucciones, de lo contrario, salte al 

siguiente juicio (ELIF) o (ELSE DO) para 

continuar con la ejecución o ejecute la 

siguiente línea de instrucciones de ENDIF. 

ELIF <Expression> THEN DO 

Cuando se establezca la condición variable 

(distinta de 0), continúe con la siguiente línea 

de instrucciones, de lo contrario, salte al 

siguiente juicio (ELIF) o (ELSE DO) para 

continuar con la ejecución o ejecute la 

siguiente línea de instrucciones de ENDIF. 

ELSE DO 

En conjunto con la instrucción IF o ELIF, 

indica la posición a ejecutar cuando no se 

establece la condición variable (igual a 

0). 
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ENDIF 

Con la instrucción IF o ELIF indica la posición 

a saltar cuando no se establece la condición 

de variable (igual a 0). 

FOR <Expression> 

Bucle de programa, utilizando el valor de la 

expresión como un número fijo de ciclos, el 

rango del programa es el programa de FOR al 

SIGUIENTE correspondiente. 

NEXT 
Junto con la instrucción FOR, indica el rango 

del bucle del programa. 

END Fin del programa de macros 

SETB (Bit variable address) Establecer variables de bits 

CLRB (Bit variable address) Borrar variables de bit 

INVB (Bit variable address) Variable antifase 

Las variables de dirección interna del sistema N0-N65535 N0-N65535 son 

variables de dirección planificadas por HMI internamente, con un total de 

65536 PALABRAS (16 bits). 

Cuando el formato de datos se establece en DWORD, el sistema leerá 

automáticamente una PALABRA después del número, que se define como el 

bit alto, PALABRA alta, y junto con el bit bajo de la variable seleccionada, 

PALABRA baja, para formar una DWORD. Por ejemplo, DWORD N0, luego 

N0 es Lo WROD y N1 es Hi WROD, formando DWORD. 

Cuando el formato de datos es WORD, puede usar directamente el 

nombre de variable definido, a saber, N0-N65535. 

Cuando desee usar un bit para definir la dirección, debe agregar un "." 

Símbolo después del nombre de definición antes de la posición de bit 0 ~ 

15. Por ejemplo, el quinto bit de N0 se puede escribir como "N0.5" y el 

undécimo bit de N100 se puede escribir como "N100.11". 

11.3.2 Instructions 

1. LABEL <constant> 

Etiqueta de posición del programa (el rango constante es 0-65535) 

La posición de la etiqueta puede ser cualquier línea del programa. 

Ejemplos de macros de etiquetas: 

N0 = 100 

#Define label number 10 

LABEL 10 

N1 = 200 

... 

GOTO LABEL 10 

... 
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GOTO LABEL 20 

... 

#Define tag number 20 

LABEL 20 

2. GOTO <constant> 

Saltar incondicionalmente a la etiqueta de ubicación del programa (el rango 

constante es 0-65536) 

N0 = 100 

LABEL 10 

N1 = 200 

... 

... 

# Saltar a la posición del número de etiqueta 10 

GOTO LABLE 10 

3. CALL <variable / constant / expression> Submacro de 

llamada (número de submacro 1-512) 

Los parámetros de la instrucción llamada sub-macro pueden ser variables o 

constantes o expresionesN0 = 100 

#CALL <variable> 

CALL N0 

... 

#CALL <constant> 

CALL N100 

... 

#CALL <expression> 

CALL 100 + N0 

4. RET 

Volver a la posición inicial de la macro de llamada 

5. IF <variable> THEN GOTO LABEL <constant> 

Cuando se establezca la condición variable (distinta de 0), salte a la etiqueta 

de posición del programa, de lo contrario, continúe con la siguiente línea de 

instrucciones ETIQUETA 10 

... 

# Cuando la variable (N0 + N1) es igual a 200, salta a la posición de la 

etiqueta 

10 

IF (N0 + N1) == 200 THEN GOTO LABEL 10 

6. IF <variable> THEN DO 

Cuando se establezca la condición variable (distinta de 0), continúe con la 

siguiente línea de instrucciones, de lo contrario, salte al siguiente juicio 

(ELIF) o (ELSE DO) para continuar con la ejecución o ejecute la siguiente 
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línea de instrucciones de ENDIF. IF, ENDIF estructura de soporte hasta 

16 capas. 

# Cuando la variable N0 no sea igual a 100, ejecutar la instrucción de N1 

= 

1000 en la siguiente línea 

IF N0! = 100 THEN DO 

N1 = 1000 

#IF ... THEN DO must be paired with ENDIF 

ENDIF 

7. ENDIF <variable> THEN DO 

Cuando se establezca la condición variable (distinta de 0), continúe con la 

siguiente línea de instrucciones, de lo contrario, salte al siguiente juicio (ELIF) 

o (ELSE DO) para continuar con la ejecución o ejecute la siguiente línea de 

instrucciones en ENDIF. 

#Cuando la variable N0 sea igual a 100, ejecute la instrucción de N1 = 

1000 

#Cuando la variable N0 sea igual a 200, ejecute la instrucción de N1 = 

2000 

IF N0! = 100 THEN DO 

N1 = 1000 

#ELIF must follow the IF THEN DO syntax 

ELIF N0 == 200 THEN DO 

N1 = 2000 

ENDIF 

8. ENDIF 

Con la instrucción IF o ELIF indica la posición a saltar cuando no se establece 

la condición de variable (igual a 0). IF, ENDIF estructura de soporte hasta 16 

capas. 

#Cuando la variable N0 sea igual a 100, ejecutar la instrucción de N1 = 1000 

¡SI NO! = 100 ENTONCES HACERN1 = 1000 

#IF ... THEN DO must be paired with ENDIF 

ENDIF 

9. FOR <variable> 

Bucle de programa, el bucle toma el valor de la variable como un número 

fijo, y el rango del programa es de FOR al programa correspondiente a 

NEXT. 

FOR, NEXT estructura de soporte hasta 16 capas. 

# Calcular el número total de 1 a 10 en la variable N0 

N0 = 0 

N1 = 1 

FOR 10 

N0 + = N1 
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N1 + = 1 

NEXT 

10. NEXT 

Con la instrucción FOR, indica el rango del bucle del programa. FOR, NEXT 

estructura de soporte hasta 16 capas. 

#Calcular el número total de 1 a 10 en la variable N0 

N0 = 0 

N1 = 1 

FOR 50 

N0 + = N1 

N1 + = 1 

NEXT 

11.END 

End macro program 

12. SETB <Bit Variable Position> 

Set bit variables 

#Set the fifth bit of N100 variable to 1 

SETB N100.5 

13. CLRB <Bit Variable Position> Clear bit variables 

#Set the 12th bit of the N10 variable to 0 

CLRB N10.12 

14. INVB <Bit Variable Position> 

Antiphase variable 

#Reverse the 15th position of the N1 variable (0 becomes 1, 1 becomes 

0) INVB N1.15 

11.4 Introducción a la sintaxis del operador macro 

En View Macro, además del uso de instrucciones, hay dos sintaxis 

importantes: la sintaxis del operador y la sintaxis del operador set.. 

11.4.1 Sintaxis del operador 

Proporcionar operaciones matemáticas u operaciones lógicas entre 

variables. Estos símbolos de operación se denominan operandos. Los 

operadores disponibles actualmente se enumeran en la tabla Operadores 

de macros, hay 20 operaciones en total. La expresión se utiliza 

principalmente para establecer la sintaxis de expresión y la sintaxis de 

comando. 

Casos de uso: 

Expresión pura 

(N0 + N1) / 2 

(N0 + 100) 

Collocation operator 
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N0 = (N1 << 2) 

N0 + = (N1 + 2) / 2 

Collocation instruction 

IF (N0 == 100) && (N1 == 200) THEN GOTO LABEL 10 

ENDIF 

CALL (N0+100) 

11.4.2 Establecer la sintaxis del operador 

La sintaxis del operador de configuración es la sintaxis más importante para 

configurar el valor de las variables en los comandos de macro. Este símbolo 

de configuración se denomina operador de configuración. Actualmente hay 11 

tipos de operadores de configuración. Casos de uso: 

N0 = 100 

N0 = (N1 + N2) / 2 

N0 + = 100 

N0 * = 2 

N0 << = 2 

11.4.3 Configuración del formato de datos de datos variables 

Información de variables: las únicas variables que se pueden usar en las 

macros proporcionadas actualmente son las variables del sistema. El formato 

de datos predeterminado de la variable del sistema es un número de símbolo 

de 16 bits. Si necesita otras operaciones de formato, debe agregar la 

configuración de formato de datos. La configuración del formato de datos es 

agregar paréntesis antes de la variable y completar la definición de formato de 

datos entre corchetes. 

Caso: 

# Indica el uso de la operación de número con signo de 32 bits, la posición de 

datos está en  

N0 (INT32S) N0 

11.4.4 Configuración de la configuración del formato de datos para el 

cálculo 

Operación de configuración: cuando la variable establecida necesita 

establecer el formato de datos, el final de la línea de comando variable debe 

establecerse entre paréntesis, y la definición del formato de datos se completa 

entre paréntesis. Por ejemplo, N0 = (INT32S) N100 (INT32S) significa que el 

número de 32 bits con signo N100 se utiliza para el cálculo y el valor de N100 

se establece en el número de 32 bits con signo N0. 

Caso: 

#Bit address and settings 

N0.3 = (BIT) N10.4 && (BIT) N10.5 (BIT) 
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# Si el formato de datos variables de la misma línea es el mismo, solo puede 

configurar el formato de datos de [Establecer cálculo] 

N0.3 = N10.4 && N10.5 (BIT) 

# 32 bit operación de número firmado 

N0 = N2 + N4 (INT32S) 

N0 = N2 + N4 (SIGNED DW) 

# 32-bit floating point arithmetic 

N0 = N2 + N4 (FLOAT) 

Capítulo 12 Función macro 

12.1 Introducción a las funciones de cálculo y sintaxis 

12.1.1 Tabla de columnas de funciones 

Fun. 

Name 
Fun. function 

Return 

value 

Paramet 

er 1 

Para 

meter 

2 

_PI Returns π floating point value 
FLOAT3 

2 

  

_BCD 
Convert BIN values to BCD 

format 
INT32U INT32U 

 

_BIN 
Convert BCD value to BIN 

format value 
INT32U INT32U 

 

_SQRT Square root floating point value 
FLOAT3 

2 

FLOAT3 

2 

 

_LOG 
Natural logarithmic floating 

point value 

FLOAT3 

2 

FLOAT3 

2 

 

_LOG10 Base 10 log floating point value 
FLOAT3 

2 

FLOAT3 

2 

 

_RADIAN 
Convert degrees to radian 

floating point values 

FLOAT3 

2 

FLOAT3 

2 

 

_DEGRE 

E 

Convert radians to degrees 

floating point 

FLOAT3 

2 

FLOAT3 

2 

 

_SIN 
trigonometric function sine 

value floating point value 

FLOAT3 

2 

FLOAT3 

2 

 

_COS 
Trigonometric function cosine 

value floating point value 

FLOAT3 

2 

FLOAT3 

2 

 

_TAN 
Trigonometric function tangent 

floating point value 

FLOAT3 

2 

FLOAT3 

2 

 

_ASIN 
Trigonometric function arc sine 

value floating point value 

FLOAT3 

2 

FLOAT3 

2 

 



Manual de programación de HMI de la serie TK 

 255 
https://coolmay.com.ar 

_ACOS 
Trigonometric function inverse 

cosine floating point value 

FLOAT3 

2 

FLOAT3 

2 

 

_ATAN 
Trigonometric function arc 

tangent floating point value 

FLOAT3 

2 

FLOAT3 

2 

 

_ABS Absolute floating point value 
FLOAT3 

2 

FLOAT3 

2 

 

12.1.2 Introducción a la sintaxis de funciones 

1. Constante de punto flotante 

Establecer directamente constantes de coma flotante en variables  

N0 = 1.2345 (FLOAT32) 2._BCD 

Convierte valores BIN a formato BCD Función 

syntax: INT32U _BCD (INT32U) 

Input data format: INT32U 32-bit unsigned value 

Return data format: INT32U 32-bit unsigned value 

Example: N2 = _BCD (N0) (INT32U) 

3._BIN 

Convertir valor BCD a valor de formato BIN 

Function syntax: INT32U _BIN (INT32U) 

Input data format: INT32U 32-bit unsigned value 

Return data format: INT32U 32-bit unsigned value 

Example: N4 = _BIN (N2) (INT32U)  

4. _SQRT 

Calcule el valor de coma flotante de la raíz cuadrada 

Function syntax: FLOAT32 _SQRT (FLOAT32) 

Input data format: FLOAT32 floating point value 

Return data format: FLOAT32 square root floating point value 

Example: N0 = _SQRT (1.15129) (FLOAT32) # 1.5129 = 1.23 * 1.23 

5. _LOG 

Calcular valores de punto flotante logarítmico natural 

Function syntax: FLOAT32 _LOG (FLOAT32) 

Input data format: FLOAT32 floating point value 

Return data format: FLOAT32 natural logarithmic floating point value 

Example: N0 = _LOG (N2) (FLOAT32) 

6. _LOG10 

Calcular un valor de punto flotante logarítmico con base 10 

Function syntax: FLOAT32 _LOG10 (FLOAT32) 

Input data format: FLOAT32 floating point value 

Return data format: FLOAT32 base 10 logarithmic floating point value 

Example: N0 = _LOG10 (N2) (FLOAT32) 

7. _RADIAN 

Convertir grados a valores de coma flotante en radianes 

Function syntax: FLOAT32 _RADIAN (FLOAT32) 

Input data format: FLOAT32 degree floating point value 
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Return data format: FLOAT32 radian floating point value 

Example: N0 = _RADIAN (N2) (FLOAT32) 

8. _DEGREE 

Convertir radianes a grados punto flotante 

Function syntax: FLOAT32 _DEGREE (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 degree floating point value 

Example: N0 = _DEGREE (N2) (FLOAT32) 

9, _SIN 

Calcular función trigonométrica valor de seno valor de punto flotante 

Function syntax: FLOAT32 _SIN (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 sine floating point value 

Example: N0 = _SIN (N2) (FLOAT32) 

10._COS 

Calcule el valor de coma flotante del coseno de la función 

trigonométrica  

Function syntax: FLOAT32 _COS (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 Cosine floating point value 

Example: N0 = _COS (N2) (FLOAT32) 

11, _TAN 

Calcule el valor de punto flotante tangente de la función 

trigonométrica  

Function syntax: FLOAT32 _TAN (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 tangent floating point value 

Example: N0 = _TAN (N2) (FLOAT32) 

12, _ASIN 

Calcula la función trigonométrica valor arco seno valor punto flotante 

Function syntax: FLOAT32 _ASIN (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 arc sine floating point value 

Example: N0 = _ASIN (N2) (FLOAT32) 

13, _ACOS 

Calcular función trigonométrica valor de coseno inverso valor de coma 

flotante 

Function syntax: FLOAT32 _ACOS (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 arc cosine floating point value 

Example: N0 = _ACOS (N2) (FLOAT32) 

14. _ATAN 

Calcule el valor de coma flotante de la función trigonométrica arco 

tangente  
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Function syntax: FLOAT32 _SIN (FLOAT32) 

Input data format: FLOAT32 radian floating point value 

Return data format: FLOAT32 arc tangent floating point value 

Example: N0 = _ATAN (N2) (FLOAT32) 

15, _ABS 

Calcular el valor de punto flotante de valor absolute 

Function syntax: FLOAT32 _ABS (FLOAT32) 

Input data format: FLOAT32 input calculation floating point value 

Return data format: FLOAT32 absolute value floating point value 

Example: N0 = _ABS (-1.23) (FLOAT32) 

16, _PI 

Devuelve el valor de punto flotante π 

Function syntax: FLOAT32 _PI () 

Input data format: none 

Return data format: FLOAT32 returns π floating point value 

Example: N0 = _PI () (FLOAT32) 

Macro option register 

N65152.0 (bit 0) 

0 = Cuando se establece la variable del controlador, modifique el valor a 

través de la comunicación. 

1 = Cuando se establece la variable del controlador, modifique 

directamente los datos de la memoria HMI y modifique el valor a través de la 

comunicación. 

12.2 Introducción a las funciones relacionadas con el registro 

y la sintaxis 

12.2.1 Lista de funciones de registro 

Fun. Name Function 

_MEMCPY Memory copy 

_MEMCMP Memory comparison 

_MEMSET Memory settings 

_REGCPY Variable area copy 

_REGCMP Variable area comparison 

_REGSET Variable locale 

_MWORD2 

BYTE 

Convert multiple word data to 

multiple bytes 
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_MBYTE2W 

ORD 

Convert multiple bytes of data to 

multiple words 

_RBREAD 
Read the data in the bank 

memory area after power off 

_RBWRITE 
Write data to keep Bank memory 

area after power off 

12.2.2 Introducción a la sintaxis de funciones 

1._MEMCPY 

Copia de memoria: copia datos del área de memoria variable a otra área de 

memoria variable 

INT32S _MEMCPY (INT32S destRegNum, INT32S srcRegNum, INT32S len) 

The use range of destRegNum is 0 ~ 64511 

The use range of srcRegNum is 0 ~ 64511 

len use range is 1 ~ 256 

The returned value indicates the number of bits copied. 0 means the memory 

range is wrong; 1 ~ 256 means the number of copied bits. 

Example 1: 

N100 = _MEMCPY (200, 250, 10) 

It means that 10 BYTEs starting from the N250 variable (that is, 5 variables 

N250-N254) are copied into N200-N204, and the number of copy bits (BYTE) 

10 is placed in N100. 

Example 2: 

N100 = 1000 

N101 = 1500 

N102 = 20 

N500 = _MEMCPY (N100, N101, N102) 

Significa que los 20 BYTE a partir de la variable N1500 (es decir, las 10 

variables N1500-N1509) se copian en el N1000-N1009 y el número de bits 

copiados (BYTE) 20 se coloca en el N500. 

funciones relacionadas 

_MEMCMP, _MEMSET, _REGCPY, _REGCMP, _REGSET 

2. _MEMCMP 

Comparación de memoria: compara el mismo número de bits (BYTE) en el 

área de memoria de 2 variables 

INT32S _MEMCMP (INT32S destRegNum, INT32S srcRegNum, INT32S len) 

The use range of destRegNum is 0 ~ 65535 

The use range of srcRegNum is 0 ~ 65535 

len use range is 1 ~ 256 

El valor devuelto indica el resultado de la comparación. -1 significa que el rango 

de memoria es incorrecto; 0 significa que el contenido de la variable es el 

mismo; 1 significa que el contenido de la variable es diferente. 
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example: 

N100 = _MEMCMP (1000, 2000, 10) 

Compare si los valores de las variables de N1000-N1004 y N2000-

N2004 son iguales. funciones relacionadas 

_MEMCPY, _MEMSET, _REGCPY, _REGCMP, _REGSET 

3._MEMSET 

Configuración de memoria: establezca todos los elementos en un área 

de memoria variable en un valor específico INT32S _MEMSET (INT32U 

regNum, INT32S value, INT32S len) regNum use range is 0 ~ 64511 len 

use range is 1 ~ 256 

El valor devuelto indica el número establecido de bits. 0 significa que el 

rango de memoria es incorrecto; 1 ~ 256 significa el número establecido 

de bits. 

ejemplo: 

N100 = _MEMSET (1000, 55H, 10) 

Establezca el valor de N1000-N1004 en 5555H. (La configuración 

predeterminada es de 8 bits), 

y la variable N es de 16 bits). 

funciones relacionadas 

_MEMCPY, _MEMCMP, _REGCPY, _REGCMP, _REGSET 

4. _REGCPY 

Copia de área variable: copia datos del área de memoria variable a otra área 

de memoria variable 

INT32S _REGCPY (INT32S destRegNum, INT32S srcRegNum, INT32S len) 

El rango de uso de destRegNum es 0 ~ 64511 El rango de uso de srcRegNum 

es 0 ~ 64511 

el rango de uso de len es 1 ~ 256 

El valor devuelto indica el número de variables copiadas. 0 significa que el 

rango de memoria es incorrecto; 1 ~ 256 significa el número de variables 

copiadas. 

Ejemplo 1: 

N100 = _REGCPY (200, 250, 10) 

Copie el valor de la variable N250-250 en la variable N200-N209. 

Ejemplo 2: 

N100 = 1000 

N101 = 1500 

N102 = 20 

N500 = _REGCPY (N100, N101, N102) 

Copie las variables N1500-N1519 a las variables N1000-N1010. 

funciones relacionadas 
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_MEMCPY, _MEMCMP, _MEMSET, _REGCMP, _REGSET 

5. _REGCMP 

Comparación de área de variables: compara un cierto número de 

variables (16 bits) en dos áreas de memoria de variables 

INT32S _REGCMP (INT32S destRegNum, INT32S srcRegNum, INT32S 

len) 

El rango de uso de destRegNum es 0 ~ 65535 El rango de uso de 

srcRegNum es 0 ~ 65535 

el rango de uso de len es 1 ~ 256 

El valor devuelto indica el resultado de la comparación. -1 significa que 

el rango de memoria es incorrecto; 0 significa que el contenido de la 

variable es el mismo; 1 significa que el contenido de la variable es 

diferente. 

ejemplo: 

N100 = _REGCMP (1000, 2000, 10) 

Compare si los valores de las variables de N1000-N1009 y N2000-

N2009 son iguales. funciones relacionadas 

_MEMCPY, _MEMCMP, _MEMSET, _REGCPY, _REGSET 

6. _REGSET 

Configuración de área variable: establezca todas las variables 

en un área de memoria variable en un valor determinado 

INT32S _REGSET (INT32U regNum, INT32S value, INT32S len) 

regNum use range is 0 ~ 64511 len use range is 1 ~ 256 

El valor devuelto indica el número establecido de bits. 0 significa que el rango 

de memoria es incorrecto; 1 ~ 256 significa el número establecido de bits. 

Ejemplo: 

N100 = _REGSET (1000, 1234, 10) 

Set the value of N1000-N1009 to 1234. 

related functions 

_MEMCPY, _MEMCMP, _MEMSET, _REGCPY, _REGCMP 

7. _MWORD2BYTE 

Convertir datos de varias palabras en varios bytes: el valor devuelto indica el 

número de conversions 

INT32U _MWORD2BYTE (INT32S destByteRegNum, INT32S 

srcWordRegNum, INT32S len) 

The use range of destByteRegNum is 0 ~ 64511 

The use range of srcWordRegNum is 0 ~ 64511 

len use range is 1 ~ 256 



Manual de programación de HMI de la serie TK 

 261 
https://coolmay.com.ar 

El valor devuelto indica el número de conversiones. 0 significa que el rango de 

memoria es incorrecto; 1 ~ 256 significa el número de conversiones. 

ejemplo: 

_STRW (N200, "ABCD") 

_MWORD2BYTE (100, 200, 4) 

Results of the 

N100 = 4241H 

N101 = 4443H 

N200 = 0041H 

N201 = 0042H 

N202 = 0043H 

N203 = 0044H 

related functions 

_MBYTE2WORD 

8. _MBYTE2WORD 

Conversión de múltiples bytes de datos a múltiples palabras: el valor 

devuelto indica el número de conversiones 

INT32U __MBYTE2WORD (INT32S destWordRegNum, INT32S 

srcByteRegNum, INT32S len) 

destWordRegNum se usa en el rango de 0 ~ 64511 El rango de uso de 

srcByteRegNum es de 0 ~ 64511 

el rango de uso de len es 1 ~ 256 

El valor devuelto indica el número de conversiones. 0 significa que el 

rango de memoria es incorrecto; 1 ~ 256 significa el número de 

conversiones. 

ejemplo: 

_STRW (N200, "ABCD") 

_MBYTE2WORD (100, 200, 4) 

Results of the 

N100 = 0041H 

N101 = 0042H 

N102 = 0043H 

N103 = 0044H 

N200 = 4241H 

N201 = 4443H 

related functions 

_MWORD2BYTE 

9, _RBREAD 

Lea los datos en el área de la memoria del banco después del apagado: el 

valor de retorno indica el número de registros leídos 

INT32S _RBREAD (INT32S bank, INT32S destRegNum, INT32S scrAddr, 
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INT32S cnt) 

El rango de uso del banco es 0 ~ 6 (actualmente solo abierto 0: Bank0) 

destRegNum el número de la ubicación del registro de destino para leer 

datos scrAddr leer el número de la ubicación de origen del banco 

cnt se puede utilizar en el rango 1 ~ 8192 

Cuando el valor devuelto es 0: significa que el rango de la variable es 

incorrecto o que el modelo operativo no proporciona la memoria del banco 

retentivo de apagado; otros valores leídos representan el número de 

registros leídos. 

Nota: esta función de macro solo es compatible con modelos que 

proporcionan memoria de banco para mantener la alimentación apagada. 

Ejemplo: 

N100 = _RBREAD (0, 1000, 3000, 100) 

Results of the 

N100 = 100 

N1000 ~ N1099 = RBank.3000 ~ RBank.3099 

related functions 

_RBWRITE 

10. _RBWRITE 

Escriba los datos en el área de memoria del banco cuando se apague: el 

valor de retorno indica el número de registros escritos 

INT32S _RBWRITE (INT32S bank, INT32S scrRegNum, INT32S destAddr, 

INT32S cnt) 

El rango de uso del banco es 0 ~ 6 (actualmente solo abierto 0: Bank0) 

ScrRegNum fuente de datos registra el número de ubicación destAddr 

escribe el número de la ubicación de destino en el banco 

cnt se puede utilizar en el rango 1 ~ 8192 

Cuando el valor devuelto es 0: significa que el rango variable es incorrecto o 

que el modelo en ejecución no proporciona la memoria del banco retentivo 

de apagado; otros valores leídos representan el número de registros 

escritos. 

Nota: esta función de macro solo es compatible con modelos que 

proporcionan memoria de banco para mantener la alimentación apagada. 

Ejemplo: 

N100 = _RBWRITE (0, 1000, 3000, 100) 

Resultados de la 

N100 = 100 

RBank.3000 ~ RBank.3099 = N1000 ~ N1099 

funciones relacionadas 

_RBREAD 
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12.3 Introducción a las funciones y sintaxis relacionadas con 

cadenas 

12.3.1 Lista de funciones de cadena 

Name Function 

_STR 
Set ASCII (bit) string to variable 

memory 

_STRW 
Set Unicode (word) character 

string to variable memory 

_STRLEN 
Returns the ASCII (bit) string 

length 

_STRWLEN 
Returns the length of the Unicode 

(word) string 

_STR2DEC 
Convert decimal string to numeric 

value 

_STR2HEX 
Convert hexadecimal string to 

numeric value 

_STR2BIN 
Convert binary string to numeric 

value 

_DECSTR 
Convert numeric value to decimal 

string 

_HEXSTR 
Convert numeric value to 

hexadecimal string 

_BINSTR 
Convert numeric value to binary 

string 

12.3.2 Introducción a la sintaxis de funciones de cadena 

1._STR 
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Establezca la cadena de caracteres ASCII (bit) 

en la memoria variable: escriba ASCII (8 bits) 

cadena de caracteres al área de memoria 

variable  

INT32S _STR (REG reg, STRING str) 

Reg se puede utilizar de N0 a N64511 

Str es una cadena ASCII, la longitud de la cadena es 1 ~ 256 

El valor devuelto indica la longitud del bit, 0 indica que el rango de 

memoria es incorrecto; 1 ~ 256 indica la longitud del bit establecido. Además 

del texto general en formato de cadena, también puede usar el símbolo de 

escape "\" para agregar texto que no sea una cadena. 

Escape 

symbol 
Character value 

"" 22H=34 

\' 27H=39 

\" 22H=34 

\? 3FH=63 

\\ 5CH=92 

\r 0DH=13 

\n 0AH=10 

\000~\777 Octal code character 

\x00~\xFF Hexadecimal code character 

example: 

N100 = _STR (N1000, "ABCD") 

Results of the 

N100 = 5 

N1000 = 4241H // ’BA’ 

N1001 = 4443H // ’CD’ N1002 

= 0000H // End of string 

related functions 

_STRW 

2._STRW 

Establezca la cadena de caracteres Unicode (palabra) 

en la memoria variable: escriba la cadena de 

caracteres Unicode (16 bits) en el área de memoria 

variable 

INT32S _STRW (INT32U regNum, STRING str) 

regNum se puede utilizar en el rango de 0 ~ 64511 

Str es una cadena Unicode, la longitud de la cadena es 

1 ~ 256 
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El valor devuelto indica la longitud del bit, 0 indica que el rango de 

memoria es incorrecto; 1 ~ 256 indica la longitud del bit establecido. Nota: 

Cuando la cadena usa la codificación Unicode, cuando la HMI muestra la 

cadena, la codificación interna es solo los 7 bits inferiores (0-127 fuente en 

inglés) igual que Unicode, por lo que cuando la codificación Unicode excede 

127 en la cadena, la HMI mostrará visualización incorrecta o imposible. 

256 

Ejemplo: 

N100 = _STRW (N1000, "ABCD") 

Results of the 

N100 = 10 

N1000 = 0041H // ’A’ 

N1001 = 0042H // ’B’ 

N1002 = 0043H // ’C’ 

N1003 = 0044H // ’D’ N1004 = 

0000H // End of string related 

functions 

_STR, _STRLEN, _STRWLEN 

3. _STRLEN 

Devuelve la longitud de la cadena ASCII (bit): el valor devuelto representa la 

longitud de la cadena ASCII 

INT32U _STRLEN (INT32S regNum) 

regNum se puede usar en el rango 0 ~ 64383 

El valor devuelto indica la longitud de la cadena de caracteres. 0 indica 

que el rango de la variable es incorrecto o la longitud excede 256 o la 

longitud de la cadena de caracteres es 0; ejemplo: 

_STR (N200, "ABCD") 

N100 = _STRLEN (200) 

Resultados de la 

N100 = 4 

N200 = 4241H 

N201 = 4443H 

related functions 

_STR, _STRW, _STRWLEN 

4. _STRWLEN 

Devuelve la longitud de la cadena Unocode (palabra): el valor devuelto 

representa la longitud de la cadena Unicode 

INT32U _STRWLEN (INT32S regNum) 

regNum puede usar el rango 0 ~ 64255 

El valor devuelto indica la longitud de la cadena, 0 indica que el rango de 

la variable es incorrecto o la longitud supera los 256 o la longitud de la 

cadena es 0; 1 ~ 256 indica la longitud de la cadena. ejemplo: 
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_STRW (N200, "ABCD") 

N100 = _STRWLEN (200) 

Results of the 

N100 = 4 

N200 = 0041H 

N201 = 0042H 

N202 = 0043H 

N203 = 0044H 

related functions 

_STR, _STRW, _STRLEN 

5. _STR2DEC 

Convertir una cadena decimal en un valor numérico: el 

valor de retorno representa el valor numérico convertido 

INT32S _STR2DEC (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango 0 ~ 65535 

cnt puede usar el rango 1 ~ 256 (cuando se excede el 

rango de valores, se producirá un error de 

desbordamiento, lo que dará como resultado un valor 

incorrecto) 

Un valor de retorno de 0 indica que el rango de la variable 

es incorrecto o el valor es 0; otros valores indican el valor 

convertido. 

Ejemplo 1: 

_STRW (N100, "12345") 

N200 = _STRWLEN (100) 

N500 = _STR2DEC (100, N200) 

Results of the 

N100 = 0031H 

N101 = 0032H 

N102 = 0033H 

N103 = 0034H 

N104 = 0035H 

N200 = 5 

N500 = 12345 

Example 2: 

_STRW (N100, "1234567") 

N200 = _STRWLEN (100) 

N500 = _STR2DEC (100, N200) (DW) 

Resultado de la 

N100 = 0031H 

N101 = 0032H 

N102 = 0033H 

N103 = 0034H 
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N104 = 0035H 

N105 = 0036H 

N106 = 0037H 

N200 = 7 

N500 = -10617 

N501 = 18 

Double word N500 = 1234567 

funciones relacionadas 

_STR2HEX, _STR2BIN 

6. _STR2HEX 

Convertir cadena hexadecimal a valor numérico: el valor 

de retorno representa el valor numérico convertido 

INT32S _STR2HEX (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango 0 ~ 65535 

Cnt puede usar el rango 1 ~ 256 (cuando la conversión excede el rango de 

valores, se producirá un error de desbordamiento, lo que dará como resultado 

un valor incorrecto) 

Un valor de retorno de 0 indica que el rango de la variable es incorrecto o el 

valor es 0; otros valores indican el valor convertido. 

Ejemplo 1: 

_STRW (N100, "55AA") 

N200 = _STRWLEN (100) 

N500 = _STR2HEX (100, N200) 

Results of the 

N100 = 0035H 

N101 = 0035H 

N102 = 0041H 

N103 = 0041H 

N200 = 4 

N500 = 55AAH 

Example 2: 

_STRW (N100, "1234567") 

N200 = _STRWLEN (100) 

N500 = _STR2HEX (100, 2) 

Results of the 

N100 = 0031H 

N101 = 0032H 

N102 = 0033H 

N103 = 0034H 

N104 = 0035H 

N105 = 0036H 

N106 = 0037H 

N200 = 7 

N500 = 0012H 
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related functions 

_STR2DEC, _STR2BIN 

7, _STR2BIN 

Convertir una cadena binaria en un valor numérico: el 

valor de retorno representa el valor numérico convertido 

INT32S _STR2BIN (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango 0 ~ 65535 

Cnt puede usar el rango 1 ~ 256 (cuando la conversión 

excede el rango de valores, se producirá un error de 

desbordamiento, lo que dará como resultado un valor 

incorrecto) Las cadenas binarias pueden usar 'H' o '1' 

para representar el valor de 1 

Las cadenas binarias pueden usar 'L' o '0' para 

representar el valor de 0 

Las cadenas binarias pueden usar ':' o '_' para delimitar 

Un valor de retorno de 0 indica que el rango de la variable 

es incorrecto o el valor es 0; otros valores indican el valor 

convertido. 

Ejemplo 1: 

_STRW (N100, "10100000_00000001") 

N200 = _STRWLEN (100) 

N500 = _STR2BIN (100, N200) 

Resultado de la 

N100 ~ N116 = "10100000_00000001" 

N200 = 17 

N500 = A001H  

Ejemplo 2: 

_STRW (N100, "HLHL: LHLH: HHHH: LLLL") 

N200 = _STRWLEN (100) 

N500 = _STR2BIN (100, N200) 

Resultado de la 

N100 ~ N118 = "HLHL: LHLH: HHHH: LLLL" 

N200 = 19 

N500 = A5F0H 

Funciones relacionadas 

_STR2DEC, _STR2HEX 

8. _DECSTR 

Convierta el valor numérico en una cadena decimal: el valor devuelto 

indica la longitud de la cadena convertida 

INT32S _DECSTR (INT32S destRegNum, INT32S data, INT32S format) 

destregNum puede usar el rango 0 ~ 64255 datos El valor convertido 

ingresado 
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El formato convierte el formato del valor. 

0: 8-bit signed number 

1: 8-bit unsigned number 

2: 16-bit signed number 

3: 16-bit unsigned number 

4: 32-bit signed number 

5: 32-bit unsigned number 

Un valor de retorno de 0 indica que el rango de la variable es incorrecto o el 

valor es 0; otros valores indican la longitud de la cadena convertida. 

Ejemplo 1: 

N200 = _DECSTR (100, 12345, 2) 

Results of the 

N100 ~ N104 = ”12345” 

N200 = 5 

Ejemplo 2: 

N200 = _DECSTR (100, -12345, 2) 

Results of the 

N100 ~ N104 = ”-12345” 

N200 = 6 

Funciones relacionadas 

_HEXSTR, _BINSTR 

9. _HEXSTR 

Convierta el valor numérico en una cadena hexadecimal: el valor devuelto 

indica la longitud de la cadena convertida 

INT32S _HEXSTR (INT32S destRegNum, datos INT32S, formato INT32S) 

destregNum puede usar el rango 0 ~ 64255 datos El valor convertido 

ingresado 

El formato convierte el formato del valor. 

0: 8-bit unsigned number, convert string lowercase 0-9, a-f 

1: 8-bit unsigned number, converted string uppercase 0-9, A-F 

2: 16-bit unsigned number, conversion string lowercase 0-9, a-f 

3: 16-bit unsigned number, converted string uppercase 0-9, A-F 

4: 32-bit unsigned number, conversion string lowercase 0-9, a-f 

5: 32-bit unsigned number, converted string uppercase 0-9, A-F 

Un valor de retorno de 0 indica que el rango de la variable es incorrecto o el 

valor es 0; otros valores indican la longitud de la cadena convertida. 

Ejemplo 1: 

N200 = _HEXSTR (100, 0AA55H, 2) 

Results of the 

N100 ~ N103 = ”aa55” 

N200 = 4 

Example 2: 

N200 = _HEXSTR (100, 55AAFF00H, 5) 
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Results of the 

N100 ~ N107 = "55AAFF00" 

N200 = 8 

related functions 

_DECSTR, _BINSTR 

10._BINSTR 

Convierta el valor numérico en una cadena binaria: el valor de retorno 

indica la longitud de la cadena convertida 

INT32S _BINSTR (INT32S destRegNum, INT32S data, INT32S format) 

destregNum puede usar el rango de datos 0 ~ 64255 El valor 

convertido ingresado Formato convierte el formato del valor 

0: 8-bit unsigned number, convert string 0, 1 

1: 8-bit unsigned number, convert character string H, L 

2: 16-bit unsigned number, conversion string 0, 1 

3: 16-bit unsigned number, convert string H, L 

4: 32-bit unsigned number, conversion string 0, 1 

5: 32-bit unsigned number, convert character string H, L 

A return value of 0 indicates that the variable range is incorrect or the value is 

0; other values   indicate the converted string length. 

Example 1: 

N200 = _BINSTR (100, 0AA55H, 2) 

Results of the 

N100 ~ N115 = ”1010101001010101” 

N200 = 16 

Example 2: 

N200 = _BINSTR (100, 55AAFF00H, 5) 

Results of the 

N100 ~ N131 = "LHLHLHLHHLHLHLHLHHHHHHHHLLLLLLLL" 

N200 = 32 

related functions 

_DECSTR, _HEXSTR 

12.4 Introducción al cálculo matemático Funciones 

relacionadas y gramática 

12.4.1 Una tabla de columnas de funciones relacionadas con cálculos 

matemáticos 

Name Function 

_MIN 
Take the minimum of multiple 16-

bit signed numbers 
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_MAX 
Take the maximum of multiple 16-

bit signed numbers 

_AVE 
Take the average of multiple 16-bit 

signed numbers 

_MIND 
Take the minimum of multiple 32-

bit signed numbers 

_MAXD 
Take the maximum of multiple 32-

bit signed numbers 

_AVED 
Take the average of multiple 32-bit 

signed numbers 

_MINF 
Take the minimum of multiple 32-

bit symbol points 

_MAXF Take the maximum of multiple 

 32-bit symbol points 

_AVEF 
Take the average of multiple 32-

bit symbol points 

12.4.2 Introducción al cálculo matemático Sintaxis de funciones 

relacionadas 

1. _MIN 

Tome el valor mínimo de varios números con signo 

de 16 bits: el valor de retorno 

indica el valor mínimo de los múltiples datos  

INT32S _MIN (INT32S regNum, INT32S cnt) 

regNum can be used in the range 0 ~ 65535 

Cnt puede usar el rango 1 ~ 256 

El valor de retorno de 0 significa que el rango de la 

variable es incorrecto o el valor mínimo es 0; otros 

valores son el valor mínimo devuelto. 

Ejemplo: N100 = 156 

N101 = 6578 

N102 = -578 

N103 = 4568 

N200 = _MIN (100, 4) 

Results of the 

N200 = -578 

related functions 

_MAX, _AVE 

2. _MAX 

A Tome el valor máximo de varios números con signo de 16 

bits: el valor de retorno 
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B indica el valor máximo de los datos múltiples INT32S _MAX 

(INT32S regNum, INT32S cnt) regNum puede usarse en el rango 

0 ~ 65535 

C Cnt puede usar el rango 1 ~ 256 

D D valor de retorno de 0 significa que el rango variable es 

incorrecto o el valor máximo es 0; otros valores son el valor 

máximo devuelto. ejemplo: N100 = 156 

N101 = 6578 

N102 = -578 

N103 = 4568 

N200 = _MAX (100, 4) 

Resultado de la 

N200 = 6578 

related functions 

_MIN, _AVE 

3. _AVE 

Tome el promedio de varios números con signo 

de 16 bits: el valor de retorno 

representa el promedio de los múltiples datos 

INT32S _AVE (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango 0 ~ 65535 

Cnt puede usar el rango 1 ~ 256 

el valor de retorno de 0 significa que el rango de la 

variable es incorrecto o el valor máximo es 0; 

otros valores son el valor máximo devuelto. 

ejemplo: N100 = 156 

N101 = 6578 

N102 = -578 

N103 = 4568 

N200 = _AVE (100, 4) 

Results of the 

N200 = 2681 

funciones relacionadas 

_MIN, _MAX 

4. _MIND 

Tome el valor mínimo de varios números con signo de 

32 bits: el valor de retorno 

representa el valor mínimo de los múltiples datos  

INT32S _MIND (INT32S regNum, INT32S cnt) 

regNum can be used in the range 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 
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El valor de retorno de 0 significa que el rango de la variable es 

incorrecto o el valor mínimo es 0; otros valores son el valor mínimo 

devuelto. 

Ejemplo: 

N100 = 1564 (DW) 

N102 = 6573458 (DW) 

N104 = -574358 (DW) 

N106 = 4568 (DW) 

N200 = _MIND (100, 4) (DW) 

Resultado de la 

N200 = -574358 

Funciones 

relacionadas 

_MAXD, _AVED 

5. _MAXD 

Tome el valor máximo de varios números con signo de 

32 bits: el valor de retorno 

indica el valor máximo de los múltiples datos  

INT32S _MAXD (INT32S regNum, INT32S cnt) 

regNum se puede usar en el rango 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 

Un valor de retorno de 0 significa que el rango de la variable es incorrecto o el 

el valor máximo es 0; otros valores son el valor máximo devuelto. ejemplo: 

N100 = 1564 (DW) 

N102 = 6573458 (DW) 

N104 = -574358 (DW) 

N106 = 4568 (DW) 

N200 = _MAXD (100, 4) (DW) 

Resultado de la 

Double word N200 = 6573458 

Funciones relacionadas 

_MIND, _AVED 

6. _AVED 

Tome el promedio de varios números con signo de 32 

bits: el valor de retorno 

representa el promedio de los múltiples datos 

INT32S _AVED (INT32S regNum, INT32S cnt) 

regNum se puede usar en el rango 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 

El número con signo de 32 bits se utiliza para calcular el valor medio. 

Preste atención a si el valor total se desborda. 
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Un valor de retorno de 0,0 significa que el rango de la variable es incorrecto o 

que el valor máximo es 0,0; otros valores son el valor máximo devuelto. 

ejemplo: 

N100 = 1564 (DW) 

N102 = 6573458 (DW) 

N104 = -574358 (DW) 

N106 = 4568 (DW) 

N200 = _AVED (100, 4) (DW) 

Resultado de la 

Double word N200 = 151308 

Funciones relacionadas 

_MIND, _MAXD 

7. _MINF 

Tome el valor mínimo de varios puntos de símbolo de 

32 bits: el valor de retorno 

representa el valor mínimo de los múltiples datos 

INT32S _MINF (INT32S regNum, INT32S cnt) 

regNum se puede usar en el rango 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 

El valor de retorno de 0 significa que el rango de la variable es incorrecto o el 

valor mínimo es 0; otros valores son el valor mínimo devuelto. ejemplo: 

N100 = 15.64 (FLOAT) 

N102 = 6573.458 (FLOAT) 

N104 = -5743.58 (FLOAT) 

N106 = 45.68 (FLOAT) 

N200 = _MINF (100, 4) (FLOAT) 

Resultado de la 

Floating point N200 = -5743.58 

Funciones relacionadas 

_MAXF, _AVEF 

8. _MAXF 

Tome el valor máximo de varios puntos de símbolo de 

32 bits: el valor de retorno indicates the maximum 

value of the multiple data INT32S _MAXF (INT32S 

regNum, INT32S cnt) regNum can be used in the 

range 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 

Un valor de retorno de 0,0 significa que el rango de la variable es 

incorrecto o que el valor máximo es 0,0; otros valores son el valor máximo 

devuelto. 

Ejemplo: 

N100 = 15.64 (FLOAT) 
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N102 = 6573.458 (FLOAT) 

N104 = -5743.58 (FLOAT) 

N106 = 45.68 (FLOAT) 

N200 = _MAXF (100, 4) (FLOAT) 

Resultado de la 

Floating point number N200 = 6573.458 

Funciones relacionadas 

_MINF, _AVEF 

9, _AVEF 

Tome el promedio de varios puntos de símbolo de 32 

bits: el valor devuelto representa el promedio de los 

datos múltiples 

INT32S _AVEF (INT32S regNum, INT32S cnt) 

regNum se puede usar en el rango 0 ~ 65534 

Cnt puede usar el rango 1 ~ 128 

El número con signo de 32 bits se utiliza para calcular 

el valor medio. Preste atención a si el valor total se 

desborda. 

Un valor de retorno de 0,0 significa que el rango de la 

variable es incorrecto o que el valor máximo es 0,0; 

otros valores son el valor máximo devuelto. 

Ejemplo: 

N100 = 15.64 (DW) 

N102 = 6573.458 (DW) 

N104 = -5743.58 (DW) 

N106 = 45.68 (DW) 

N200 = _AVEF (100, 4) (DW) 

Results of the 

Floating point number N200 = 222.8 

related functions 

_MINF, _MAXF 

12.5 Introducción a las funciones relacionadas con el tiempo y 

la sintaxis 

12.5.1 Una columna de funciones relacionadas con el tiempo 

Name Function 

_TICK Get the current time tick value 

_TICK2TIM 

E 

Time tick value conversion to date 

and time data 
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_TIME2TIC 

K 

Conversion of date and time data 

to time tick value 

12.5.2 Introducción a la sintaxis de funciones relacionadas con el tiempo 

1._TICK 

Obtener el valor de marca 

de tiempo actual: el valor 

de retorno indica el valor 

de marca de tiempo 

actual 

INT32U _TICK () 

Parámetro: Ninguno 

Ejemplo: 

N100 = _TICK () (DW) 

N102 = N65448 (DW) // (DW) N65448 has the same function as _TICK 

Resultados de la 

Grupo de palabras dobles 

N100 = 1287635383 // El 

valor varía con el tiempo 

Palabra doble N102 = 

1287635383 

funciones relacionadas 

_TICK2TIME, _TIME2TICK 

2. _TICK2TIME 

Conversión de valor de tick de tiempo a datos de fecha y hora: el valor de 

retorno indica 

si la conversión es exitosa 

INT32U _TICK2TIME (INT32S destRegNum, INT32U marca) 

El rango de destRegNum que se puede usar es 0 ~ 64255. Se requieren 7 

registros de datos para convertir los datos Valor de tick ingresado por tick 

El valor de retorno 0 indica que el rango de la variable es incorrecto o que la 

conversión falla, y 1 indica que la conversión se realizó correctamente. 

Configuración de datos de registro de conversión 

0: sec [0 ~ 59] 

1: min [0 ~ 59] 

2: hour [0 ~ 23] 

3: day [1 ~ 31] 

4: month [1 ~ 12] 

5: year [1970 ~ 2069] 

6: week [0 ~ 6] 

Ejemplo: 
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N100 = _TICK () (INT32U) 

_TICK2TIME (200, (INT32U) N100) 

Resultado de la 

Double word group N100 = 1277639390 // El valor varía con el tiempo. 

N200 = 30 // 30 seconds 

N201 = 36 // 36 minutes 

N202 = 5 // 5 hours 

N203 = 21 // 21st 

N204 = 10 // October 

N205 = 2010 // 2010 

N206 = 4 // Thursday 

related functions 

_TICK, _TIME2TICK 

3. _TIME2TICK 

Los datos de fecha y hora se convierten en valor de marca de tiempo: el valor 

devuelto indica el valor de marca de tiempo 

INT32S _TICK2TICK (INT32S destRegNum) 

El rango de destRegNum que se puede usar es 0 ~ 64255. Se requieren 7 

registros de datos para convertir datos 

El valor devuelto de 0 significa que el rango de la variable es incorrecto o la 

conversión falla, y los otros valores son valores de marca de tiempo. 

Configuración de datos de registro de conversión 

0: sec [0 ~ 59] 

1: min [0 ~ 59] 

2: hour [0 ~ 23] 

3: day [1 ~ 31] 

4: month [1 ~ 12] 

5: year [1970 ~ 2069] 

6: week [0 ~ 6] 

example: 

N200 = 30 // 30 seconds 

N201 = 36 // 36 seconds 

N202 = 5 // 5 hours 

N203 = 21 // 21st 

N204 = 10 // October 

N205 = 2010 // 2010 

N206 = 4 // Thursday 

N100 = _TICK2TICK (200) (INT32U) 

Results of the 

Double word group N100 = 1287639390 // The value varies with time 

related functions 

_TICK, _TIME2TIME 
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12.6 Introducción a funciones y sintaxis de conversión de 

datos 

12.6.1 Lista de funciones de registro 

Name Function 

_HIBYTE 
Variables take high-order 

metadata 

_LOBYTE Variables take low-order metadata 

_HIWORD Variable takes high byte data 

_LOWORD Variables take low byte data 

_SWAPBYT 

E 

Variable high and low bit 

metadata exchange 

_SWAPWO 

RD 

Variable high and low byte data 

exchange 

_BIN2GRAY Convert binary data to Gray code 

_GRAY2BIN 
Gray code conversion into binary 

data 

_MAKEWO 

RD 

Two bits of data combined into 

one word 

_MAKEDW 

ORD 

Two words combined into one 

double word 

12.6.2 Introducción a la sintaxis de funciones 

1._HIBYTE 

Las variables toman metadatos de orden 

superior: el valor devuelto es el metadato de 

orden superior del valor de entrada 

INT32U _HIBYTE (INT32U data) 

Ejemplo: 

N100 = _HIBYTE (1234H) 

Resultado de la 

N100 = 0012H 

Funciones relacionadas 

_LOBYTE, _HIWORD, _LOWORD, _MAKEWORD, _MAKEDWORD 

2._LOBYTE 

Las variables toman metadatos de orden 

inferior: el valor devuelto es el metadato de 

orden superior del valor de entrada 

INT32U _LOBYTE (INT32U data) 

Ejemplo: 
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N100 = _LOBYTE (1234H) 

Resultado de la 

N100 = 0034H 

Funciones relacionadas 

_HIBYTE, _HIWORD, _LOWORD, _MAKEWORD, _MAKEDWORD 

3. _HIWORD 

La variable toma datos de byte alto: el 

valor devuelto es el dato de byte alto del valor 

de entrada 

INT32U _HIWORD (INT32U data) 

Ejemplo: 

N100 = _HIWORD (12345678H) 

Resultado de la 

N100 = 1234H 

Funciones relacionadas 

_HIBYTE, _LOBYTE, _LOWORD, _MAKEWORD, _MAKEDWORD 

4. _LOWORD 

La variable toma datos de byte alto: el valor 

devuelto es el dato de byte alto del valor de 

entrada 

INT32U _LOWORD (INT32U data) 

Ejemplo: 

N100 = _LOWORD (12345678H) 

Resultado de la 

N100 = 5678H 

Funciones relacionadas 

_HIBYTE, _LOBYTE, _HIWORD, _MAKEWORD, _MAKEDWORD 

5. _SWAPBYTE 

Intercambio de datos de bit alto y bajo variable: 

el valor de retorno son los datos después del 

intercambio de bits altos y bajos del valor de 

entrada  

INT32U _SWAPBYTE (INT32U data) Ejemplo: 

N100 = _SWAPBYTE (1234H) 

Resultado de la 

N100 = 3412H 

Funciones relacionadas 

_HIBYTE, _LOBYTE, _HIWORD, _LOWORD, _MAKEWORD, 

_MAKEDWORD, _SWAPWORD 

6. _SWAPWORD 
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Intercambio de datos de bit alto y bajo variable: el valor de retorno son los 

datos después del 

intercambio de bits altos y bajos del valor de entrada  

INT32U _SWAPWORD (INT32U data) 

Ejemplo: 

N100 = _SWAPWORD (12345678H) 

Results of the 

N100 = 1234H 

N101 = 5678H 

Funciones relacionadas 

_HIBYTE, _LOBYTE, _HIWORD, _LOWORD, _MAKEWORD, 

_MAKEDWORD, _SWAPBYTE 

7, _BIN2GRAY 

Convertir datos binarios a código Gray: devuelve los datos binarios cuyo 

valor de entrada se convierte a código Gray INT32U _BIN2GRAY (INT32U 

data) Ejemplo: 

N100 = _BIN2GRAY (55555555H) (DW) 

Results of the 

N100 = FFFFH 

N101 = 7FFFH 

Funciones relacionadas 

_GRAY2BIN 

8. _GRAY2BIN 

Conversión de código gris a datos binarios: los datos de código gris cuyo 

valor de retorno es el valor de entrada se convierten en datos binarios 

INT32U _GRAY2BIN (INT32U data) Ejemplo: 

N100 = _GRAY2BIN (7FFFFFFFH) (DW) 

Resultado de la 

N100 = 5555H 

N101 = 5555H 

Funciones relacionadas 

_BIN2GRAY 

9. _MAKEWORD 

Dos bits de datos combinados en una palabra: el valor de retorno 

son los datos combinados en una palabra 

INT32U _MAKEWORD (INT32U hiData, INT32U loData) 

Ejemplo: 

N100 = _MAKEWORD (12H, 34H) 

Resultados de la 

N100 = 1234H 

Funciones relacionadas 
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_MAKEDWORD 

10. _MAKEDWORD 

11. Dos palabras combinadas en una palabra doble: el 

valor de retorno son los datos combinados en una palabra 

doble 

12. INT32U _MAKEDWORD (INT32U hiData, INT32U 

loData) Ejemplo: 

N100 = _MAKEDWORD (1234H, 5678H) 

Resultados de la 

N100 = 1234H 

N101 = 5678H 

Funciones relacionadas 

_MAKEWORD 

12.7 Introducción a funciones y sintaxis relacionadas con el 

código de verificación de cálculo 

12.7.1 Funciones relacionadas con la tabla de columnas del código de 

verificación de cálculo 

Name Function 

_REGLRC 

Uso del método LRC para calcular el 

código de verificación del área 

variable 

_REGCRC1 

6 

Use el método CRC16 para calcular 

el código de verificación de región 

variable 

_REGCRC3 

2 

Use el método CRC32 para calcular 

el código de verificación de región 

variable 

_REGCCITT 

Utilice el método CCITT para calcular 

el código de verificación del área 

variable 

_REGBCC 

Use el método BCC para calcular el 

código de verificación del área 

variable 

_REGBCC2 

Use el método de complemento de 

BCC para calcular el código de 

verificación del área variable 



 Manual de programación de HMI de la serie TK 

 282  
https://coolmay.com.ar/ 

12.7.2 Introducción a la sintaxis de la función relacionada con el 

cálculo 

Código de verificación 

1._REGLRC 

Utilice el método LRC para calcular el código de 

verificación del área variable: el valor de retorno es el valor del 

código de verificación LRC 

INT32S _REGLRC (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango de 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor devuelto 0 indica que la variable es incorrecta o el valor es 0, y los 

otros valores son los valores del código de verificación LRC. 

Ejemplo: 

_STRW (N100, "1234") 

N200 = _REGLRC (100, 4) 

Resultados de la 

N100 = 0041H 

N101 = 0042H 

N102 = 0043H 

N103 = 0044H 

N104 = 0000H 

N200 = 202 // 202 = 0CAH 

Funciones relacionadas 

_REGCRC16, _REGCRC32, _REGCCITT, _REGBCC, _REGBCC2 

2. _REGCRC16 

Use el método CRC16 para calcular el código de 

verificación del área variable: el valor de retorno es 

el valor del código de verificación CRC16 

INT32S _REGCRC16 (INT32S regNum, INT32S cnt) 

CRC16 algorithm (X16 + X15 + X2 + 1) regNum se 

puede utilizar en el rango de 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor devuelto de 0 significa que la variable es incorrecta o el valor 

es 0, y los otros valores son los valores del código de verificación 

CRC16. 

Ejemplo:_STRW (N100, "1234") 

N200 = _REGCRC16 (100, 4) 

Results of the 

N100 = 0041H 

N101 = 0042H 

N102 = 0043H 

N103 = 0044H 
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N104 = 0000H 

N200 = 30BAH 

Funciones relacionadas 

_REGLRC, _REGCRC32, _REGCCITT, _REGBCC, _REGBCC2 

3. _REGCRC32 

Utilice el método CRC32 para calcular el código de verificación del área 

variable: el valor devuelto es el valor del código de verificación 

CRC32INT32S _REGCRC32 (INT32S regNum, INT32S cnt) 

CRC32 algoritmo 

(X32 + X26 + X23 + X22 + X16 + X12 + X11 + X10 + X8 + X7 + X5 + X4 + 

X2 + X1 + 1) regNum se puede utilizar en el 

rango de 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor devuelto de 0 significa que la variable es incorrecta o el valor es 0, y 

los otros valores son los valores del código de verificación CRC32. 

ejemplo: 

_STRW (N100, "1234") 

N200 = _REGCRC32 (100, 4) (DW) 

Results of the 

N100 = 0041H 

N101 = 0042H 

N102 = 0043H 

N103 = 0044H 

N104 = 0000H 

Double word N200 = 09BE3E0A3H 

Funciones relacionadas 

_REGLRC, _REGCRC16, _REGCCITT, _REGBCC, _REGBCC2 

4. _REGCCITT 

Utilice el método CCITT para calcular el código de 

verificación de área variable: el valor de retorno indica el 

valor del código de verificación CCITT 

INT32S _REGCCITT (INT32S regNum, INT32S cnt) CRC-

CCITT algoritmo (X ^ 16 + X ^ 12 + X ^ 5 + 1) regNum can 

be used in the range of 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor de retorno 0 indica que la variable es incorrecta o el valor es 0, y los 

otros valores son los valores del código de verificación CCITT. 

ejemplo: 

_STRW (N100, "1234") 

N200 = _REGCCITT (100, 4) 

Resultado de 

N100 = 0041H 
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N101 = 0042H 

N102 = 0043H 

N103 = 0044H 

N104 = 0000H 

N200 = 9741H 

Funciones relacionadas 

_REGLRC, _REGCRC16, _REGCRC32, _REGBCC, _REGBCC2 

5. _REGBCC 

Use el método BCC para calcular el código de verificación del área variable: 

el valor devuelto indica el valor del código de verificación BCC INT32S 

_REGBCC (INT32S regNum, INT32S cnt) regNum se puede usar en el 

rango de 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor devuelto de 0 significa que la variable es incorrecta o el valor es 0, 

y los otros valores son los valores del código de verificación BCC. ejemplo: 

_STRW (N100, "1234") 

N200 = _REGBCC (100, 4) 

Results of the 

N100 = 0041H 

N101 = 0042H 

N102 = 0043H 

N103 = 0044H 

N104 = 0000H 

N200 = 0004H 

Funciones relacionadas 

_REGLRC, _REGCRC16, _REGCRC32, _REGCCITT, _REGBCC2 

6. _REGBCC2 

Use el método de complemento de BCC para calcular el 

código de verificación de área variable: el valor devuelto es 

el valor del código de verificación de complemento de BCC 

INT32S _REGBCC2 (INT32S regNum, INT32S cnt) 

regNum se puede utilizar en el rango de 0 ~ 65535 

Cnt se puede utilizar en el rango de 1 ~ 256 

El valor devuelto de 0 significa que la variable es incorrecta 

o el valor es 0, y los otros valores son los valores del 

código de verificación BCC. 

ejemplo: 

_STRW (N100, "1234") 

N200 = _REGBCC2 (100, 4) 

Resultados de la 

N100 = 0041H 

N101 = 0042H 
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N102 = 0043H 

N103 = 0044H 

N104 = 0000H 

N200 = 00FBH 

Funciones relacionadas 

_REGLRC, _REGCRC16, _REGCRC32, _REGCCITT, _REGBCC 

12.8 Introducción a las funciones relacionadas con la 

comunicación y la sintaxis 

12.8.1 Una tabla de columnas de funciones relacionadas con la 

comunicación 

Name Function 

_LWRITE 
Data is sent through the 

communication port 

12.8.2 Introducción a la sintaxis de funciones relacionadas con la 

comunicación 

1._LWRITE 

Los datos se envían a través del puerto de comunicación: el valor de 

retorno indica si el envío se completó 

INT32S _LWRITE (INT32S handle, INT32S regNum, INT32S cnt) 

Valor de operación de la conexión de comunicación del identificador (El 

identificador se muestra después del parámetro [Administración de enlaces] en 

la ventana Administración de enlaces)

 

regNum fuente de datos número de dirección de registro 

Cnt puede usar el rango 1 ~ 256 

El valor de retorno 0 significa que el rango de la variable es incorrecto o 

el identificador es incorrecto o hay un problema con el desarrollo. 

ejemplo: 

_STR (1000, "A0 = 1234 \ r \ n") 

N100 = _STRLEN (1000) 

N101 = _LWRITE (0, 1000, N100) 
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Resultados de la 

La cadena de caracteres se envía a través del puerto de comunicación. "A0 

= 1234 \ r \ n" 

N100 = 9 

N101 = 1 

Chapter 13 Description of Macro Communication 

Protocol 

Recibir datos y enviar datos es de hasta 253 bytes (Byte). 

N63744 [0xf900] Longitud de los datos recibidos (BYTE). (0 ~ 253) 

N63745 ~ N63871 Datos recibidos Los datos recibidos se almacenan desde 

el byte inferior, es decir, el primer BYTE almacena los 8 bits inferiores de 

N63745, el segundo BYTE almacena los 8 bits superiores de N63745, y así 

sucesivamente. 

Cuando el sistema recibe los datos del puerto de comunicación, almacenará 

los datos en secuencia en N63745 y almacenará la cantidad de bytes 

recibidos en N63744. 

N63872 [0xf980] Longitud de los datos a transmitir (BYTE). (0 ~ 253) 

N63873 ~ N63999 Datos transmitidos Los datos transmitidos se almacenan 

desde el byte inferior, es decir, el primer BYTE almacena los 8 bits inferiores 

de N63873, el segundo BYTE almacena los 8 bits superiores de N63873, y así 

sucesivamente. 

Cuando el sistema reconoce que N63872 es mayor que 0 y menor que 254, 

comenzará a transmitir los datos en la posición variable de N63873 al número 

de bytes registrados por N63872. Comandos enviados dos veces. (Cuando los 

datos se envían al búfer de comunicación, el sistema enviará secuencialmente 

los datos al puerto de comunicación correspondiente) 

Nota: El protocolo de comunicación Macro no admite el uso simultáneo 

de varios puertos de comunicación. 

Apéndice 1 Definición del teclado de edición de 

proyectos mView 

keyboard action remark 

Ctrl+Z Deshacer la última acción  

Ctrl+Shift+Z Deshacer última acción  

Ctrl+X Corte  

Ctrl+C Copiar  

Ctrl+M Copia múltiple  
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Ctrl+V pegar  

Ctrl+Del Eliminar  

Del Eliminar  

Ctrl+A seleccionar todo  

Up Ajuste fino de 

componentes 

 

Down Ajuste fino de 

componentes 

 

Left 

Ajuste fino de 

componentes a la 

izquierda 

 

Right 
Componentes ajustados a 

la derecha 

 

Shift+Up 
El componente sube una 

cuadrícula. 

 

Shift+Down 
Mover el componente 

hacia abajo una cuadrícula 

 

Shift+Left 
Mover el componente un 

cuadro a la izquierda 

 

Shift+Right 
Mover el componente un 

espacio a la derecha 

 

Ctrl+Up 
Reducción de la altura del 

componente en uno. 

 

Ctrl+Down 
Aumente la altura del 

componente en uno 

 

Ctrl+Left 
Ancho del componente 

menos uno 

 

Ctrl+Right 
Aumente el ancho del 

componente en uno 

 

ESC cancelar selección  

G Grupo  

U Desagrupar  

 

I pantalla ampliada  

O Disminuir el zoom  

L elemento fijo  
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Space Editar símbolo  

F4 Mostrar el orden de los 

componentes 

 

Shift+F4 Mostrar nombre del 

componente 

 

F5 Mostrar variables (simple)  

Shift+F5 Mostrar variables (general)  

F6 

Mostrar solo información 

sobre los componentes 

seleccionados 

 

F8 Chequeo de gramática  

F9 Ejecución en línea  

Shift+F9 ejecución fuera de línea  

Ctrl+F9 Deténgase  

Ctrl+Alt+S Descargar a HMI  

Shift+"+" 
Cambiar el orden de los 

componentes (hacia arriba) 

 

Shift+"-" 
Cambiar el orden de los 

componentes (hacia abajo) 

 

"+" 

Cambiar el orden de los 

componentes (hasta una 

capa) 

 

"-" 

Cambiar el orden de los 

componentes (retroceder 

una capa) 

 

Apéndice 2 Lista de variables predefinidas del 

sistema mView 

El rango variable disponible para el usuario es N0~N65023, y el rango de 

registro para interrupción de energía es N49152~N61439 (se ampliará a 

N32768~N49151 en el futuro). Tenga en cuenta que las variables después de 

N65024 son para uso del sistema y los usuarios no pueden personalizarlas. 

1 Variables preestablecidas del sistema 

Apagado remanente 
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No. data Explanation 
Default 

value 

Read 

and 

write 

N65024 
Brillo de la 

pantalla 
0...100 70 R/W 

N65025 
Comparación de 

pantalla 
0...100 50 R/W 

N65026 Temporizador de 

retroiluminación 

Unit: second ， 30...65535 ，

65535=off 

65535 R/W 

N65027 volumen 0...100 100 R/W 

N65028 
LED de 

alimentación 
0=flash，1=stop 0 R/W 

N65029 
indicación de 

estado 
0=off，1=on 0 R/W 

N65030 Interruptor 

generador de 

señal 

65535=off 0 R/W 

N65031 
Índice de sonido 

clave 
65535=off 1 R/W 

N65040 Índice de sonido 

del cuadro de 

diálogo 

65535=off 65535 R/W 

N65041 
Auxiliar de cursor  

0 R/W 

N65044 

Máscara de 

cuadro de 

diálogo 

Use dialog mask 

0X0001, 0X0002 omit the 

background picture 

1 R/W 

N65048 

Tasa de aumento 

del brillo de la 

pantalla 

1...20 10 R/W 

N65049 

Tasa de 

reducción del 

brillo de la 

pantalla 

1...20 2 R/W 

N65050 

Relación de 

ahorro de 

energía de 

retroiluminación 

0...100 0 R/W 

 

N65056 Zona horaria -32768...32767 0  
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N65072 

El puerto Com 1 

está conectado a 

eléctrico 

0-auto recognition 

RS232/RS422/RS485 

1-RS232 

2-RS422 

3-RS485 

0 

 

N65073 

Puerto de 

comunicación 1 

comunicación 

Velocidad 

0-150,3-1200,6-9600,9-57600, 

1-300,4-2400,7-19200,10-115200, 

2-600,5-4800,8-38400, 
10 

 

N65074 

Datos del puerto 

COM 1 

 

0 - 5bit，1 - 6bit， 

2 - 7bit，3 - 8bit 3 

 

N65075 

Comprobación 

del puerto 1 

 

0 - None，1 - Odd parity， 

2 - Even parity， 3 - mark， 4 - 

Space 

0 

 

N65076 

Puerto Com 1 

parada 

 

0 - 1bit，1 - 2bit， 0 

 

N65077 Retardo puerto 

COM 1 

Unit: ms 20  

N65078 

Puerto de 

comunicación 1 

ajuste de tiempo 

de espera 

Unit: millisecond, minimum value 

1000 
1000 

 

N65080 

Puerto COM 2 

conectado a 

eléctrico 

Setting as N65072 0 

 

N65081 

Puerto de 

comunicación 2 

Velocidad de 

comunicación 

Setting as N65073 10 

 

N65082 
Datos del puerto 

COM 2 
Setting as N65074 3 

 

N65083 
Comprobacion 

del puerto COM 2 
Setting as N65075 0 

 

N65084 
Bit de stop del 

puerto COM 2 
Setting as N65076 0 

 

N65085 Retardo del 

puerto COM 2 

Unit: ms 20  

N65086 

Com port 2 

Ajuste de tiempo 

de espera 

Unit: millisecond, minimum value 

1000 1000 
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N65088 

Com port 3 

conectado 

electrico 

Setting as N65072 0 

 

N65089 

Com port 3 

Velocidad de 

comunicacion 

Setting as N65073 10 

 

N65090 
Com port 3 bit de 

datos 
Setting as N65074 3 

 

N65091 
Com port 3 bit de 

comprobacion 
Setting as N65075 0 

 

 

N65092 
Com port 3 Bit de 

stop 
Setting as N65076 0 

 

N65093 Com port 3 

Retardo 

Unit: ms 20  

N65094 
Com port 3 

Ajuste de tiempo 

Unit: millisecond, minimum value 

1000 
1000 

 

N65096 

Puerto COM 4 

conectado a 

eléctrico 

Setting as N65072 0 

 

N65097 

Com port 4 

Velocidad de 

comunicacion 

Setting as N65073 10 

 

N65098 
Com port 4 data 

bits 
Setting as N65074 3 

 

N65099 
Com port 4 bit de 

control 
Setting as N65075 0 

 

N65100 
Com port 4 bit de 

stop 
Setting as N65076 0 

 

N65101 Com port 4 

retardo 

Unit: ms 20  

N65102 

Com port 4 ajuste 

de tiempo de 

espera 

Unit: millisecond, minimum value 

1000 1000 

 

N65104 
Ajuste de tiempo 

de parpadeo 1 
Unit: ms 1000 

 

N65105 
Ajuste de tiempo 

de parpadeo 2 
Unit: ms 500 

 

N65106 
Ajuste de tiempo 

de parpadeo 3 
Unit: ms 200 
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N65107 
Ajuste de tiempo 

de parpadeo 4 
Unit: ms 100 

 

N65112 

Efecto de entrada 

de cuadro de 

diálogo 

0=off，1=on. 1 

 

N65116 

Visualización de 

activación de 

componentes 

0: Visualización normal, 

1: Cuando no se establece la 

condición de habilitación, el 

símbolo [Prohibición] se muestra 

en la parte superior izquierda. 

2: cuando no se establece la 

condición de habilitación, el 

módulo establece el patrón de 

protección del tipo de red 

  

N65120 RFID_MODE 
RFID reading mode 0=Read UID, 

1=Read UID+IID, 2=Write IID 

  

N65128 

MODBUS 

número de 

estación esclava 

   

N65137 Idioma de la 

pantalla 

Bit0=1: Record the current   

 Opciones language   

N65152 Opciones de 

Macros 

   

N65168 
Ajustar la altura 

de la columna 

   

N65264 último estado de 

arranque 

0=Normal，！=0 wrong 0  

Working temporary register(R/W) 

No. Data Explanation 
Read/ 

write 

N65280 
Calendario perpetuo-

Año 
1960...2059 R/W 

N65281 
Calendario perpetuo-

mes 
1...12 R/W 

N65282 
Calendario perpetuo-

dia 
1...31 R/W 

N65283 
Calendario perpetuo-

hora 
0...23 R/W 

N65284 
Calendario perpetuo-

minuto 
0...59 R/W 
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N65285 
Calendario perpetuo-

segundo 
0...59 R/W 

N65286 
Calendario perpetuo-

semana 

0...6， 

0-Sunday， 

6=Saturday 

R/W 

N65287 Tiempo de 

retroiluminación 

actual 

0...65535 R/W 

N65288 resultado del cuadro 

de diálogo 

 R/W 

N65289 
Formato de datos del 

cuadro de diálogo 

 
R/W 

N65290 
Punto decimal del 

cuadro de diálogo 

 
R/W 

N65291 
Número de cuadros 

de diálogo 

 
R/W 

N65292 

Número máximo de 

texto en el cuadro de 

diálogo 

 

R/W 

N65293 
Borrar el botón del 

cuadro de diálogo 

0X8000(Loop 

input0X00FF) 
R/W 

N65294-N652 

95 

Texto de diálogo  
R/W 

N65296-N653 

27 

Texto del cuadro de 

diálogo 

 
R/W 

N65328-N653 

29 

Introduzca el valor 

máximo 

 
R/W 

N65330-N653 

31 

Introduzca el valor 

mínimo 

 
R/W 

N65332 

Cuadro de diálogo de 

derecho a usar 

contraseña 

 

R/W 

N65340 Derechos de usuario 

actuales 

1...31 R/W 

N65341 ID de usuario actual 1...15 R/W 

N65342 
Índice de idioma de 

la pantalla actual 
0...n R/W 

N65343 ID de pantalla actual 1...n R/W 

N65344 Estado clave actual 0...3 R/W 

N65345 Inhabilitar entrada  R/W 
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N65347 
registro de control Bit=0Update the current 

backlight timing 
R/W 

N65360-N653 

75 

Entrada de cuadro de 

diálogo máx. 
Display data format2：-A R/W 

N65376-N653 

91 

cuerda 
Display data format2：-A R/W 

Working read-only register 

No. Data Explanation 
Read/ 

wirte 

N65408 Modelo HMI 0X5000 R 

N65409 Versión del sistema 

operativo 

 R 

N65410 ancho de pantalla 320 R 

N65411 altura de la pantalla 240 R 

N65412 color de pantalla 1/4/8/16 R 

N65413 tamaño de pantalla 5700 R 

N65414 Producto número 1  R 

N65415 Producto número 2  R 

N65422 Tiempo de 

actualización de 

pantalla 

Unit: ms R 

N65423 
Actualizaciones de 

imagen por segundo 

 
R 

N65424 Tasa de uso de la 

CPU 

0...100 R 

N65430 

Tipo de información 

de ocurrencia de 

alarma 

0...2 R 

N65431 

Capacidad de 

almacenamiento de 

alarmas 

 

R 

N65432 Número de alarmas  R 

N65440 

Número de 

información del 

sistema 

 

R 

N65448-N6544 

9 
Hora TICK 

 
R 
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N65456-N6546 

3 

nombre de protocolo 

del puerto com 1 

Display format 1-BA display 

length 16 
R 

N65464-N6547 

1 

nombre de protocolo 

del puerto com 2 

Display format 1-BA display 

length 16 
R 

N65472-N6547 

9 

nombre de protocolo 

del puerto com 3 

Display format 1-BA display 

length 16 
R 

N65480-N6548 

7 

nombre de protocolo 

del puerto com 4 

Display format 1-BA display 

length 16 
R 

N65488 

COM1Número de 

escribir búferes 

 

At present, each COM port has 32 

write buffers R 

N65489 
COM2Número de 

escribir búferes 

At present, each COM port has 32 

write buffers 
R 

N65504 Generador de 

señal1 

[0...359] R 

N65505 Generador de 

señal2 

[0...99] R 

N65506 Generador de 

señal3 

[0...11] R 

N65507 Generador de 

señal4 

[0...59] R 

N65508 Generador de 

señal5 

Sine wave[0...327687] R 

N65509 Generador de 

señales6 

Sawtooth wave[0...327687] R 

N65510 Generador de 

señales7 

Triangle wave[0...327687] R 

N65511 Generador de 

señales8 

Square wave[0...327687] R 

N65528 

Alarma de 

comunicación 

anormal 

Bit0=COM1,Bit1=COM2. R 

N65529 

Estado del tiempo 

de arranque 

Bit0 = 1 after booting, Bit1 = 1 

after 1 second, 

Bit15 = 1 at the 15th second. 

R 

2 El uso de la variable de puntero interno V 

El puntero V y la variable N aparecen en pares, y la relación fija es la siguiente
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En mView, la relación entre el puntero de la variable interna V y la variable 

N es de uno a uno. Al usarlo, debe seguir la relación correspondiente en la tabla 

anterior. Si usa V0, el otro necesita usar N0, y así sucesivamente... 

Entre ellos, el valor de N representa la dirección que apunta al registro, y 

el valor de V representa el valor del registro al que apunta N; por ejemplo: 

use el grupo N0 y V0 para la indexación, N0=100, N100=255, luego 

V0=255. 

Ejemplos de asignación por lotes: 

N0=10 

FOR 61430 

V0=555(INT16U) 

N0+=1(INT16U) 

NEXT 

END 

Análisis: N0=10, el registro que especifica el inicio del índice es N10; 

V0=555, especifique el valor a transmitir, es decir, N10=V0=555; Utilice el 

programa de bucle FOR para asignar todos los valores de 555 a N10-N61439.
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Apéndice 3 Tabla de frecuencias de la escala mView 

scale Octave0 Octave1 Octave2 Octave3 

Do 
C 262 523 1047 2093 

Db 277 554 1109 2217 

Re 
Db 294 587 1175 2349 

Eb 311 622 1245 2489 

Mi Eb 330 659 1329 2637 

Fa 
F 349 698 1397 2794 

Gb 370 740 1480 2960 

Sol 
G 392 784 1568 3136 

Ab 415 831 1661 3322 

La 
A 440 880 1760 3520 

Bb 466 923 1865 3729 

Si B 494 988 1976 3951 
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Apéndice 4 Instrucciones para el uso de variables de 

operación 
Variable de operación 

Significa que la ubicación general de la fuente de datos numéricos se puede 

establecer mediante el cálculo entre variables. 

En este software, si aparece un icono pequeño en el lado derecho del cuadro 

de edición para la posición de la variable de entrada, significa que la posición 

de entrada de la variable puede usar variables aritméticas. Como se muestra 

abajo:

 

Los símbolos operativos que se pueden utilizar se muestran en la siguiente 

tabla 

Categoría de 

operación 
Operacion Simbolo Caso Observaciones 

|computation 

suma + D100 + 

D101 

 

Sustracción - D100 - 

D101 

 

multiplicación * D100 * 

D101 

 

Division / D100 / 

D101 

 

Porcentaje % D100 % 

D101 
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Numeros negativos 
- -D101 

 

Bit operation 

and & D100 & 

D101 

 

XOR ^ D100 ^ 

D101 

 

or | D100 | 

D101 

 

Shift left << D100 << 

D101 

 

Right shift >> D100 >> 

D101 

 

 Negate ~ ~D100  

Relational 

operation 

Igual a == D100 == 

D101 

 

Distinto a != D100 != 

D101 

 

Menor que < D100 < 

D101 

 

Menor o igual que <= D100 <= 

D101 

 

Mayor que > D100 > 

D101 

 

Mayor o igual que >= D100 >= 

D101 

 

Operación logica 

Logical OR || D100 || 

D101 

 

Logical AND && 
D100 && 

D101 

 

Logical inverse ! !D100  

En la tabla de arriba: 

D100 y D101 se refieren a variables en el PLC (controlador). 

Los operadores se pueden usar juntos, por ejemplo ((D100 + D101) / 2) == 

100 

Para aumentar la comodidad de lectura, cuando el operador ocupa un bit, 

se puede insertar un espacio entre la variable y el operador. Sin embargo, 

cuando el operador ocupa dos bits, no se puede agregar espacio entre los 

operadores, como se explica a continuación: 

D100 + D101 se puede escribir: D100 + D101 

D100 <= D101 La verificación de sintaxis es correcta aquí 
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D100 <= D101 La verificación de sintaxis es incorrecta aquí porque el 

operador <= tiene un carácter en blanco en el medio. 

Definición de constante 

tipo 

constante 
Definición descripción Caso 

Decimal Number0~9 123 or 100000 

Hex 

Números 0 ~ 9, letras inglesas A ~ F, la última 

palabra es 'H', pero la primera palabra no debe 

ser una letra, debe ser un número 

100H or 

1234H or 

0ABCDH 

Cases 

Variable de operación Explicación 

(D0+D1+D2+D3+D4)/5 Tome el promedio de D0 a D4 

(D0+1234)/1000 Multiplica D0 por 1.234 

(D0==100H)||(D1==200H 

) 

Cuando D0 es igual a 100 en hexadecimal o D1 es igual 

a 200 en hexadecimal, el valor es 1, de lo contrario el valor 

es 0. 

D0>D1 
Cuando D0 es mayor que D1, el valor es 1, de lo 

contrario, el valor es 0 

(D0<=D1) && (D0==100) 
Cuando D0 es menor que D1 y D0 es igual a 100, el 

valor es 1, de lo contrario, el valor es 0. 

 

D0 & D1 

D0 = [Binary] 0000000000001111-> Decimal = 15 

D1 = [Binary] 0000000000010001-> Decimal = 17 

D0 & D1 = [Binary] 0000000000000001-> Decimal = 1 

D0 << 2 
D0 = [Binary] 0000000000001111-> Decimal = 15 

D0 << 2 = [Binary] 0000000000111100-> Decimal = 60 
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Apéndice 5 Descripción de funciones de múltiples 

máquinas inteligentes conectadas de HMI 
En la actualidad, más usuarios tendrán cada vez más dispositivos conectados 

a la HMI. Un RS485 se puede conectar a varios controladores. Bajo esta 

estructura, el software puede distinguir cada controlador por número de 

estación al diseñar la etapa del programa HMI, para que la HMI pueda leer los 

datos de cada controlador conectado. Cuando cada controlador funciona 

normalmente, la comunicación funcionará normalmente. 

Sin embargo, en algunos casos de uso, no todos los controladores conectados 

deben estar encendidos, lo que hará que la HMI siempre intente conectarse 

con el controlador que no está encendido durante la comunicación, lo que 

afectará la velocidad de comunicación general. 

Cuando diseñamos el software, agregamos la función [múltiples máquinas 

conectadas inteligentemente] en el software HMI, y la página de configuración 

se muestra en la siguiente figura:

 

La función [Multi-Station Smart Link] básicamente registra el estado de 

conexión de cada controlador para ajustar los parámetros de comunicación y 

aumentar la velocidad y la estabilidad de la conexión. Cuando el controlador 

sin alimentación se reinicia, la HMI detectará y se conectará automáticamente. 

El número de estación debe estar entre 0 y 31 cuando el número de estación 

del controlador se asigna mediante la función de [Vínculos inteligentes 

múltiples]. Si necesita conocer el estado del controlador conectado, puede 

verificarlo desde las variables internas del sistema HMI (COM1 = N65352, 

COM2 = N65354). 
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El número de estación corresponde al bit de la variable, 0 = conexión normal, 

1 = actualmente no conectado. La tabla correspondiente específica es la 

siguiente. 

CO 

M1 

Vari a-

bl e N65353 N65352 

Bit 15 
1 

4 
13 12 11 

1 

0 
9 8 7 6 5 4 3 2 1 0 15 14 13 

1 

2 
11 10 9 8 7 6 5 4 3 2 1 0 

Station 

No 31 
3 

0 
29 28 27 

2 

6 

2 

5 

2 

4 
23 

2 

2 

2 

1 
20 

1 

9 

1 

8 

1 

7 
16 15 14 13 

1 

2 
11 10 9 8 7 6 5 4 3 2 1 0 

CO 

M1 

Vari a-

bl e N65355 N65354 

Bit 15 
1 

4 
13 12 11 

1 

0 
9 8 7 6 5 4 3 2 1 0 15 14 13 

1 

2 
11 10 9 8 7 6 5 4 3 2 1 0 

Station 

No 31 
3 

0 
29 28 27 

2 

6 

2 

5 

2 

4 
23 

2 

2 

2 

1 
20 

1 

9 

1 

8 

1 

7 
16 15 14 13 

1 

2 
11 10 9 8 7 6 5 4 3 2 1 0 

Nota: [Vínculos inteligentes múltiples] solo admite controladores con protocolo 

de comunicación de número de estación. 

Apéndice 6 Descripción de la función de 

visualización de valor numérico incrustado en cadena 
El valor incrustado en la cadena de caracteres significa que cuando se 

utiliza un componente de texto estático, el valor de la cadena de caracteres 

variable dinámica se muestra en un componente estático general mediante la 

función [cadena de caracteres de visualización variable].  

[Cadena de caracteres de visualización variable]: se refiere a la cadena de 

caracteres de definición que utiliza '{' como símbolo inicial y '}' como símbolo 

final. Por ejemplo {N0,4.2d}, {N100,81X}. 

Si desea mostrar el símbolo '{' en la cadena de caracteres, debe escribir 

dos '{' 's consecutivos de ' {{' para reconocer el ' {' como una cadena de 

caracteres normal. 

[Cadena de visualización variable] La definición se divide en 6 partes: 

prefijo, parte de definición de variable, parte entera, parte decimal, definición 

de formato de visualización, sufijo. La parte de definición de variable y la parte 

entera están separadas por una coma ',' (coma en inglés). 

Descripción del formato de cadena de visualización variable 

Prefijo 
Definiciones de 

variables 
parte entera 

Parte 

decimal 

Definición de formato de 

visualización 
subfijo 
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{ 

Variables del 

sistema N0 ~ 

N65535 

Variable de 

índice V0 

~ V255 

Valor: 1-12. 

Cuando 

se requiere 

relleno cero 

de alto 

orden, 

agregar un 

número 

'0' delante. 

Valor: 1-12. Si 

este bit es 0, 

es decir, no 

se necesita la 

parte 

fraccionaria, 

este bit se 

puede omitir. 

Cuando se 

omite, el 

separador "." 

Con la parte 

entera 

necesita ser 

borrado. 

d: número con signo decimal 

(16 bits) 

u: número decimal sin signo 

(16 bits) 

x: visualización hexadecimal 

(16 bits) ld: número con signo 

decimal 

(32 bits ※) 

lu: número decimal sin signo 

(32 bits ※) 

lx: pantalla hexadecimal 

(32Bits 

※) 

f: pantalla de punto flotante 

(32 bits 

※) 

} 

Nota: No puede haber espacios en blanco en la definición de cadena de visualización 

variable 

※ La lectura de 32 bits es de datos inferiores de 16 bits y datos superiores de 16 bits. 

Ejemplos de configuración de cadena de visualización variable: 

En {N0,4.2d}, 

Prefijo: {; 

Definición de variable: N0; 

Parte entera: 4; 

Parte decimal: 2; 

Formato de visualización: d; 

Sufijo:} 

Un ejemplo de visualización de cadena de caracteres de visualización 

variable, tomando el decimal N0 = 123 como ejemplo: 

Establecer 

cadena de 

visualización 

variable 

monitor 

Explicación 

{N0,04x} 007B 
Muestre el valor de N0 en forma de relleno cero 

hexadecimal de alto orden 

{N0,2.2d} 1.23 
Mostrar el valor de N0 en decimales y 2 

decimales 

{N0,d} 123 Mostrar el valor de N0 en formato decimal 

Ejemplos de configuraciones de software: 
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1. Componentes recién agregados [texto estático]

 

2. Establezca la propiedad [Etiqueta] como se muestra a continuación

 
3. [Texto estático] El estado de visualización se muestra a continuación

 

4. Al ejecutar el programa, el estado de visualización de [texto estático] se 

muestra en la siguiente figura
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Apéndice 7 Lista de controladores comunicables 

518 Singlex Series 

AD-4401 Series 

Allen-Bradley DH-485 

ARCUS Series 

CoolMay PLC(2N) 

CoolMay PLC(3U/3G)/FX3U 

CSIM Series 

DELTA DVP Series 

DPS Series 

Facon FB Series 

Fama Series 

Fuji MICREX-SX Series 

GALIL Series 

Jing Yi elevator Series 

Keyence KV Series 

Koyo K sequence 

LG Master-K K120S Series 

LUSTBUS Series 

Macro Series 

Matsushita FP Series 

Mitsubishi A1SH Series 

Mitsubishi FX Series 

Mitsubishi FX Series-Computer link 

Mitsubishi FX2N Series 

Mitsubishi FX2N-10GM/20GM Series 

Mitsubishi FX3U Series 

Mitsubishi MR-J2S Series 

Mitsubishi MR-J3 Series 

Mitsubishi MR-J4 Series 

Mitsubishi Q Series 

Mitsubishi Q06HCPU Series 

Mitsubishi QnA Series 

Modbus ASCII Mode 

Modbus RTU Mode 
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Omron C Series 

Omron CompoWay 

P900 Series 

Phoenixtec UPS Series 

 

RM80 Series 

SAMCO-Vm05 Series 

Simatic S7-200 Series 

SMAC LLC-10 Series 

SmartMotor Series 

TAIE Series 

TECORP HC1 Series(ASCII Mode) 

TECORP V5000 Series 

TOHO TTM-004/X04 Series 

TRIO Host link Series 

Unidriver Series 

UNIPULSE Series 

VIGOR M/VB/VH Series 

WDH IR-BOX Series 

WDH Lamp Series 

XP989 Series 

Yamatake CPL 
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Apéndice 8 Instrucciones de operación de exportación 

de datos de almacenamiento de HMI de la serie TK 
Software：xExpress El software xExpress está especialmente diseñado para 

la HMI de la serie mView TK. La función principal es leer los datos de la receta 

y registrar los datos de la HMI de la serie TK en funcionamiento a través del 

puerto de comunicación, y guardarlos como un archivo de texto, lo cual es 

conveniente para que los clientes analicen más datos o hagan informes, los 

datos de salida se pueden personalizar formato de visualización, de modo que 

los datos se muestren más cerca del uso real. 

Pasos de operación simples 

1. Edite el software mView, diseñe el programa HMI y defina datos de receta o 

datos de registro. 

2. Pruebe el programa HMI conectado para confirmar que funciona 

correctamente. 

3. Use el software mView para exportar [exportación de definición de caché]. 

4. Abra el editor xExpress, conecte el dispositivo y los parámetros de 

comunicación. 

5. Importar definición de datos (el archivo exportado por el paso 3). 

6. Lea los datos del área de búfer HMI a través de la línea de práctica 

7. Seleccione la receta editada o los datos registrados y, después de editar los 

atributos, exporte los datos a un archivo de texto. 

8. Use el software Microsoft Excel para abrir documentos de texto y luego 

haga análisis de datos e informes.  

Paso 1 

En primer lugar, use mView para editar el programa HMI. Cuando los datos de 

receta o los datos de registro se usan en el programa, se pueden usar con el 

software xExpress. 

Tenga en cuenta que la edición de datos de recetas [dispositivo de respaldo: 

use el área de variables del sistema (N0-N61439)]
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Tenga en cuenta que la edición de datos de registro necesita [función 

retentiva] 

Nota: El intervalo máximo de ahorro de energía es de 49152 palabras, que 

está relacionado con [Longitud de datos] y [Recuento de registros]

 

Paso 2 

Descargue el programa a la operación de prueba de HMI hasta que se 

confirme que la operación de prueba es normal. 

Paso 3 

Abra el software mView para editar el programa HMI, seleccione 
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[Archivo]-[Exportar]-[Definir registro] para almacenar el archivo de definición 

de búfer.  
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Paso 4 

Abra el software xExpress, [Archivo]-[Abrir un archivo nuevo], presione el 

botón [Agregar dispositivo] en la esquina inferior derecha

 

Esta demostración explica cómo usar el puerto com para la comunicación, 

después de agregar un dispositivo, seleccione el puerto de comunicación; El 



 Manual de programación de HMI de la serie TK 

311                                                                               https://coolmay.com.ar/ 

parámetro [dispositivo] hace referencia al puerto com entre la PC y la HMI, y 

configure los parámetros de comunicación (predeterminado 115200, 8, 

ninguno, 1 es suficiente) 

 

Luego haga clic en [Agregar HMI] para agregar una nueva HMI

 

Paso 5 
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Después de agregar la HMI, debe importar la definición de datos (definida por 

el búfer exportado en el paso 3)

 
Paso 6 

Los datos de definición de la HMI registrarán la definición de datos. Después 

de importar la definición de datos, fije la línea de conexión entre la PC y la HMI 

(la línea de descarga de la HMI) y presione [Leer datos] en la esquina inferior 
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derecha de la pantalla xExpress para comenzar a leer la HMI. datos
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Paso 7 

En este momento, los datos de la receta o los datos registrados se han vuelto 

a leer en la PC, seleccione la receta editada o registre los datos, después de 

editar los atributos, exporte los datos a un archivo de texto. (Cuando los datos 

no se registran en la HMI en ejecución, xExpress está vacío durante la 

grabación de datos)
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Paso 8 

Use el software Microsoft Excel para abrir el archivo de texto guardado en el 

paso 7 para el análisis de datos y la generación de informes.
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Apéndice 9 Instrucción de comunicación HMI modbus 

RTU 
Códigos de función admitidos por HMI como host Modbus 

Función No. 01: Leer el estado de la bobina y obtener el estado actual de un 

grupo de bobinas lógicas (ON/OFF) 

Función No. 03: Leer registros de espera y obtener el valor binario actual en 

uno o más registros de espera 

Función 04: Leer el registro de entrada para obtener el valor binario actual en 

uno o más registros de entrada 

Función No. 05: Forzar una sola bobina, forzar el estado de encendido y 

apagado de una bobina lógica (bit de escritura) Función No. 06: Cargar 

valores binarios específicos en un registro de retención (registro de escritura) 

Función n.º 15: forzar múltiples bobinas, forzar el encendido y apagado de una 

cadena de bobinas lógicas continuas (escribir múltiples bits) 

Función n.° 16: preseleccionar registros múltiples, cargar valores binarios 

específicos en una serie de registros de retención continuos (escribir registros 

múltiples) 

1. Realice la configuración del maestro con un solo esclavo 

1. 1. Configuración de parámetros de comunicación, use comunicación 485 

para seleccionar COM2 para agregar protocolo de comunicación. 
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[Proyecto] → [Comunicación] → [Agregar protocolo], como se muestra a 

continuación
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ID: número de identificación del controlador. (Único, no repetible) 

Estación: el número de estación del controlador, es decir, el número de 

estación esclava que se va a leer/escribir. (Los números de estación de com1 

y com2 se pueden repetir) 

El número de estación (número de estación HMI) en la configuración de la 

unidad de pantalla es la ID (ID de PLC) correspondiente al controlador 

conectado, y la ID (ID de HMI) configurada en la unidad de pantalla es la de 

varios controladores correspondientes. Para la configuración del número de 

estación, COM1 y COM2 de la unidad de visualización son independientes, 

por lo que COM1 y COM2 se pueden configurar por separado para conectar 

el controlador con el mismo número de estación, pero para la configuración de 

ID, no se puede repetir cada HMI. Debido a que la ID describe el controlador 

que es el primer controlador conectado a la unidad de visualización, como se 

muestra en la siguiente figura.

figure below. 
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1. 2.Después de que la adición sea exitosa, aparecerá el protocolo de 

comunicación correspondiente en la comunicación seleccionada:

 

1.3. Las variables disponibles son las siguientes 

Controlador: el dispositivo que se comunica con la HMI; número: introduzca 

directamente la dirección de la variable.
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1. 4. Coloque la variable correspondiente en la pantalla de la HMI y use 485 

para conectar el dispositivo de comunicación modbus, es decir, puede 

leer/escribir los datos de la dirección de la variable correspondiente, como se 

muestra en la siguiente figura:

 

1.1. 1. Configurar el maestro con múltiples esclavos 

1.2. Configuración de parámetros de comunicación, use comunicación 485 

para seleccionar COM2 para agregar protocolo de comunicación. 

Si necesita conectar varios esclavos, debe agregar varios controladores. Cada 

controlador corresponde a un dispositivo que lee/escribe un número de 

estación esclava diferente. [Proyecto] → [Comunicación] → [Agregar 

controlador], como se muestra a continuación.
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O seleccione directamente el protocolo de comunicación, haga clic con el 

botón derecho del mouse → [Agregar controlador]

 

Tenga en cuenta que al conectar varios productos para la comunicación, debe 

marcar [Multi-Station Smart Link] y seleccionar [Timeout, Non-retransmission]
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1.2. Después de agregar 3 controladores con éxito, es el siguiente:

 

1.2. Agregue la variable que solicita leer/escribir el número de la estación 

esclava en el orden de ①②③④ de la siguiente manera, ②Seleccione la 

estación esclava correspondiente a la dirección variable
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Por ejemplo, dirección variable del esclavo 2:

 

Dirección variable del esclavo 3:

 

2. 4. Coloque la variable correspondiente en la pantalla HMI y use 485 para 

conectar el dispositivo de comunicación modbus, es decir, puede leer/escribir 

los datos de la dirección de la variable correspondiente, como se muestra en 
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la siguiente figura:

 

2.1 2. Configuración de HMI como esclavo 

2.2 Nota: Sin agregar ningún protocolo y dispositivo, la HMI 

actuará como esclavo MODBUS RTU. 

Cómo configurar el número de estación de la estación esclava: 

①Proyecto>Configuración>ID. 

②Utilice N65128 para configurar directamente en HMI.

 



 Manual de programación de HMI de la serie TK 

327                                                                               https://coolmay.com.ar/ 

Actualmente solo admite MODBUS RTU. Dos métodos para configurar los 

parámetros de comunicación en HMI: 

① Dibuje una línea diagonal desde la esquina superior izquierda de la HMI 

para ingresar a la configuración del sistema. 

②Utilice el botón de salto de pantalla para cambiar la pantalla a [65005: 

Sistema 

pantalla de configuración]
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2.3 Las variables disponibles cuando se utiliza HMI como esclavo son las 

siguientes

 
El número de dirección correspondiente del registro HMI en la 

comunicación modbus: 

Modbus NO. 
HMI internal 

variables 

400000~465535 N0~N65535 

El número de dirección correspondiente del componente de bit HMI en 

la comunicación modbus: 

En HMI, una variable interna N tiene 16 bits, donde N0.0 corresponde a 

0X0000, N0.1 corresponde a 0X0001, y así sucesivamente...  
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Apéndice 10 Instrucciones de la HMI de la serie 

Coolmay TK comunicándose con otra banda PLC 

Especificaciones de hardware: 
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1. Serie Coolmay CX 

Método 1: Utilice la conexión RS232 

 Configuración del software TK 

Elemento de parámetro Recommended settings 

Protocolo CoolMay PLC(3U/3G)/FX3U 

Tipo de puerto de 

comunicación 

RS232 
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Tasa de comunicación 9600 

 

Comprobación de 

sincronización 

Even parity 

Número de datos 7 digits 

Detener dígitos 1 digit 

 

Variable Operable 
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 Diagrama de conexión de la línea de comunicación del PLC de la serie 

TK(COM1)-CX (utilice 

Línea de descarga de la serie CX2N)

 
Método 2: Utilice la configuración 

del software TK de conexión RS485 

Elemento de parámetro Recommended settings 

Protocolo CoolMay PLC(3U/3G)/FX3U 

Tipo de puerto de 

comunicación 

RS485 

Tasa de comunicación 9600 

Comprobación de 

sincronización 

Even parity 

Número de datos 7 digits 

Detener dígitos 1 digit 
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 Diagrama de conexión de la línea de comunicación del PLC de la serie 

TK(COM1)-CX 

Variable  Operable 
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2. AD4401 (Japan AIAND weighing controller) 

 TK software settings 

Elemento de parámetro Recommended settings 

Protocolo AD-4401 Series 

Tipo de puerto de comunicación RS232 

Tasa de comunicación 9600 

Comprobación de sincronización Even parity 

Número de datos 7 digits 

Detener dígitos 1 digit 

 
 Variable 
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 Diagrama del cable de comunicación TK(COM1)-AD4401   
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3. Serie Fuji MICREX-SX (Fuji) 

 Configuración del software TK 

Elemento de parámetro Configuraciones 

recomendadas 
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Protocolo Serie Fuji MICREX-SX 

 

Tipo de puerto de 

comunicación 

RS232 

Tasa de comunicación 38400 

Comprobación de 

sincronización 

Even parity 

Número de datos 8 digits 

Detener dígitos 1 digit 

 
Variable manipulable 
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TK-Fuji MICREX-SX Series Diagrama de conexión del cable de 

comunicación (usando 

232 cable cruzado)

 

4.Mitsubishi FX series 

TK configuración de software 

Elemento de 

parámetro 

Configuración recomendada 

Protocolo Mitsubishi Fx Series 

Comunicación RS232 

Comunicación 9600 
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Sincronización Incluso la paridad 

Número de 

datos 

7 digits 

Detener dígitos 1 digit 

 

 

Variable manipulable 
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 TK-FX Series Diagrama de conexión de la línea de comunicación (utilizando 

la línea de programación de Mitsubishi, concretamente SC-11/SC-09) 

 

5. Serie Keyence KV 

TK configuración de software 

Elemento de parámetro Recomendado 

Protocolo Keyence KV Series 

Tipo de puerto de 

comunicación 

RS232 

Tasa de comunicación 9600 

Comprobación de 

sincronización 

Incluso la paridad 

Número de datos 8 digits 

Detener dígitos 1 digit 



 Manual de programación de HMI de la serie TK 

341                                                                               https://coolmay.com.ar/ 

 

Variable manipulable 
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6.Koyo K serie de secuencias 

TK configuración de software 

Elemento de 

parámetro 

Recomendado 

Protocolo Koyo K secuencia 

Puerto de 

comunicación 

RS232 

Tasa de comunicación 9600 

Comprobación de 

sincronización 

paridad impar 

Número de datos 8 digits 

Detener dígitos 1 digit 

TK- Keyence KV Communication line connection diagram 
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Variable manipulable 
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7.LG series 

TK Configuraciones de software 

Elemento de 

parámetro 

Configuracion 

recomendada 

Protocolo LG Master-K K120S Series 

Comunicación RS232 

Comunicación 38400 

TK- Koyo K sequence Communication line connection diagram 
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Sincronización Sin información 

Número de 

datos 

8 digits 

Detener dígitos 1 digit 
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TK-LG Master-K120S Diagrama de conexión de la línea de comunicación 

 

8. OMRON C series 

TK Configuraciones de software 

Elemento de 

parámetro 

Configuraciones 

recomendadas 

Protocolo Serie C de Omron 

Manipulable variable 
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Puerto de 

comunicación 

RS232 

Tasa de comunicación 9600 

Comprobación de 

sincronización 

Incluso la paridad 

Número de datos 7 digits 

Detener dígitos 2 digits 
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9.Siemens S7-200 series 

TK Configuraciones de software 

Elemento de 

parámetro 

Recommended settings 

Protocolo Simatic S7-200 Series 

Comunicación RS485 

Variable manipulable 

TK-OMRON communication cable connection diagram 
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Comunicación 9600 

Sincronización Incluso paridad 

 

Número de datos 8 digits 

Detener dígitos 1 digit 

Comunicación 1 second 
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10.Delta DVP series 

TK Configuraciones de software 

Elemento de parámetro Configuración 

recomendada 

Protocolo DELTA DVP Series 

Tipo de puerto de 

comunicación 

RS232 

Tasa de comunicación 9600 

Variable manipulable 

TK-Siemens S7-200 communication line connection diagram 
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Comprobacion de 

contraste 

Incluso la paridad 

Número de datos 7 digits 

Detener dígitos 1 digit 

Tiempo de espera de 

comunicación 

1 second 

 
 Variable manipulable

 K-Delta DVP communication cable connection diagram 
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11. Xinje PLC series 

TK Configuración de software 

Elemento de parámetro Recommended settings 

Protocolo Xinjie PLC Series 

Tipo de puerto de 

comunicación 

RS232 
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Tasa de comunicación 19200 

Comprobación de 

sincronización 

Even parity 

Número de datos 8 digits 

Detener dígitos 1 digit 

Tiempo de espera de 

comunicación 

1 second 
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 TK- Xinje PLC diagrama de conexión de la línea de comunicación 

 

12. Matsushita PLC series 

Variable  manipulable 
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TK Configuraciones de software 

Elemento de parámetro Configuración 

recomendada 

Protocolo Matsushita FP Series 

Tipo de puerto de 

comunicación 

RS232 

Tasa de comunicación 9600 

Comprobación de 

sincronización 

Odd parity 

Número de datos 8 digits 

Detener dígitos 1 digit 

Tiempo de espera de 

comunicación 

1 second 
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TK- Diagrama de conexión de la línea de comunicación Matsushita PLC

 

Apéndice 11 Simulación y descarga del programa HMI 

11.1 Simulación de programa 

Variable  Manipulable 
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mView proporciona la función de simular directamente en la PC. Puede usar 

esta función para simular las acciones realizadas en HMI después de 

planificar HMI. Por un lado, aumenta la conveniencia de encontrar errores de 

programa y, por otro lado, puede ahorrar la descarga del tiempo que la HMI 

puede conectarse al controlador. La función de simulación de mView se divide 

en dos tipos: [Ejecución en línea] y [Ejecución fuera de línea], como se 

muestra en la siguiente figura.

 
11.1.1 Ejecución en línea 

Esta función debe estar conectada al controlador, y el programa modificará los 

contactos y registros correspondientes establecidos por el controlador durante 

la ejecución. Se puede utilizar para verificar si el programa planificado puede 

actuar normalmente sobre el controlador. 
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Antes de [Ejecutar en línea], debe configurar la comunicación, como se 

muestra en la siguiente figura:

 

Entre ellos, COM1 y COM2 a la izquierda de [Configuración de comunicación] 

se refieren a los puertos de comunicación en HMI, y la configuración a la 

derecha es el conjunto de puertos de comunicación designados por el usuario 

en el lado de la PC para simular los puertos de comunicación 
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correspondientes al sexo. del lado HMI, como se muestra a continuación:
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11.1.2 Ejecución fuera de línea 

Esta función no necesita estar realmente conectada al controlador, puede 

usarse para probar el funcionamiento normal del programa y la verificación de 

varias funciones. 

11.2 Descarga y actualización del programa S.O. versión 

Después de usar la PC para simular y verificar que el programa es correcto, 

puede comenzar a descargar a la HMI y usar directamente la HMI para 

conectarse al controlador. 

11.2.1 Descargar a HMI 

Antes de descargar el programa a HMI, primero debe realizar la configuración 

de comunicación, seleccione [HMI]→[Configuración]→[Configuración de 

comunicación], como se muestra en la siguiente figura:
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Especifique el puerto de comunicación de la PC en [Cargar/Descargar] de la 

ventana de configuración de comunicación, es decir, el puerto donde se 

conecta el cable de descarga a la PC. Por ejemplo, COM3, puede seleccionar 

[Usar velocidad de comunicación fija] junto con HMI [pantalla de descarga], o 

dejar que la PC intente descargar automáticamente a diferentes velocidades. 

Luego seleccione [HMI] → [Descargar a HMI], y luego comience a descargar 

el programa HMI a la HMI, como se muestra a continuación:

 

 

11.2.2 Guardar como programa HMI 

Además de descargar directamente el programa planificado a HMI, 

mView también permite al usuario guardar el programa planificado en un 

archivo específico (*.vho). Para descargar y usar en el futuro, se debe tener 

en cuenta que este archivo es solo para descargar y su contenido no se 
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puede modificar. Seleccione [HMI]→[Guardar proyecto como archivo...] para 

guardar el proyecto como un archivo especial para hombre-máquina de tipo 

vho, como se muestra en la siguiente figura: 

 

 

Después de que necesite descargar este programa a la HMI, seleccione 

[Herramienta]→[Descargar programa HMI], como se muestra a 

continuación,puede descargar este programa a la HMI.
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11.2.3 Actualizar SO HMI 

En términos generales, cuando se actualice la nueva versión del software 

mView, se combinará con la versión correspondiente del sistema operativo. 

Este sistema operativo es compatible con la versión anterior del software de 

planificación hacia abajo, pero si el usuario desea utilizar las funciones 

proporcionadas por la nueva versión del software de planificación, la nueva 

versión debe coincidir con el sistema operativo y el sistema operativo HMI se 

actualiza de la siguiente manera. 
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Paso 1: Seleccione [Herramientas]→[Actualizar HMI OS].

 

Paso 2: seleccione la versión del sistema operativo que desea actualizar (se 

recomienda actualizar con la versión del software de planificación utilizado).

 

Paso 3: Comience a descargar. (Nota: ¡Durante el proceso de descarga del 

sistema operativo, la HMI no debe estar apagada!)
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Paso 4: Una vez completada la descarga, reinicie la alimentación de la HMI.

 

11.3 Carga del programa 

Utilice esta función para cargar el programa en el hombre-máquina de nuevo a 

la PC y guardarlo como un programa HMI para su posterior descarga o edición 

por parte del usuario. 

11.3.1 Cargar programa HMI 

Seleccione [Herramienta]→[Cargar programa HMI] para volver a cargar el 

programa desde la HMI a la PC. Una vez completada la transferencia, se le 

pedirá al usuario que guarde el archivo como un archivo dedicado llamado 

vho, como se muestra en la siguiente figura:
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Para que el programa cargado sea editable, debe agregar la información 

descompilada antes de descargar el programa; de lo contrario, el programa 

cargado solo se puede usar para descargarlo y el usuario no puede editarlo. 

Seleccione [Ver]→[Opción(H)]→[Archivo] y marque [Agregar información 

descompilada]. 

Como se muestra abajo:
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Apéndice 12 Función de penetración HMI USB 
La función de comunicación penetrante proporcionada por HMI es usar el 

software de programación de PLC en la computadora y conectarse al PLC a 

través de la interfaz hombre-máquina conectada a la computadora. De esta 

forma, puede monitorear, cargar y descargar programas de PLC.

 

A Como se muestra en la figura anterior, la conexión entre la PC y la HMI 

es USB (puerto serie virtual), y la conexión entre la HMI y el PLC es una 

conexión en serie. Para facilitar la depuración, la PC puede descargar o 

monitorear directamente los programas de PLC a través de HMI para mejorar 

la eficiencia del trabajo. 

Nota: pantalla única COM1 significa RS232, COM2 significa RS485; 

Máquina todo en uno COM1 significa usar HMI y puerto de 

comunicación interna de PLC, COM2 significa usar HMI RS232 o 

RS485. 

1. COM1 comunicacion de penetracion 

Paso 1: Configure un botón de pantalla en la interfaz del programa HMI, 

seleccione [65021: Conexión virtual COM1] para [Cambio de pantalla]; 

descargar el programa a la pantalla táctil.

 
Paso 2: HMI y PLC están conectados a través de HMI COM1, la pantalla 

táctil cambia a esta página y la PC puede descargar o monitorear 
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directamente los programas de PLC a través de HMI.

 

2. COM2 penetration communication 

Paso 1: Configure un botón de pantalla en la interfaz del programa HMI, 

seleccione [65022: Conexión virtual COM2] para [Cambio de pantalla]; 

descargar el programa a la pantalla táctil.

 
Paso 2: HMI y PLC están conectados a través de HMI COM2, la pantalla 

táctil cambia a esta página y la PC puede descargar o monitorear 
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directamente los programas de PLC a través de HMI.

 

3. Los datos de COM1 y COM2 se penetran entre sí 

Paso 1: Configure un botón de pantalla en la interfaz del programa HMI, 

seleccione [65011: Virtual Online] para [Screen Switch]; descargar el 

programa a la pantalla táctil.

 

Paso 2: conecte COM1 y COM2 de HMI al controlador serial 

respectivamente, 
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la pantalla táctil cambiará a esta página y los controladores conectados a 

COM1 y COM2 de HMI pueden transmitirse datos entre sí;

 


